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WebSphere Adapter for Email documentation

With WebSphere® Adapter for Email, you can create integrated processes that
include the exchange of information using e-mail, without special coding.

Overview of WebSphere Adapter for Email

With WebSphere Adapter for Email, you can create integrated processes that can
exchange information using e-mail, without special coding.

For example, you can use the adapter to send general broadcast e-mails to a group
of addresses or to send a notification e-mail to a single address that an action has
taken place, such as a customer record update in a database. The adapter can also
forward information received in an e-mail message to IBM® Business Process
Manager or WebSphere Enterprise Service Bus and use it to initiate a service (for
example, to initiate a customer record update).

Suppose a company uses e-mail as its principal communication tool for most of its
business operations. A new product is coming out and the marketing team wants
to notify all of their IBM Business Partners before information is made available to
the public. You can use the WebSphere Adapter for Email to send an e-mail
broadcasting the new release date to a large group of e-mail addresses. Or, imagine
that a customer sends an e-mail to a company to notify it that their address has
changed. In this case, you can use the adapter to send the address change request
to an application that tracks addresses, and then returns an e-mail to the customer
with notification that the address change request is complete.

The adapter is imported and configured in a module that is created in IBM
Integration Designer and deployed to IBM Business Process Manager or
WebSphere Enterprise Service Bus. After the configuration is completed, the
adapter acts like a service provider in part of a service-oriented architecture (SOA)
implementation, providing operations to send and receive e-mails. Client
applications interact with the module instead of directly with the mail server. This
configuration enables the authentication details (such as user name and password)
that you provide when you set up a module to be shielded from client applications
and services outside of the module. The adapter exposes a service interface that
hides the mechanics of how the data or operations are obtained or used.

The benefit of creating the module with the external service wizard in IBM
Integration Designer is that it becomes a reusable unit that can perform a specific
inbound or outbound service. Each module uses a consistent interface and
standard business objects, so that the applications consuming the service do not
have to understand the lower-level details of the mail server.

What is new in this release

This version includes several new features that enhance the business flexibility,
user experience, and performance of the adapter.

This information is also available at the WebSphere Adapters product support
website |http: / /www-947.ibm.com/support/ entry/portal /Overview /Software/ |
[WebSphere/WebSphere_Adapters_Family| which is periodically updated with the

latest information.
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WebSphere Adapter for Email, version 7.5, which includes the following new
features:

* Support for scheduling your business activities during the inbound operations.
* Migration
— Migration of WebSphere Adapters version 7.0 to WebSphere Adapters version
7.5 on IBM Business Process Manager

New in WebSphere Adapter for Email, version 7.0, Feature Pack 1

A feature pack is available for WebSphere Adapter for Email that extends the
capabilities of that product. For information about WebSphere Adapter for Email,
version 7.0 Feature Pack 1, see |http:/ /publib.boulder.ibm.com /infocenter/|
ldmndhelp /v7rOmx /topic/com.ibm.wsadapters.fep0610.doc /dochome.htm|

* Receiving undeliverable e-mail notifications in the specified e-mail address in
case of simple e-mail, generic e-mail, and user-defined data types.

* Logging SMTP, POP, and IMAP commands to the mail server in the trace file.

* Logging adapter foundation class (AFC) version, Java Mail API version, and
third-party version artifacts in the trace file.

Hardware and software requirements

The hardware and software requirements for WebSphere Adapters are provided on
the IBM Support website.

To view hardware and software requirements for WebSphere Adapters, see
lhttp:/ /www.ibm.com /support/docview.wss?uid=swg27006249|

Additional information

The following links provide additional information you might need to configure
and deploy your adapter:

e The compatibility matrix for WebSphere Business Integration Adapters and
WebSphere Adapters identifies the supported versions of required software for
your adapter. To view this document, go to the WebSphere Adapters support
page: |http:/ /www-947.ibm.com/support/entry /portal / Overview /Software /|
[WebSphere / WebSphere_Adapters_Family]

* Technotes for WebSphere Adapters provide workaround and additional
information that are not included in the product documentation. To view the
technotes for your adapter, go to the following Web page, select the name of
your adapter from the Product category list, and click the search icon:

http:/ /www.ibm.com /support/search.wss?tc=SSMKUK &rs=695&rank=8|
&dc=DB520+D800+D900+DA900+DA800+DB560&d tm|

Technical overview of WebSphere Adapter for Email

WebSphere Adapter for Email enables e-mail connectivity between IBM Business
Process Manager or WebSphere Enterprise Service Bus and one or more mail
servers. The adapter itself is housed within an adapter module that you create
using the external service wizard in IBM Integration Designer. Each module
performs an outbound or inbound service, such as retrieving e-mails from a mail
server or sending e-mails to a group of recipients.

A module encapsulates the service in a reusable unit and consists of both a project
in IBM Integration Designer and a unit of deployment which is an enterprise
archive (EAR) file to IBM Business Process Manager or WebSphere Enterprise
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Service Bus. The module is packaged and deployed to IBM Business Process
Manager or WebSphere Enterprise Service Bus as an enterprise archive (EAR) file.

In the simplest implementation, you can use the adapter to send e-mails to one or
more e-mail addresses. This process is referred to as outbound communication
because the adapter is part of a module designed to send e-mails out to a mail
server. You can also use the adapter to poll a mail server for incoming e-mails, and
then send the information found in the e-mail to a service. The service consumes
the information forwarded by the adapter to complete a task. This process is called
inbound communication.

In more complicated implementations, you use a number of individual modules
(designed for inbound and outbound communication) together to initiate an
automated flow of operation, and then send an e-mail notification to an e-mail
address to confirm that an action has been completed. Similarly, you can create an
inbound module that listens for incoming e-mail events on the mail server that
match certain criteria (for example, e-mails with a specific word in the subject
field) and forwards only those e-mail events to the service.

The adapter sends and receives e-mails to or from different mail servers by using
the SMTP e-mail protocol for all outbound communication and either the IMAP or
POP3 e-mail protocol for inbound communication. Depending on what inbound
protocol your mail server supports, you can select between IMAP and POP3 when
you create your inbound module.

Outbound processing

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Outbound processing begins with the adapter receiving a request in the form of a
business object from a service. Business objects represent data that the adapter
needs to create an e-mail and each one might include, among other things,
attachments, and e-mail addresses for where the e-mail is to be sent. When a
request is received by the adapter, the adapter takes the information stored in the
business object and creates an e-mail. This e-mail is then forwarded to the mail
server for distribution.

The following illustration shows how the adapter and module (which encapsulates
the service in a reusable unit) function together as part of an outbound service. A
module created for outbound processing receives the business object, the business
object is turned into an e-mail by the adapter, and then the adapter sends the
e-mail to the mail server for distribution.
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Figure 1. Adapter as part of an outbound SOA implementation

Each outbound module contains components that form a service, including an
import. An import is a component, but without an implementation that is used to
identify the services outside the module, making them callable from within the
module. To communicate with references (for calling interfaces), imports require
enterprise information system (EIS) binding information, to specify how the data is
to be transported from the module. The assembly editor in IBM Integration
Designer sets up the import and the EIS binding.

The following illustration shows a more detailed view of the module in an
outbound implementation. The I and R symbols within the illustration represent
interfaces and references. Interfaces dictate to the users of a service, in this case the
import, how the component can be used. Interfaces are specification of the
operations performed by a component. The operations are createCustomer,
createAddress, and createEmail for outbound communication. References declare
the interface that your service component is going to call. Each component in your
module has one or more references. When you write your implementation for your
service component using the assembly editor in IBM Integration Designer, you call
a reference instead of directly calling the component. This implementation allows
you to reassemble components in the future because you have not built
dependencies into the code.

IBM Business Process Manager

Module Module IBM
WebSphere Email
®Component® 5 Imprt - Ad?pter 5 server
— or
L é/ Email l

E-mails

Figure 2. Outbound communication showing the import
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During outbound processing, the adapter itself does not create e-mails. Instead, it
converts the information received in a business object to a message that mail
servers supporting the RFC822 format can understand.

Note: This process is not visible to you. It is only mentioned because the term
"RFC822 format" appears in the reference section in regard to the e-mail headers
the adapter supports.

When a mail server receives an e-mail message from the adapter, the mail server
converts the message to an e-mail and sends it to all e-mail addresses listed in the
To, Cc, and Bcc fields. If the adapter cannot send the message successfully to the
server, it logs the following information:

¢ the MailSendFault fault for all non-connection related exceptions,

* for all other cases, the EmailOutboundCreateException exception with an
appropriate error message indicating the reason for the failure.

Outbound data transformation:

During outbound communication, the adapter transforms business objects into
multipart MIME e-mail messages.

While the adapter uses an adapter-specific data binding and data handlers to
accomplish it, the actual transformation is external to the adapter and performed
by IBM Business Process Manager or WebSphere Enterprise Service Bus. The data
bindings and data handlers that the adapter uses to compose an e-mail from the
corresponding attributes in a business object are configured through the external
service wizard in IBM Integration Designer.

Data bindings

Data bindings are essentially maps that define how a business object is to be
formatted. Data bindings are responsible for reading the fields in a business object
and filling the corresponding fields in an e-mail.

During outbound communication, the data binding takes the following fields from
a business object and populates the equivalent fields in an e-mail with their values:

e Headers
e Mail content
e Attachment

For data that does not require transformation, the adapter conducts the
pass-through processing, where data such as attachments pass through the system
without being altered.

The adapter uses one of the three data bindings during outbound communication.
Each data binding corresponds to a business object structure or data type selected
in the external service wizard. The following table lists these data bindings and
describes their usage. A more detailed description of each data binding is provided
in the sections that follow the table.

Table 1. Outbound data bindings

Data binding Usage

[Email simple data binding] Used for the simple alert e-mail data type

Email 5
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Table 1. Outbound data bindings (continued)

Data binding Usage

|[Email wrapper data binding] Used for generic e-mail and generic e-mail
with business graph data types

IlEmail fixed structure data binding| Used with the user-defined data type

ilEmail data binding| Used only with version 6.0.2 business objects

| for compatibility with earlier versions

Email simple data binding

The Email simple data binding is the default data binding for the simple alert
e-mail data type in the external service wizard. This data binding corresponds to
the simple alert e-mail business object structure that is described in this
documentation.

Email wrapper data binding

The Email wrapper data binding is the default data binding for both the Generic
Email and Generic Email with business graph data types in the external service
wizard. This data binding corresponds to the Email business object structure.

Email fixed structure data binding

The Email fixed structure data binding is the default data binding for the
user-defined type data type in the external service wizard. This data binding
corresponds to a specific business object structure defined by a user. With this data
binding, the order of the attachments is significant. The attachments must be in the
same order as the attributes in the business object. This data binding retains the
order.

Email data binding

This data binding is used exclusively for compatibility with business objects
created in version 6.0.2 or earlier. This data binding supports the five-level
business object structure used in version 6.0.2 of the adapter.

Data handlers

In addition to data bindings, data transformation requires the use of a data
handler. Data handlers are converters of data from one format to another. Data
handlers perform the conversions between a business object and a particular MIME
format. Data handlers are provided by IBM Business Process Manager or
WebSphere Enterprise Service Bus.

For data that does not need to be transformed, such as some attachments, the
adapter can be configured to conduct what is called pass-through processing. In
pass-through processing, data passes directly from the business object to the e-mail
without being altered.

Character encoding

To send globalized characters in e-mail messages, you set encoding values for
headers, mail content, and attachment business objects. For all data types except

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



the simple alert e-mail data type, you can set encoding values at two levels: in the
Encoding attribute of the business object or in the Encoding property of the data
binding in the data binding properties.

* For the simple alert e-mail data type, you set the encoding value in the
Encoding attribute of the SimpleAlertEmail business object.

* For the generic e-mail data type, you set the encoding value in the Encoding
property of the data binding (EmailWrapperDataBinding) or in the Encoding
property of the wrapper business object (Email business object). The encoding
property in the data handler configuration must have the same value that is
specified in the data binding.

* For the user-defined data type, you set the encoding value in the Encoding
property of the wrapper business object (Email business object) or in the
Encoding property of the data binding (EmailFixedStructureDatabinding). The
encoding property in the data handler configuration must have the same value
that is specified in the data binding.

During pass-through processing, the adapter uses the encoding value that is set in
the business object. When data transformation is required, the adapter uses the
value that is set in the individual data binding.

In both pass-through and non pass-through scenarios, the headers are encoded
with same encoding value such as the mailContent.

Related reference

[“Interaction specification properties” on page 18§

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

Inbound processing

WebSphere Adapter for Email supports inbound processing of e-mail events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new e-mails that are ready for processing. When the adapter detects
an event that is ready to be processed, it converts the event data into a business
object and sends it to the consuming service.

During inbound processing, the adapter polls the mail server for new e-mails,
which are called events. When the adapter detects a new event, it reads the e-mail
and creates a business object to represent the e-mail content. The adapter then
forwards the business object to the export which is an exposed interface from a
service component architecture (SCA) module that offers a business service to the
outside world. Business objects carry the information the adapter takes from an
e-mail. By converting e-mails to business objects and forwarding them to a service,
the services using your adapter module do not have to deal directly with the mail
server. It is the adapter that polls for events, changes them to a format the
consuming services can understand (business objects), and then forwards them to
the export for delivery to the services that consume them.

The following illustration shows at a high level how the adapter functions as part
of an inbound service in a service-oriented architecture (SOA) implementation. The
adapter polls the mail server for incoming events, converts them into business
objects, and then the adapter sends them to a consuming service.
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Figure 3. Adapter as part of an inbound SOA implementation

Each inbound module contains components that form a service, including an
export. An export is a component, but without an implementation. Exports allow
components in a module to provide their services to external clients. Exports
require an EIS binding, which specifies the means of transporting the data from the
modules. The assembly editor in IBM Integration Designer sets up the export, lists
the supported bindings, and simplifies its creation. For inbound requests, business
objects are essentially the logical graphical representation of the content of an
incoming e-mail, that appears as output from the export that represents the
module in the assembly diagram.

The following illustration shows a more detailed view of the module in an
inbound implementation. The I and R symbols within the illustration represent
interfaces and references. Interface is a specification of the operations performed by
a component. For inbound communication, it is limited to the Read operation. The
interface dictates to the users of a service component, in this case the export, how
the component can be used. A reference declares the interface that your service
component is going to call. Each component in your module has one or more
references. When you write the implementation for your service component using
the assembly editor in IBM Integration Designer, you call a reference instead of
directly calling the component. This implementation allows you to reassemble
components in the future because you have not built dependencies into the code.

IBM Business Process Manager

IBM Module Module
sEeTvaeilr ( WebSphere Export }Rj
Adpater ¢ 0 Component

I Emn \ EﬁEl []

E-mails

Figure 4. Inbound communication showing the export
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Supported inbound protocols

The adapter supports two different inbound e-mail protocols: POP3 and IMAP.
With each, the adapter polls the mail server at a specified interval for inbound
events (e-mails) and when an e-mail is detected on the mail server, the adapter
converts it to a business object. The adapter considers any e-mail in the specified
inbox folder on the mail server that is ready for processing an event.

Depending on your mail server, you might be able to choose the inbound e-mail
protocol that the adapter can use. Differences between the protocols and a
description of how the adapter works with each protocol are noted in and
the sections that follow.

Table 2. Differences between the IMAP and POP3 protocols

IMAP POP3

Supports the existence of multiple mail Supports only one mailbox (named Inbox)
folders on a mailbox. per user.

Allows a copy of the e-mail to remain on the | Supports a view-once-only feature on the
mail server after the client receives the server. The mail is deleted from the mail
e-mail. server after the client receives a copy of it.

Inbound communications with IMAP

If you use the IMAP protocol for your inbound communication, the following
steps are performed:

1. The adapter polls the mail folders at regular intervals and logs any unread
e-mails as events in the event store. You can use the activation specification
PollFolders property to customize the list of folders that are searched by the
adapter.

Note: If you specify multiple mail server folders for the mail server account in
the PollFolders property, the adapter polls all mail server folders sequentially.

2. Search criteria determines which events are picked up from the mail server. The
adapter picks up all events that match the search criteria. If no search criteria is
specified, the adapter picks up all unread e-mails.

3. The adapter writes all polled events to the staging directory. After an event is
written to the staging directory, it is deleted from the mail server.

4. The adapter transforms each event into an Email business object. The headers,
e-mail body content, and mail attachments are recorded within the business
object.

5. The Emalil business object is sent to the export.

6. After it has been processed, the adapter deletes processed e-mails from the
staging directory and archives them (if archiving is selected).

Note: If the archive file naming pattern activation specification property is
specified, the file names conform to the pattern.

Inbound communications with POP3
If you use the POP3 protocol for your inbound communication, the adapter

performs the following steps during inbound operations (from the mail server to
the service):
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1. Polls the Inbox folder on the mail server for inbound events (new e-mails).
When it finds an e-mail, it logs it as a new event in the event table.

Note: If you specify search criteria, all unread e-mails that fit the search criteria
are picked up by the adapter. If no search criteria are specified, the adapter
picks up all unread e-mails.

2. Writes new events to the staging directory as files and then deletes them from
the mail server.

3. Converts the e-mail into a business object. Headers, e-mail body content, and
mail attachments are recorded within the business object.

4. Sends the business object to the export.

5. Deletes all processed e-mail from the staging directory and archives them if the
archiving property is configured.

Note: If the archive file naming pattern property is specified, the file names
conform to the pattern. If it is not specified, the name remains the same as it is
in the staging directory.

Related tasks

[“Setting deployment and runtime properties for inbound processing” on page 100)
Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

Related reference

[“Activation specification properties” on page 196
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

[“Resource adapter properties” on page 184|

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[‘Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

[“Inbound configuration properties” on page 193

WebSphere Adapter for Email has several categories of inbound connection
configuration properties, which you set with the external service wizard while
generating or creating objects and services. You can change the resource adapter
and activation specification properties after you deploy the module using IBM
Integration Designer or the administrative console, but connection properties for
the external service wizard cannot be changed after deployment.

Inbound data transformation:

During inbound communication, the adapter transforms multipart MIME e-mail
messages into business objects.
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Data bindings

While the adapter uses an adapter-specific data binding and data handlers for
inbound data transformation, this actual transformation is external to the adapter
and provided by the IBM Business Process Manager or WebSphere Enterprise
Service Bus. The data bindings and data handlers that the adapter uses to read the
contents of an e-mail and fill the corresponding attributes in a business object are
configured using the external service wizard in IBM Integration Designer.

To take fields from an e-mail and populate a business object, the adapter needs a
data binding. Data bindings are maps that define how a business object is to be
formatted. Data bindings are responsible for reading the fields in an e-mail and
populating the corresponding fields in a business object.

During inbound communication, the data binding takes the following fields from
an e-mail and populates the parent Email business object attributes with their
values:

* Headers

* Mail content

¢ Attachment

For data that does not require transformation, the adapter conducts a pass-through
processing, where data such as attachments pass through the system without being
altered.

To transform data in the form of e-mails coming into the adapter, the adapter uses
one of the three data bindings. The following table lists these data bindings and
their usage. A more detailed description of each data binding is provided in the
sections that follow the table.

Table 3. Inbound data bindings

Data binding Usage

[“Email wrapper data binding”| Default data binding

[“Email fixed structure data binding”] Used with user-defined type business objects
[“Email data binding” on page 12| Used with version 6.0.2 business objects

Email wrapper data binding

The Email wrapper data binding is the default data binding for both the Generic
Email and Generic Email with Business Graph data types in the external service
wizard. This data binding corresponds to the Email business object structure.

Email fixed structure data binding

The Email fixed structure data binding is the default data binding for the
user-defined type data type in the external service wizard. This data binding
corresponds to a specific business object structure defined by a user. With this data
binding, the order of the attachments is significant. The attachments must be in the
same order as the attributes in the business object. This data binding retains the
order.

Email 11
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Email data binding

This data binding is used exclusively for compatibility with business objects
created in version 6.0.2 or earlier. This data binding supports the five-level
business object structure used in version 6.0.2 of the adapter.

Data handlers

In addition to data bindings, data transformation requires the use of a data
handler. Data handlers change data from one format to another. Data handlers
perform the conversions between a particular MIME format and a business object.
Data handlers are provided by IBM Business Process Manager or WebSphere
Enterprise Service Bus.

For data that does not need to be transformed, such as some attachments, the
adapter can be configured to conduct a pass-through processing. During
pass-through processing, data passes directly from the e-mail to the business object
without being altered.

Event store:

The event store is a persistent cache where event records are saved until the
polling adapter can process them.

The adapter uses an event store to track the inbound events that come into the
system. When a new e-mail is found in the polling folder, the adapter updates the
status of the corresponding event in the event store. For recovery purposes, the
adapter continually maintains the status of the event in the event store until the
event is delivered to the IBM Business Process Manager or WebSphere Enterprise
Service Bus. If the adapter is abruptly terminated, the adapter uses the event store
to determine which events have and have not been processed.

An event store is not required for the adapter to process inbound requests. The
adapter creates an event store:

* when the module is deployed to the runtime environment. It can happen if the
event persistence feature is configured in the external service wizard.

 if it detects that an event store does not exist for the inbound module in the
database.

Each event store created by the adapter is associated with a specific inbound
module. The adapter does not support multiple adapter modules pointing to the
same event store.

Related reference

[“Event store structure” on page 169

Each time an e-mail is read by the adapter during inbound communication, the
adapter updates the status of the event in an event store. The status of each event
is continually updated by the adapter for recovery purposes until the events are
delivered to a configured export on the run time.

Business objects

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.
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How the adapter uses business objects

The adapter during the outbound processing receives a business object from a
service. It then creates an e-mail from the details it finds in the business object and
sends the e-mail message to the mail server for distribution. For inbound
processing, this process happens in reverse. The adapter takes information from an
e-mail, converts it to a business object, and forwards it to a service.

How data is represented in business objects

Business objects are created using either the business object editor or external
service wizard in IBM Integration Designer. As shown in the following illustration,
a business object consists of a set of fields and a type of data, such as a string or
integer. The business object shown in the figure is a customer business object that
records name, address, and telephone number information for a customer record.
This example uses string values, but many other values are supported by the
business object editor.

% Customer
L

Mame  siring

Address string
Phone string

Figure 5. Customer business object

A field might, in turn, be another business object. For example, the following
illustration shows a customer business object that contains another business object.
Here, a company that sells pet-related items might want to keep a track of names
and species information of the pets that belongs to its customers. The Pet business
object stores the name and species information for one customer pet.

[%lf] Customer = [C] Pet
[ | [ |
Mame  string Mame siring
Address string Species string
Phone string
Pet Pet

Figure 6. Customer business object with child Pet business object

Each business object is associated with an operation. The operation in turn is
associated with the wrapper. The operation tells the adapter what to do with the
wrapper business objects. The following operations are examples of Create
operations used by the adapter to create e-mails during the outbound
communication:

e Create Customer

¢ Create Address

No matter what name you give an operation for your module, the adapter
performs the CreateEmail operation.
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For inbound communications, Emit is the only supported operation. This operation
is used to take information from an e-mail and convert it to business objects.

You can optionally choose, during adapter configuration, to generate a business
graph. In version 6.0.2, each top-level business object is contained in a business
graph, which includes a verb that an application can use in version 6.0.2 to specify
additional information about the operation to be performed. In Version 7.0,
business graphs are optional; they are required only when you are adding business
objects to a module created with a version of IBM Integration Designer earlier than
Version 7.0. If business graphs exist, they are processed, but the verb is ignored.

How business objects are created

Business objects and their wrapper objects are created by the external service
wizard from XSD files either imported from another module or created with IBM
Integration Designer business object editor. For any business object structure except
the simple alert e-mail structure, you must create or import the XSD files you want
the adapter to make into business objects before you run the external service
wizard. If transformation is needed, a business object that maps to the e-mail body
or an attachment that needs transformation must exist. A generic e-mail business
object is available for pass-through operations. Or, if only a simple alert e-mail is
needed (no attachments), the adapter provides a simple alert e-mail structure with
standard headers as another option.

You create business objects for your module with the external service wizard
launched from IBM Integration Designer. If you have defined XSD files using the
business object editor before starting the external service wizard, the adapter
creates business objects from these schemas.

Custom wrapper business objects

Custom wrapper business objects are user-defined wrapper business objects that
contain protocol-specific information and content. To use custom business objects,
you must first create business object schema files (XSD files) by using the IBM
Integration Designer business object editor. You can then use the external service
wizard to generate business objects from the XSD files. A custom wrapper business
object can be created from an existing business object or from XSD files.

Custom wrapper business objects are useful if you have an existing map or
mediation that expects a business object to have a protocol-specific wrapper. The
custom wrapper business object does not allow child objects of anyType. Using
anylype objects restricts you from using maps and mediation wiring, because you
must write programs or code to fetch business objects from the anyType field. You
have to write such code if child objects of anyType are allowed, because the
business object type being set on the anyType field is unknown.
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Related reference

[“Supported operations” on page 154|

Each business object is associated with an operation, such as create. Operations
might be stored in a business graph, which is like an enhanced business object, if
you choose to use business graphs. Each operation tells the adapter what to do
with the business object. For outbound communication, there are three different
create operations used to create an e-mail from the contents of a business object.
For inbound communication, only the emit e-mail operation is supported.

[“Business object information” on page 150

A business object is a structure that contains specific information about an e-mail
being processed by an inbound or outbound module. Business objects contain
information about how the adapter processes the e-mail content and attachments,
and also how the business objects are associated with an operation (such as
Create). Business object names are generated by the external service wizard and
are named according to their contents.

WebSphere Application Server environment variables

WebSphere Application Server environment variables can be used in the external
service wizard to specify directory values. You can now change any string property
values in inbound and outbound configuration by only changing the environment
variables.

When you configure the adapter for inbound or outbound processing using the
external service wizard, you set values for various required local files and
directories. You can later change these values in the deployed application from the
IBM Business Process Manager or WebSphere Enterprise Service Bus administrative
console.

Starting with IBM Business Process Manager or WebSphere Enterprise Service Bus
Version 6.1.0, instead of hard coding values for directories and files, you can
declare them as WebSphere Application Server environment variables and specify
the environment variable names when you run the external service wizard. When
you deploy your application, the environment variable name is replaced with the
actual value and used by the adapter. If you want to change the property value,
you can change the environment variable in the IBM Business Process Manager or
WebSphere Enterprise Service Bus administrative console.

WebSphere Application Server environment variables can be used for all string
property values (not Boolean or integer variables) that are set in inbound and
outbound configurations.

When you create a WebSphere Application Server environment variable, you
specify:
* The name of the environment variable, for example, ARCHIVE_FOLDER.

¢ The value that the symbolic name represents, for example: C:\email\
ArchiveFolder.

* The scope for the environment variable, which determines the level at which the
environment variable is visible in the administrative console. The scope level can
be server, node, or cell:

— Server scope limits visibility to the named server. The server scope is the most
specific scope for defining environment variables.

— Node scope limits visibility to all the servers on the named node. The Node is
the default scope level.

— Cell scope limits visibility to all servers on the named cell.
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Related tasks

[‘Defining WebSphere Application Server environment variables” on page 44|
Use the administrative console of IBM Business Process Manager or WebSphere
Enterprise Service Bus to define WebSphere Application Server environment
variables.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

The external service wizard
The external service wizard provides a blueprint to create services from existing
elements like business objects.

Use the external service wizard to configure your adapter before it is deployed to
IBM Business Process Manager or WebSphere Enterprise Service Bus. Using the
external service wizard, you can create business object schema files (XSD files),
build service descriptions, define connection properties for the mail server, and
generate business objects that contain everything the adapter needs to conduct
inbound and outbound communication.

You can use the external service wizard to generate business objects from the XSD
files. The external service wizard builds the service descriptors that are
adapter-specific artifacts used in import, export, and WSDL files. Also, you define
the connection properties by typing the name or IP address of the mail server and
the user ID and password needed to access it. The external service wizard then
generates the business objects through which the WebSphere Adapter for Email
provides operations such as to send and receive e-mails.

Planning for adapter implementation

You need to consider various factors before setting up and using the WebSphere
Adapter for Email. For example, before you configure the adapter, consider
whether to set up the adapter in a clustered environment, in which the workload
of the server is distributed across multiple machines. Also, if you are migrating
from an earlier version of WebSphere Adapter for Email, perform any migration
tasks.

Before you begin

Before you begin to set up and use the adapter, you must possess a thorough
understanding of business integration concepts, the capabilities, and requirements
of the integration development tools and runtime environment that you are going
to use, and the mail server environment where you build and use the solution.

To configure and deploy WebSphere Adapter for Email you must understand and
be familiar with the following concepts, tools, and tasks:

¢ The business requirements of the solution you are building.
* The mail server's security and configuration needs.

* Business integration concepts and models, including the Service Component
Architecture (SCA) programming model.
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* The capabilities and requirements of IBM Business Process Manager or
WebSphere Enterprise Service Bus. You must know how to configure and
administer the host server and how to use the administrative console to set and
modify property definitions, configure connection factories, and manage events.

¢ The tools and capabilities provided by IBM Integration Designer. You must
know how to use these tools to create modules, wire and test components, and
complete other integration tasks.

Security

WebSphere Adapter for Email supports user name and password authentication
methods of Java 2 as implemented in J2C. By supporting authentication, the
adapter provides protection for sensitive user data in log and trace files. Java 2 has
other security methods, such as Kerberos, which is not supported. The
authentication details are configured using the external service wizard. Secure
Sockets Layer (SSL) can be configured to protect the integrity of information being
passed between the mail server and the adapter and, for users who require it, the

adapter can be configured to run in support of the Federal Information Processing
Standard (FIPS) 140.

Antivirus software

If an antivirus program is running on your system (the system on which the
adapter is deployed or the one that hosts the mail server), the adapter might fail to
send outbound e-mails. It happens because some types of antivirus software have
auto protection turned on for Internet e-mail protection. When auto protection is
turned on, the antivirus software might treat open connections to an mail server as
malicious attacks and block all e-mails using that connection. Because the adapter
maintains the connections to the mail server in the pool, it does not close any of
the connections. It might result in the antivirus program blocking all e-mail from
the adapter.

By default, the Select when antivirus or firewall software is running check box in
the connection properties window of the external service wizard is selected. This
means that the adapter will close the connection after each outbound request.

Support for protecting sensitive user data in log and trace files
The adapter provides the ability to prevent sensitive or confidential data in log and
trace files from being seen by those without authorization.

Log and trace files for the adapter can contain data from your mail server, which
might contain sensitive or confidential information. Sometimes these files might be
seen by individuals without authorization to view sensitive data. For example, a
support specialist must use the log and trace files to troubleshoot a problem.

To protect the data in such situations, the adapter lets you specify whether you
want to prevent confidential user data from displaying in the adapter log and trace
files. You can select this option in the external service wizard or change the
HideConfidentialTrace property. When this property is enabled, the adapter
replaces the sensitive data with XXX's.

See [‘Managed connection factory properties” on page 175| for information about
this optional property.

The following types of information are considered potentially sensitive data and
are disguised:
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* The contents of a business object
* The contents of the object key of the event record

e User name, Password, Environment, and Role

The URL used to connect to the mail server

The following types of information are not considered user data and are not

hidden:

* The contents of the event record that are not part of the event record object key,
for example, the XID, event ID, business object name, and event status

* Business object schemas
* Transaction IDs

* Call sequences

Configuring Secure Socket Layers

Data that travels across a network can be intercepted by third parties. When this
data includes private information such as passwords or credit card numbers, steps
must be taken to make this data unintelligible to unauthorized users. Using Secure
Sockets Layer (SSL), you protect the integrity of information being passed between
the mail server and the adapter.

Before you begin

To enable SSL, the following prerequisites must be satisfied:

* The mail server must support secure IMAP, POP3, and SMTP communication
using SSL

* The mail server must have its own private key and certificate
* An e-mail client must be installed

About this task

E-mails passing through the mail server are vulnerable to third-party interference
when SSL is not configured for use with the adapter. Using SSL prohibits data
from being modified either intentionally or unintentionally during transport and
protects data from being intercepted. It is effective because it uses several
cryptographic processes, such as public key cryptography for authentication with
the mail server and secret key cryptography and digital signatures for privacy and
data integrity. SSL allows the adapter to authenticate the identity of the mail server
and, when necessary, for the mail server to authenticate the identity of the mail
client.

Procedure

1. Set the e-mail client truststore.
A truststore helps an e-mail client decide what it can trust. When SSL is
configured, IBM Business Process Manager or WebSphere Enterprise Service
Bus sends its certificate to the e-mail client for verification. The e-mail client
verifies the certificate to ascertain that it is communicating with the intended
mail server. To enable this verification process, the certificate of the mail server
must be present in the client's truststore. Use the following steps to set up the
e-mail client truststore.

a. In IBM Integration Designer, right-click the server and click Run
administrative console.

b. Expand Security.

C. Select SSL certificate and key management.
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d. Under Related items, select Key stores and certificates.
e. Select NodeDefaultTrustStore.

ssL certificate and key management

S5L certificate and key management WIE

551 certificate and key management > Key stores and certificates

Definas KeyStore types, including cryptography, RACF(R), CMS, Java(TM),

znd zll TrustStore types. %
Preferences
Mew| Delete | Exchange signers... |
b | [
Clkzlc
Select| Name 2 Path >
D NodeDefaultkeyStore £{CONFIG_ROOT }/cells/IBM-

66AZBACESS1Nodel1Cell/nodes/IEM-
66AZ8ACESS1Nodall/key.pl2

Fl NodeDefsultTrustStore ${CONFIG_ROOT} cells/IEM-
56A28ACESS1NodadiCell/nodes/IEM-
S66A28ACES51Nodeali/trust.pi2

[] |MNodelTPAkeys ${CONFIG_ROOT} calls/IEM-
66A28ACEES1Noden1Cell/nodes/ IEM-

Figure 7. Selecting NodeDefaultTrustStore

f. Under Additional properties, select Signer certificates.
g. Click Add.
h. In the Alias field, type the certificate name.

SSL certificate and key management NE

S5L certificate and key management > Key stores and certificates >
NodeDefaultTrustStore > Signer certificates > Add signer certificate

Adds a signer certificate to 2 key store.

Configuration

General Properties

* Alias

* File name

Data type %
| Basef4-encoded ASCII data [il

Apply| ﬂ Reset| Cancel |

Figure 8. Adding signer certificate properties for the mail server certificate

i. In the File name field, type the full path of the mail server certificate.
j. Click OK.
2. Configure SSL properties for the adapter.

a. In the external service wizard, set enableSSL to True. By default,
enableSSL is set to False.

b. When using SSL for inbound communication, set the port number to 993 if
you are using the IMAP e-mail protocol and 995 if you are using the POP3
e-mail protocol. For outbound communication using the SMTP e-mail
protocol, set the port number to 465.
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Configuring the module for federal information processing
standard 140

The Federal Information Processing Standard 140 (FIPS) is a United States
government standard for cryptographic features like encryption, decryption,
hashing (message digests), Secure Sockets Layer, Transport Layer Security, Internet
Protocol security, Secure Shell, signatures, key exchange, and key or certificate
generation used in software products and modules. For users working with the
United States government who must conform to the FIPS standard, the adapter can
be configured to run in FIPS mode.

About this task

Configuring the module to run in FIPS mode restricts the adapter to working with
modules whose cryptographic features comply with FIPS approved methods and
providers. From an adapter perspective, running in FIPS mode restricts the adapter
to using the Transport Layer Security (TLS) security protocol based on Secure
Sockets Layer (SSL).

Restriction: WebSphere Adapter for Email cannot connect to Microsoft Exchange
Server 2003 when FIPS (SSL 3.1 and TLS 1.0) is configured for inbound
communication. The adapter generates exceptions during startup. Currently there
are no known workaround to configure WebSphere Adapter for Email for use with
Microsoft Exchange Server 2003 in the FIPS mode. Version 7.5 of the adapter was
tested with SurgeMail 3.8 for FIPS.

To run the adapter in FIPS mode, you must instruct the adapter to use the IBM
Java Secure Socket Extension (IBMJSSE2) provider package. The IBMJSSE2 provider
is the preregistered Java Secure Socket Extension provider in the java.security file
in IBM SDK, version 5.0. IBMJSSE2 uses FIPS-approved packages.

When in FIPS 140-2 mode, IBM WebSphere Adapter for Email uses the FIPS 140-2
approved cryptographic provider(s); IBMJCEFIPS (certificate 376) and IBMJSSEFIPS
(certificate 409). The certificates are listed in the NIST Web site at

lhttp:/ /csre.nist.gov /groups/STM /cmvp /documents / 140-1/1401val2011.htm|

Complete the following steps to run the adapter in FIPS mode.

Procedure
1. In the IBMJSSE2 provider, set the com.ibm.jsse2]JSSEFIPS property to True.

2. Set the following security properties so the IBMJSSE2 provider can handle all
JSSE requests.

a. Set the ssl.SocketFactory.provider property to
com.ibm.jsse2SSLSocketFactoryImpl.

b. Set the ssl.ServerSocketFactory.provider property to
com.ibm.jsse2SSLServerSocketFactoryImpl.

3. In the java.security properties file, add the IBMJCEFIPS provider
com.ibm.crypto.fips.provider.IBMICEFIPS to the provider list above the
IBMJCE provider. Follow the security.provider.n=providername format where n
denotes the order of the provider. The provider with a value of 1 is considered
before the provider with a value of 2. Do not remove the IBMJCE provider.

4. From the IBM Business Process Manager or WebSphere Enterprise Service Bus
administrative console, set the system properties which are listed under the
Java virtual machine (JVM) properties. Follow the -Dpropertyname=propertyvalue
format.
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5. Set security properties in the java.security file (located in the IBM Business
Process Manager or WebSphere Enterprise Service Bus Java virtual
machine/lib/security directory).

Required folders for inbound processing

Several folders are required for activities such as archiving and storage before you
run the adapter for inbound processing.

Required folders for inbound communication

Before running the adapter, you must create one or more poll folders on your mail
server and a staging folder where the adapter saves all polled e-mails as files.
These folders are required and neither type are created by the adapter. Also, to use
the archiving functionality of the adapter to store successfully processed and failed
e-mail events you must create an archive folder and a failed event folder.

The adapter requires that there be a folder on the local drive that holds e-mails
marked in progress in the event store. This folder is called the staging directory in
the external service wizard. Because the adapter does not create a staging directory,
you must create it before you start the external service wizard.

Required folders for archiving

You can configure the adapter to save, or archive copies, of both successful and
failed e-mails by using the ArchiveFolder property. To use this property, you must
create both of the following folders before you run the adapter.

* Archive folder — A file system folder where the adapter archives successful
e-mails.

* Failed event folder — A file system folder where the adapter archives failed
e-mails.

When the ArchiveFolder property is specified, all successfully processed mail is
moved into the archive folder from the staging folder. If you leave this property
blank all successfully processed mail is deleted from the staging folder.

If the FailedEventsFolder property is specified, all unsuccessfully processed mail is
moved into the failed events folder from the staging folder. If you leave this
property blank, all failed mail is deleted from the staging folder.

For more information about either of these folder properties, see the section on
activation specification properties located in the reference section of this
documentation.

Using WebSphere Application Server environment variables

Instead of specifying the folder names when you run the external service wizard,
you can use WebSphere Application Server environment variables. Refer to more
information about environment variables at:|“WebSphere Application Server]

fenvironment variables” on page 15.|
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Related tasks

[‘Defining WebSphere Application Server environment variables” on page 44|
Use the administrative console of IBM Business Process Manager or WebSphere
Enterprise Service Bus to define WebSphere Application Server environment
variables.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

User authentication

The adapter supports several methods for supplying the user name and password
that are needed to connect to the mail server. By understanding the features and
limitations of each method, you can pick a method that provides the appropriate
level of security and convenience for your application.

To integrate an adapter into your application, you must provide the user name and
password for the adapter to use at run time on IBM Business Process Manager or
WebSphere Enterprise Service Bus to connect to the mail server to process
outbound requests and inbound events.

At run time, the adapter needs to provide the user name and password to connect
to the mail server. To connect without user intervention, the adapter must access a
saved copy of the user information. In a server environment, there are several
methods for saving user information. The external service wizard lets you
configure the adapter to get the user information using any of the following
methods:

* Adapter properties
* Data source

* J2C authentication alias

Saving the user name and password in adapter properties is a direct way to
provide this information at run time. You provide this user name and password
when you use the external service wizard to configure your module. Although
directly specifying the user name and password seems the most straightforward
method, it has important limitations. Adapter properties are not encrypted; the
password is stored as clear text in fields that are accessible to others on the server.
Also, when the password changes, you must update the password in all instances
of the adapter that access that mail server. This includes the adapters embedded in
application EAR files as well as adapters that are separately installed on the server.

Using a data source lets you use a connection already established for another
application. For example, if multiple applications access the same database with
the same user name and password, the applications can be deployed using the
same data source. The user name and password can be known only to the first
person who deploys an application to that data source or who defines a data
source separately.

Using a J2C authentication data entry, or authentication alias, created with the Java
Authentication and Authorization Service (JAAS) feature of Java 2 security is a
robust, secure way to deploy applications. An administrator creates the
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authentication alias that is used by one or more applications that need to access a
system. The user name and password can be known only to that administrator,
who can change the password in a single place when a change is required.

Related tasks

[“Creating an authentication alias” on page 41|

An authentication alias is a feature that encrypts the passwords used by the
adapter to access the mail server. You can gain a greater level of security by using
an authentication alias to configure the adapter, instead of typing the user ID and
password in directly.

Deployment options

There are two ways to deploy the adapter. You can either embed it as part of the
deployed application, or you can deploy it as a stand-alone RAR file. The
requirements of your environment affect the type of deployment option you
choose.

The deployment options are described below:

* With module for use by single application: With the adapter files embedded in
the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

¢ On server for use by multiple applications: If you do not include the adapter
files in a module, you must install them as a stand-alone adapter on each
application server where you want to run the module. Use a stand-alone adapter
when multiple modules can use the same version of the adapter and you want
to administer the adapter in a central location. A stand-alone adapter can also
reduce the resources required by running a single adapter instance for multiple
modules.

An embedded adapter is bundled within an enterprise archive (EAR) file and is
available only to the application with which it is packaged and deployed.

IBM Business Process Manager or Enterprise information
WebSphere Enterprise Service Bus system
Application
Module Module Embedded Businsss
Adapter < » function
Module

“«t

E-mails

A stand-alone adapter is represented by a stand-alone resource adapter archive
(RAR) file, and when deployed, it is available to all deployed applications in the
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server instance.

IBM Business Process Manager or Enterprise information
WebSphere Enterprise Service Bus system
Application A

Module Module

v
\4

Module Stand-alone Business
Adapter function

Application B
Module Module

v
A
\4

Module

E-mails

While creating the project for your application using IBM Integration Designer, you
can choose how to package the adapter [either bundled with the (EAR) file or as a
stand-alone (RAR) file]. Your choice affects how the adapter is used in the run time
environment, as well as how the properties for the adapter are displayed on the
administrative console.

Choosing either to embed an adapter with your application or to deploy the
adapter as a stand-alone module depends on how you want to administer the
adapter. If you want a single copy of the adapter and do not care about disruption
to multiple applications when you upgrade the adapter, then you would be more
likely to deploy the adapter as a stand-alone module.

If you plan to run multiple versions, and if you care more about potential
disruption when you upgrade the adapter, you would be more likely to embed the
adapter with the application. Embedding the adapter with the application allows
you to associate an adapter version with an application version and administer it
as a single module.

Considerations for embedding an adapter in the application

Consider the following items if you plan to embed the adapter with your
application:

* An embedded adapter has class loader isolation.

A class loader affects the packaging of applications and the behavior of
packaged applications deployed on run time environments. Class loader isolation
means that the adapter cannot load classes from another application or module.
Class loader isolation prevents two similarly named classes in different
applications from interfering with each other.

* Each application in which the adapter is embedded must be administered
separately.
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Considerations for using a stand-alone adapter

Consider the following items if you plan to use a stand-alone adapter:
 Stand-alone adapters have no class loader isolation.

Because stand-alone adapters have no class loader isolation, only one version of
any given Java artifact is run and the version and sequence of that artifact is
undetermined. For example, when you use a stand-alone adapter there is only
one resource adapter version, one adapter foundation class (AFC) version, or one
third-party JAR version. All adapters deployed as stand-alone adapters share a
single AFC version, and all instances of a given adapter share the same code
version. All adapter instances using a given third-party library must share that
library.

 If you update any of these shared artifacts, all applications using the artifacts are
affected.

For instance, if you have an adapter that is working with server version X, and
you update the version of the client application to version Y, your original
application might stop working.

* Adapter Foundation Classes (AFC) is compatible with previous versions, but the
latest AFC version must be in every RAR file that is deployed in a stand-alone
manner.

If more than one copy of any JAR file is in the class path in a stand-alone
adapter, the one that is used is random; therefore, they all must be the latest
version.

Note:

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation.jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during runtime, the adapter will return
the ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for Email version 7.5, the following error message is
displayed: IBM WebSphere Adapter for Email has loaded file:/C:/IBM/
WebSphere/ProcServer?7 /profiles /ProcSrv01/installedConnectors /
CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with version 7.0.0.3.
However, the base level of this jar required is version 7.5. When you install
multiple adapters with different CWYBS_AdapterFoundation jar versions, the
adapter returns the ResourceAdapterInternalException message, due to a version
conflict. To overcome this conflict, you must migrate all adapters to the same
version level. For further assistance, contact WebSphere Adapters Support for help.

Considerations while deploying WebSphere Adapter 7.5 with
another version

There are occasions when you have to work with embedded adapters that do not
need a client-server communication, standalone adapters that need a server
connection, or a hybrid mix of adapter connections.

The following scenarios cover the different behaviors of AFC version conflict
detection.

Deploying a standalone Adapter

1. Install WebSphere Adapter for Flat Files version 7.0.1.0 through the IBM
Business Process Manager administrative console.
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2. Install WebSphere Adapter for SAP Software version 7.5.0.0 through the
administrative console.

3. Create ActivationSpec for an ALE passthrough inbound operation.

4. Create an application in IBM Integration Designer for a standalone ALE
passthrough inbound operation.

5. Install and start the application through the administrative console.
6. Verify the error.

Note: An error message will be generated in the log/trace area of IBM Business
Process Manager, to indicate an AFC version conflict.

Deploying an embedded Adapter
1. Import a build of WebSphere Adapter for FTP version 7.0.1.0, using a RAR file.
2. Create a FIP Inbound EMD operation.

3. Import a build of WebSphere Adapter for Oracle E-Business Suite version
7.5.0.0, using a RAR file.

4. Create an Oracle inbound EMD operation, in the same module where you have
created the FTP Inbound EMD operation.

5. Deploy the module to IBM Business Process Manager.
6. Check the trace.

At step 5, the deployment should fail. At step 6, you will get an internal error
message resulting out of an AFC version conflict.

Note: To avoid a name conflict between the business object generated by the two
adapters, you may need to generate the artifacts into different folders.

Deploying a combination of standalone and embedded Adapters

1. Install WebSphere Adapter for JDBC version 7.0.1.0 through the IBM Business
Process Manager administrative console.

2. Create an ActivationSpec for a JDBC inbound operation.

3. Create an application in IBM Integration Designer for a JDBC inbound
operation, for the standalone Adapter deployment.

4. Deploy the JDBC inbound application and trigger your inbound events.

5. Create an application in IBM Integration Designer for a WebSphere Adapter for
SAP Software version 7.5.0.0 inbound embedded Adapter deployment.

6. Deploy an SAP inbound application, and trigger your inbound events.

Note: You can resolve the AFC version conflict by using different class loaders for
the standalone and embedded deployments. With this approach, the migration
process will handle different CWYBS_AdapterFoundation jar files and will not
conflict with each other. You can start both JDBC and SAP inbound applications
successfully, and process Inbound events without exception.

For further assistance, visit [http: / /www-947.ibm.com /support/entry/portal /|
Overview /Software/ WebSphere/WebSphere_Adapters_Family]|

WebSphere Adapters in clustered environments

You can improve adapter performance and availability by deploying a module on
a clustered server environment. Clusters are groups of servers that are managed
together to balance workloads and to provide high availability and scalability.
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The module you deployed is replicated across all servers in a cluster, regardless of
whether you deploy the module using a stand-alone or an embedded adapter. The
following IBM products support WebSphere Adapters in a clustered environment:

* IBM Business Process Manager or WebSphere Enterprise Service Bus
* WebSphere Application Server Network Deployment
¢ WebSphere Extended Deployment

When you set up a server cluster, you create a Deployment Manager profile. The
HAManager, a subcomponent of the Deployment Manager, notifies the Java 2
Platform, Enterprise Edition (J2EE) Connector Architecture (JCA) container to
activate an adapter instance. For information about creating clustered
environments, see the following link: |http:/ /publib.boulder.ibm.com/ infocenter/|
wasinfo/beta/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae /|
trun_wlm_cluster_v61.html|

Using WebSphere Extended Deployment, you can optionally enhance the
performance of adapter instances in your clustered environment. WebSphere
Extended Deployment extends the WebSphere Application Server Network
Deployment capabilities by using a dynamic Workload Manager instance instead of
a static Workload Manager. The dynamic Workload Manager instance can optimize
the performance of adapter instances in the cluster by dynamically balancing the
load of the requests. This means that application server instances can be
automatically stopped and started based on the load variations, allowing systems
with different capacities and configurations to handle load variations evenly. For
information about the benefits of WebSphere Extended Deployment, see

lhttp:/ /publib.boulder.ibm.com/infocenter /wxdinfo /v6rlm1/index.jsp|

In clustered environments, adapter instances can handle both inbound and
outbound processes.

Restriction: During inbound communication WebSphere Adapter for Email is not
able to switch polling between a IBM Business Process Manager or WebSphere
Enterprise Service Bus cluster backup node and the cluster's primary node when
each node is installed on a different operating system. For example, if the adapter
starts polling on a primary Windows node, it cannot switch to a backup UNIX
node because it cannot process the Windows path used for the directory storing in
progress events.

High availability for inbound processes

Inbound processes are based on events triggered as a result of updates to data in
the mail server. WebSphere Adapter for Email is configured to detect updates by
polling an event table. The adapter then publishes the event to its endpoint.

Important: In a clustered environment, the event directory must be on a shared
file system and not local to any of the cluster machines.

When you deploy a module to a cluster, the Java 2 Platform, Enterprise Edition
(J2EE) Connector Architecture (JCA) container checks the enableHASupport
resource adapter property. If the value for the enableHASupport property is true,
which is the default setting, all of the adapter instances are registered with the
HAManager with a policy 1 of N. This policy means that only one of the adapter
instances starts polling for events. Although other adapter instances in the cluster
are started, they remain dormant with respect to the active event until the active
adapter instance finishes processing the event. If the server on which the polling
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thread was started shuts down for some reason, an adapter instance that is
running on one of the backup servers is activated.

Note: In the active-passive configuration mode of the adapters, the endpoint
application of the passive adapter instance also listens to the events/messages even
if the enableHASupport property is set to True. This is because the
alwaysactivateAl1MDBs property in the JMS activation specification is set to True.
To stop the endpoint application of the passive adapter instance from listening to
the events, you must set the alwaysactivateATTMDBs property value to False. For
more information, see the|”Endpoint application of the passive adapter instance|
listens to the events when enableHASupport is set to True” on page 147[topic.

Note: In clustered environments, when the adapter works in a Active-Active
configuration, it provides both high availability and load balancing support. This
functionality is useful in production environments where high performance is
needed.

Important: Do not change the setting of the enableHASupport property.
High availability for outbound processes

In clustered environments, multiple adapter instances are available to perform
outbound process requests. Accordingly, if your environment has multiple
applications that interact with WebSphere Adapter for Email for outbound
requests, then you might improve performance by deploying the module to a
clustered environment. In a clustered environment, multiple outbound requests can
be processed simultaneously, as long as they are not attempting to process the
same record.

If multiple outbound requests are attempting to process the same record, such as a
Customer address, the workload management capability in WebSphere Application
Server Network Deployment distributes the requests among the available adapter
instances in the sequence they were received. As a result, these types of outbound
requests in a clustered environment are processed in the same manner as those in a
single server environment: one adapter instance processes only one outbound
request at a time. For more information about workload management, see the
following link: |http:/ /publib.boulder.ibm.com/infocenter /wasinfo /beta /|
findex.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/trun_wlm.html

Migrating to version 7.5 of WebSphere Adapter for Email

By migrating to version 7.5 of WebSphere Adapter for Email, you automatically
upgrade from the previous version of the adapter. Additionally, you can migrate
your applications that embed an earlier version of the adapter, so that the
applications can use features and capabilities present in version 7.5.

Migration considerations

WebSphere Adapter for Email version 7.5 may have some features and updates
that might affect your existing adapter applications. Before migrating applications
that use WebSphere Adapter for Email, you must consider some factors that might
affect your existing applications.

Compatibility with earlier versions

WebSphere Adapter for Email version 7.5 is fully compatible with the custom
business objects (XSD files) and data bindings that are created using the adapter
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version 6.1x, version 6.2x, and version 7.0 and enables the existing business objects
and data bindings to work well in the latest version of the adapter.

Because version 7.5 of WebSphere Adapter for Email is fully compatible with
version 6.1x, version 6.2x, and version 7.0, any of your applications that used
previous versions of WebSphere Adapter for Email runs unchanged when you
upgrade to version 7.5. However, if you want your applications to use features and
functionality present in version 7.5 of the adapter, perform the migration of the
artifacts as well as the upgrade of the adapter.

The migration wizard replaces (upgrades) version 6.1.x, version 6.2.x, or version
7.0 of the adapter with version 7.5 and enables version 7.5 features and
functionality for use with your applications.

Note: The migration wizard does not create components or modify existing
components, such as mappers and mediators to work with version 7.5 of the
adapters. If any of your applications embed an adapter that is version 7.0 or earlier
and you are upgrading to version 7.5, and you want your applications to take
advantage of the features and functions in version 7.5, you might need to change
those applications.

If the artifacts within a module have inconsistent versions, the entire module is
marked as unavailable for migration and cannot be selected. Version
inconsistencies are recorded in the workspace log, as they indicate that a project
might be corrupted.

The adapter migration wizard in IBM Integration Designer version 7.5 only
supports the migration of adapters from version 6.1x, version 6.2x, and version 7.0
to version 7.5. It does not support the adapter migration from lower versions to
any of the versions prior to version 7.5.

Deciding whether to upgrade or to upgrade and migrate

The default processing of the migration wizard is to perform an upgrade of the
adapter and to migrate the application artifacts so that the applications can use
features and functions in version 7.5 of the adapter. When you choose to upgrade
the adapter by selecting a project, the wizard automatically selects the associated
artifacts for migration.

If you decide that you want to upgrade the adapter from 6.1.x, version 6.2.x and
version 7.0 to version 7.5, but you do not want to migrate the adapter artifacts,
you can do so by deselecting the adapter artifacts from the appropriate area of the
migration wizard.

Running the migration wizard without selecting any adapter artifacts installs and
upgrades your adapter. As the artifacts are not migrated, your applications cannot
take advantage of the features and capabilities that exist in version 7.5 of the
adapter.

Migrating multiple adapters referred within a project

When a module contains one or more connector projects, each of which references
to different adapters (for example, a module project that contains connector
projects referring to JDBC and SAP adapters), the migration wizard identifies the
artifacts belonging to each adapter and migrates these artifacts without disrupting
the artifacts of other adapters.
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When you select the module project and launch the migration wizard:

* The Source connector field lists the connector projects with the selected module
project.
* The Dependent artifact projects area lists only the selected module project.

If you select the connector project and launch the migration wizard:
e The Source connector field lists only the selected connector project.

* The Dependent artifact projects area lists all projects which reference the
selected connector project, including the module project.

Run the migration wizard in a test environment

Because adapter migration might require you to change those applications that use
version 7.5 of WebSphere Adapter for Email, you must always perform the
migration in a development environment first and test your applications before
deploying the application to a production environment.

The migration wizard is fully integrated with the development environment.
Fault processing when migrating to version 7.0

Fault processing in version 7.0 depends upon the type of fault configuration done
in the previous version. If the user manually configures business faults in version
6.2 then the faults are automatically configured in version 7.5. In case no fault is
configured in version 6.2, then the user needs to manually configure the faults
after migrating to version 7.5, as per the steps described in the following section.

Performing the migration

You can migrate a project or EAR file to version 7.5 using the adapter migration
wizard. When the tool is finished, the migration is complete and you can work in
the project or deploy the module.

Before you begin

Review the information in Migration considerations.
About this task

To perform the migration in IBM Integration Designer, complete the following
steps.

Note: After migration is complete, the module is no longer compatible with
previous versions of the IBM Business Process Manager or WebSphere Enterprise
Service Bus runtimes or IBM Integration Designer.

The following steps describe how to run the adapter migration wizard from the
connector project menu while in the Java EE perspective in IBM Integration
Designer.

Procedure

1. Import the PI (project interchange) file for an existing project into the
workspace.

Note: Ensure that you do not modify the contents of the RAR or copy the
adapter JAR file outside the connector project.

30 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



. When projects are created in an earlier version of IBM Integration Designer, the
Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see |http://bidoc.torolab.ibm.com:7500/help/index.jsp?topic=/|
[com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.htmi|

. Change to the Java EE perspective.

. Right-click the module and select Migrate connector project. For example, the
adapter RAR module.

You can also launch the adapter migration wizard in the following ways:

* Right-click the project in the Java EE perspective and select Migrate adapter
artifacts.

* From the Problems view, right-click a migration-specific message and select
Quick Fix to correct the problem.

. In the Select Projects window, perform the following steps:

a. The Source connector field displays the name of the connector project that
you are migrating. If you are migrating a module project, this field lists all
the connector projects in the module project. Select the source project from
the list. For more information, see [“Migrating multiple adapters referred)|
[within a project” on page 29.|

b. The Target connector field displays the name of the connector to which you
are migrating. If you are working with more than one adapter version, this
list displays the names of all the compatible connectors. Select the connector
you want to migrate.

c. The Target version field displays the version corresponding to the target
connector that you selected in the previous step.

d. The Dependent artifacts project area lists the adapter artifacts that are
migrated. If you are migrating a module project, this area lists only the
selected module project. If you are migrating a connector project within the
module project, this area lists all projects which reference the selected
connector project, including the module project. By default, all the
dependent artifact projects are selected. If you do not select a dependent
artifact project, that project is not migrated. You can migrate any project that
you have not selected at a later time. Previously migrated projects, projects
with a current version, and projects that contain errors are unavailable for
migration and are not selected. For more information, see ["Upgrading but|
[not migrating a project” on page 32)

e. Click Next. A warning window is displayed with the message, “Properties
that are not supported in this version of the target adapter will be removed
during the migration”

f. Click OK.

. In the Review Changes window, review the migration changes that occur in
each of the artifacts that you are migrating. To view the details, expand each
node by clicking the + sign.

. To complete the migration:

* Click Finish.

e If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

Before running the migration process, the wizard performs a backup up of all
projects affected by the migration. The projects are backed up to a temporary
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folder within the workspace. If the migration fails for any reason, or if you
decide to cancel the migration before it completes, the wizard deletes the

modified projects and replaces them with the projects stored in the temporary
folder.

Upon completing the migration successfully, all backed up projects are deleted.

8. If you are migrating an EAR file, optionally create a new EAR file with the
migrated adapter and artifacts, and deploy it to IBM Business Process Manager
or WebSphere Enterprise Service Bus. For more information about exporting
and deploying an EAR file, see the topics devoted to it in this documentation.

Results

The project or EAR file is migrated to version 7.5. You do not need to run the
external service wizard after exiting the adapter migration wizard.

Upgrading but not migrating a project
You can upgrade the adapter from an earlier version, to version 7.5 while choosing
not to migrate the adapter project artifacts.

About this task

Running the migration wizard without selecting any adapter artifacts installs and
upgrades your adapter. As the artifacts are not migrated, your applications cannot
take advantage of the features and capabilities that exist in version 7.5 of the
adapter.

Procedure
1. Import the PI (project interchange) file into the workspace.

2. When projects are created in an earlier version of IBM Integration Designer, the
Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see |http:/ /bidoc.torolab.ibm.com:7500/help /index.jsp?topic=/|
[com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.htmi}

3. In the Java EE perspective, right-click the project name and click Migrate
connector project. The Adapter Migration wizard is displayed.

4. In the Select Projects window, clear the dependent artifact projects, and click
Next. A warning window is displayed with the message, “The properties that
are not supported in the version of the target adapter will be removed during
the migration.”

5. Click OK.

6. In the Review Changes window, review the migration changes that occur
during updating the project. To view the details, expand each node by clicking
the + sign.

7. To complete the migration:

* Click Finish.

¢ If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To

update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.
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Results

The project can now be used with WebSphere Adapter for Email, version 7.5.

Migrating WebSphere Business Integration applications for
use with Version 7.5 WebSphere Adapters

You need to migrate the WebSphere Business Integration applications so that they
become compatible with Version 7.5 of your adapter.

About this task

Migrating WebSphere Business Integration applications for use with Version 7.5 of
your WebSphere adapter is a multistep process. First, the artifacts from WebSphere
InterChange Server are migrated and converted. A project is then created for the
artifacts in IBM Integration Designer. In the remaining steps, the adapter-specific
artifacts are migrated and converted into the JCA-compliant format supported by
Version 7.5 of the adapter.

Example

The following diagram shows the wizards that you use to migrate WebSphere
Business Integration solutions from WebSphere InterChange Server, so that these
applications can be used with Version 7.5 of your adapter.

Migrating WebSphere Business Integration solutions

WebSphere InterChange Server

IBM Integration Designer Installation directory

The imported jar file

1 WebSphere becomes a project in

Interchange . . )
wizard P WebSphere InterChange Jar file
JCA-compliant at this point artifacts
2 . . Run the External
Enterprise service | service wizard to
wizard import the connector
project
3 | Adapter migration | Run the Adapter

migration wizard to

convert WBI adapter
artifacts into JCA-compliant
artifacts for use within

IBM Business Process
Manager

wizard

Roadmap for migrating applications from WebSphere
InterChange Server

To use Version 7.5 of WebSphere Adapter for Email with applications from
WebSphere InterChange Server, you need to migrate the application artifacts and
convert them so that they can be deployed and run on IBM Business Process
Manager or WebSphere Enterprise Service Bus. Understanding this task at a high
level helps you perform the steps that are needed to accomplish the task.

The following figure illustrates the flow of the migration task. The steps that

follow the figure describe this task at a high level only. See the topics following
this roadmap for the details on how to perform each of these steps.
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4

4. Run the adapter migration wizard
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End
Success

Figure 9. Roadmap for migrating applications from WebSphere InterChange Server

Migrating applications from WebSphere InterChange Server

This task consists of the following steps:
1. Run the WebSphere InterChange Server migration wizard.

The WebSphere InterChange Server migration wizard moves the application
artifacts into IBM Integration Designer. The migrated adapter artifacts are not
fully JCA-compliant at the completion of this task.

2. Verity that the WebSphere InterChange Server migration is successful.

Review all messages from the Migration results window and take action if
required.

3. Consider the implications of using Version 7.5 of WebSphere Adapter for Email.

In addition to considerations for migrating WebSphere InterChange Server
applications, you need to consider how Version 7.5 of WebSphere Adapter for
Email works with the migrated applications. Some of the adapter operations
supported by WebSphere InterChange Server applications might be supported
and implemented differently with Version 7.5 of the adapter.

4. Run the adapter migration wizard.

Run the adapter migration wizard to update adapter-specific artifacts such as
the schemas and service definition files (.import,.export, and .wsdl files) for use
with Version 7.5 of the adapter.

Migration considerations for WebSphere Business Integration

adapters

By migrating to WebSphere Adapter for Email Version 7.5, you have an adapter
that is compliant with the Java 2 Platform, Enterprise Edition (J2EE) Connector

Architecture (JCA) and designed specifically for service-oriented architecture.

Application artifacts

Before running the adapter migration wizard, use the WebSphere InterChange
Server migration wizard to generate the application artifacts for the WebSphere
Business Integration adapter, including the business objects, maps, and
collaborations. Then you can run the adapter migration wizard to update the
adapter-specific artifacts such as the schemas and service definition files
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(import,.export, and .wsdl) so that they are suitably converted into a format that is
compliant with JCA.

Run the migration wizard in a test environment first

Because migrating from a WebSphere Business Integration adapter to WebSphere
Adapter for Email might require changes to the applications that use Version 7.5 of
WebSphere Adapter for Email, always perform the migration in a development
environment first and test your applications before deploying the application to a
production environment.

Migrating application artifacts from WebSphere InterChange
Server

To migrate the application artifacts into IBM Integration Designer, run the
WebSphere InterChange Server migration wizard. The wizard imports and converts
most of the artifacts into a format that is compatible with IBM Business Process
Manager or WebSphere Enterprise Service Bus.

Before you begin

Launch the WebSphere InterChange Server migration wizard from within IBM
Integration Designer to migrate the application artifacts from WebSphere
InterChange Server format into artifacts that are compatible with IBM Business
Process Manager or WebSphere Enterprise Service Bus.

For information about how to prepare to migrate artifacts from WebSphere
InterChange Server and for detailed instructions on performing the migration and
verifying that the migration was successful, see [http://]
bidoc.torolab.ibm.com:7500/help / topic/com.ibm.wbpm.wid.imuc.doc/ topics /|

twics.htm!l

About this task

Running WebSphere InterChange Server migration wizard might not fully convert
adapter-specific artifacts (such as service descriptors, service definitions, and
business objects) into IBM Business Process Manager or WebSphere Enterprise
Service Bus compatible artifacts. To complete the migration of adapter-specific
artifacts, run the adapter migration wizard after you have successfully run the
WebSphere InterChange Server migration wizard.

Note: While you run the WebSphere InterChange Server migration wizard, ensure
that you set each connector in the repository to the same adapter version.

Results

The project and application artifacts are migrated and converted into IBM Business
Process Manager compatible artifacts.

What to do next

Run the adapter migration wizard to migrate the adapter-specific artifacts.

Migrating adapter-specific artifacts

After a project is created for the artifacts in IBM Integration Designer, you can
migrate the project using the adapter migration wizard. The adapter migration
wizard updates adapter-specific artifacts such as the schemas and service definition
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files (.import, .export, and .wsdl) for use with version 7.5 of the adapter. When you
finish running the adapter migration wizard, the migration is complete and you
can work in the project or deploy the module.

Before you begin

Before running the adapter migration wizard, you should do the following steps:

» Review the information in the [“Migration considerations” on page 2§ topic.

* Run the WebSphere InterChange Server migration wizard to migrate the project
and convert data objects for use with IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

After migration is complete, the module will work only with Version 7.5 of your
adapter.

To perform the migration in IBM Integration Designer, complete the following
steps.

Procedure
1. Import the PI (project interchange) file for an existing project into the
workspace.

2. When projects are created in an earlier version of IBM Integration Designer,
the Workspace Migration wizard starts automatically and selects the projects
to migrate. Follow the wizard and complete the workspace migration. For
more information, see |http:/ /bidoc.torolab.ibm.com:7500/help/|
[index jsp?topic=/com.ibm.wbpm.wid.imuc.doc/topics / tmigsrcart.html|

3. Change to the Java EE perspective.
4. Right-click the connector project and select Migrate connector project.

You can also launch the adapter migration wizard by using the right-click
option and selecting the module project in the Java EE perspective and
selecting Migrate adapter artifacts.

Note:

If the adapter type (for example, CICS/IMS adapter) is not supported by the
migration wizard, the Migrate connector project and Migrate adapter
artifacts menus are not available for selection. If the adapter project is of the
latest version and the module projects referencing this adapter project are also
of the latest version, these menus are disabled.

When you launch the migration wizard from the connector project while in
the Java EE perspective, by default all the dependent artifact projects are
selected. If you do not select a dependent artifact project, that project is not
migrated.

5. In the Select Projects window, perform the following steps:
a. The Source connector field displays the name of the connector project that
you are migrating. Select the source project from the list.

b. The Target connector field displays the name of the connector to which
you are migrating. If you are working with more than one adapter version,
this list displays the names of all the compatible connectors. Select the
connector to which you want to migrate.
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c. The Target version field displays the version corresponding to the target
connector you selected in the previous step.

d. The Dependent artifacts project area lists the adapter artifacts that are
migrated.

e. Review the tasks and warnings presented on the welcome page, and click
Next. A warning window is displayed with the message, “The properties
that are not supported in the version of the target adapter are removed
during the migration.”

f. Click OK.

In the Review Changes window, review the migration changes that occur in
each of the artifacts that you are migrating. To view the details, expand each
node by clicking the + sign.

To complete the migration:
* Click Finish.

e If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

9 Adapter Migration Wizard = @
Update Read-only files

The migration wizard has found these files in the read-only mode.
To update these files and continue with the migration, dick Finish,

=1-CWYES_Project
connectorModuleMETA-IMF fra.xml
\classpath

=)- flatbo_test
.casspath
QutboundInterface.import
AppsCustomer, xsd
AppsCustomerContainer, xsd
ExistsResult.xsd
AppsCustomerBG,xsd

(':" Mext : I Einish H Cancel ]

Before performing the migration process, the wizard backs up all projects
affected by the migration. The projects are backed up to a temporary folder
within the workspace. If the migration fails for any reason, or if you decide to
cancel the migration before it completes, the wizard deletes the modified
projects and replaces them with the projects stored in the temporary folder.

Select Project > Clean, to refresh and rebuild the workspace for the changes to
take effect.

Note: The inProgressFolder property in WebSphere Adapter for Email does
not have an equivalent property in WebSphere Business Integration Adapter
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for e-Mail. You must specify the value for the inProgressFolder property
manually after running the migration wizard.

9. On successful migration, all backed up projects are deleted. Remove the Sync
inbound flow manually as this flow is not used by the adapter. From the
migrated project, select the Input_Sync inbound flow, right-click and select
Delete.

(== Components

@D
% Untyped Component B irpuat; Ay

"::i Human Task
@1{ Java C:) L]
B2 Mediation Flow T @I”p”t—swﬁ pr
‘Q‘ Process
F Rule Group |
m |
=& State Machine @© sample_EM ) Add Note
| Hide Notes
= Import |
| Add Interface
-2 P Sample_EM Replace Bindin
References | P g
’ - Remove Binding
& Interface Map Refactor 3
= Selecto - i
f@@ elector o G
[& Outbound Adapters = Copy
= Inbound Adapters
3 Delete
Rename
Select all

10. If you are migrating an EAR file, create a new EAR file with the migrated
adapter and artifacts, and deploy it to IBM Business Process Manager or
WebSphere Enterprise Service Bus. For information about exporting and

loying an EAR file, see [“Deploying the module for production” on page|

123.
Results

The project is migrated to Version 7.5. You do not need to run the external service
wizard after exiting the adapter migration wizard.

Changes to the import, export, and WSDL files after migration
When the WebSphere InterChange Server migration wizard moves the application
artifacts into IBM Integration Designer, changes made are reflected in the service
definition files: the import, export and WSDL files.

The migrated adapter artifacts are not fully JCA-compliant at the completion of
this task. You can complete the migration of the adapter-specific artifacts (such as
service descriptors, service definitions, and business objects) to a JCA compatible
format by running the adapter migration wizard.

Changes to the import file

During migration, the affected module artifacts are migrated to an import file. The
existing JMS Binding property is changed to the EIS Binding property in the
import file. The other property details added in the import file include information
about the data binding configuration, changes to the connection information in the
Managed Connection Factory properties, and several new method bindings.
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Changes to the export file

During migration, the affected module artifacts are migrated to an export file. The
existing J]MS Binding property is changed to the EIS Binding property in the export
file. The other property details added in the export file include information about
the data binding configuration, changes to the connection information in the
Activation Specification properties, and several new method bindings.

Changes to the WSDL file after migration

During migration, the affected module artifacts are migrated to corresponding
WSDL files that include EMail specific service description WSDL artifacts. The
service description files become JCA compatible. The WSDL files will have an
input and output type for each operation. Both the inbound and outbound
operations work on their specific input types to produce corresponding output
types after the operations are performed.

Note:

* When you migrate multiple top level inbound business objects in the project,
only the first top-level business object inbound feature works correctly. For the
other top level inbound business object to work correctly, you must manually
modify the "emit + [verb name] + after image + [business object name]" method
in the Input_Processing.java and Input_Async_Processing.java class to call the
correct destination services.

¢ The WebSphere Business Integration Adapter for e-Mail properties that are either
not valid or not supported by WebSphere Adapter for Email are removed from
the migrated artifacts.

Samples and tutorials

To help you use WebSphere Adapters, samples and tutorials are available from the
Business Process Management Samples and Tutorials Web site.

You can access the samples and tutorials in either of the following ways:

* From the welcome page of IBM Integration Designer, click Go to Samples and
Tutorials. In the Samples and Tutorials pane, under More samples, click
Retrieve. Browse the displayed categories to make your selection.

* From the Business Process Management Samples and Tutorials Web site:
[http:/ /publib.boulder.ibm.com /bpcsamp /index.html]

Configuring the module for deployment

To configure the adapter so that it can be deployed on IBM Business Process
Manager or WebSphere Enterprise Service Bus, use IBM Integration Designer to
create a module, which is exported as an EAR file when you deploy the adapter.
You then specify the business objects you want to build and the system on which
you want to build them.

Road map for configuring the module

Before you can use WebSphere Adapter for Email in a runtime environment, you
must configure the module. Understanding this task at a high level helps you
perform the steps that are needed to accomplish the task.
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You configure the module for WebSphere Adapter for Email by using IBM
Integration Designer. The following figure illustrates the flow of the configuration
task, and the steps that follow the figure describe this task at a high level only. For
details about how to perform each of these steps, see the topics following this road
map.

1. Create an
authentication
alias

l

2.Create a
module

}

l a) Set deployment and
runtime properties

3. Define
business l

objects
b) Select a data

l type

4. Create the l
project c) Select a data
binding

l l

. . d) Select a data
5. Build business handler

services
e) Set interaction
specification properties
and generate artifacts

Figure 10. Road map for configuring the module

Configuring the module
This task consists of the following steps.

Note: These steps assume that you are using user-defined business objects that
require data transformation. If you are using generic business objects, which do not
require data transformation, some of the following steps are ignored. For example,
you do not need to select a data binding and a data handler.
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1. Create an authentication alias to access the mail server. Perform this step using
the administrative console.

2. Create a module in IBM Integration Designer.

Note: You create business objects in the module.
3. Define the business objects that is to be used by the project.

4. Create a project, which is used to organize the files associated with the adapter
by using the external service wizard in IBM Integration Designer.

5. Build business services by running the external service wizard from IBM
Integration Designer, then performing the following steps:

a. Specify the following deployment and runtime properties:
¢ Connection properties
* Security properties
¢ Deployment options
* Function selector - Inbound only

b. Select a data type and name the operation associated with this data type.
For each operation, specify the following information:

* The operation kind, for example, Create, Append, Exists.
* Specify whether the operation is pass-through or user defined.
c. Select the data binding. Each data type has an equivalent data binding used

to read the fields in a business object and fill the corresponding fields in a
file.

d. Select the data handler that is going to perform the conversions between a
business object and a native format.

e. Specify interaction specification property values and generate artifacts. The
output from running the external service wizard is saved to a business
integration module, which contains the business object or objects, and the
import or export file.

Configuring the mail server to work with the adapter

Before working with the adapter, you must install and configure a mail server
according to its user manual. The information about how to connect to the mail
server (such as user names, passwords, and port) is required by the external
service wizard in IBM Integration Designer when you create your adapter module.

Creating an authentication alias

An authentication alias is a feature that encrypts the passwords used by the
adapter to access the mail server. You can gain a greater level of security by using
an authentication alias to configure the adapter, instead of typing the user ID and
password in directly.

Before you begin

To create an authentication alias, you must have access to the IBM Business Process
Manager or WebSphere Enterprise Service Bus administrative console.

Note: Using the authentication alias is the default choice in the external service
wizard.

The following procedure shows you how to gain access to the administrative
console through IBM Integration Designer. If you are using the administrative
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console directly (without going through IBM Integration Designer), log in to the
administrative console and skip to step

About this task

Using an authentication alias eliminates the need to store the password in clear
text in an adapter configuration property, where it might be visible to others.

To create an authentication alias, use the following procedure.

Procedure
1. Start the administrative console.

To start the administrative console through IBM Integration Designer, perform
the following steps:

a.

In the Business Integration perspective of Integration Designer, click the
Servers tab.

If the server does not show a status of Started, right-click the name of the
server (for example, WebSphere Process Server) and click Start.

Right-click the name of the server and select Administration > Run
administrative console.

Log on to the administrative console. If your administrative console requires
a user ID and password, type the ID and password and click Log in. If the
user ID and password are not required, click Log in.

2. In the administrative console, click Security > Secure administration,
applications, and infrastructure.

3. Under Authentication, click Java Authentication and Authorization Service >
J2C authentication data.

4. Create an authentication alias:

a. In the list of J2C authentication aliases that is displayed, click New.

b. In the Configuration tab, type the name of the authentication alias in the
Alias field.

c. Type the user ID and password that are required to establish a connection
to the mail server.

d. Optionally type a description of the alias.
Click OK.
The newly created alias is displayed.
The full name of the alias contains the node name and the authentication
alias name you specified. For example, if you create an alias on the node
widNode with the name ProductionServerAlias, then the full name is
widNode/ProductionServerAlias. This full name is the one you use in
subsequent configuration windows.

f. Click Save.

Results

You have created an authentication alias, which you can use when you configure
the adapter properties.
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Related concepts

[‘User authentication” on page 22|

The adapter supports several methods for supplying the user name and password
that are needed to connect to the mail server. By understanding the features and
limitations of each method, you can pick a method that provides the appropriate
level of security and convenience for your application.

Creating the module

A module encapsulates the service in a reusable unit and consists of both a project
in IBM Integration Designer and a unit of deployment to IBM Business Process
Manager or WebSphere Enterprise Service Bus. The module is packaged and
deployed to IBM Business Process Manager or WebSphere Enterprise Service Bus
as an enterprise archive (EAR) file.

Procedure
1. If IBM Integration Designer is not currently running, start it now.

a. Click Start > Programs > IBM > IBM Integration Designer > IBM
Integration Designer 7.5.

b. If you are prompted to specify a workspace, either accept the default value
or select another workspace.

The workspace is a directory where IBM Integration Designer stores your
project.

c. Optional: When the IBM Integration Designer window is displayed, click
Go to the Business Integration perspective.

2. Right-click inside of the Business Integration section of the IBM Integration
Designer window.
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Figure 11. Business Integration section of the window

3. In the New Module window, type a name for the module in the Module Name
field. For example, to configure a module for outbound processing, type
Outbound as the module name. Click Finish.

Results

A new module is listed in the Business Integration window.
What to do next

Define business objects for the module.

Defining WebSphere Application Server environment variables

Use the administrative console of IBM Business Process Manager or WebSphere
Enterprise Service Bus to define WebSphere Application Server environment
variables.

About this task

To define a WebSphere Application Server environment variable, use the following
procedure.

Procedure
1. Start the administrative console.
2. Select Environment > WebSphere Variables.
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3. Select the scope for the environment variable. The scope specifies the level at
which the resource definition is visible on the administrative console panel. The
possible values are server, node, and cell. In the following figure, the scope is
defined at the cell level as Cel1=DmgriCell.
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WebSphere Variables
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Figure 12. Setting the scope for the environment variable

ol

4. Click New and provide a name and a value for the environment variable. The
name is the symbolic name that represents a physical path. The value is the
absolute path that the variable represents. In this example, the name is
ARCHIVE_FOLDER and the value is C:/email/ArchiveFolder. You can use the
Description field, which is optional, to describe the purpose of the variable.
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Integrated Solutions Console
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Figure 13. Providing a name and a value for the environment variable

5. Click OK to save the changes.

Results

An environment variable called ARCHIVE_FOLDER is defined, with the value
C:/email/ArchiveFolder and a scope of Cell=Dmgr1Cell. You can use it in the
external service wizard whenever you need to specify the event directory.
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Figure 14. The new environment variable ARCHIVE_FOLDER displayed in the WebSphere
Variables window

What to do next

Define business objects for the module.
Related concepts

[“WebSphere Application Server environment variables” on page 15|

WebSphere Application Server environment variables can be used in the external
service wizard to specify directory values. You can now change any string property
values in inbound and outbound configuration by only changing the environment
variables.

[‘Required folders for inbound processing” on page 21|
Several folders are required for activities such as archiving and storage before you
run the adapter for inbound processing.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

Defining business objects

Create new business objects or import predefined business objects that is to be
used by the module. WebSphere Adapter for Email uses business objects to either
obtain information from an e-mail or to produce an e-mail.
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About this task

You use the business object editor to create new business objects or import
predefined business objects.

Note: These steps must only be used for payload business objects (such as
Customer and Order) and not for top-level e-mail business objects (wrappers).
Wrapper business objects are created by the external service wizard.

Procedure
* To create new business objects, complete the following steps.

1. Expand the new module located inside of the Business Integration section of
the IBM Integration Designer window.

Right-click the Data Types folder and select New > Business Object.
In the Business Object window, type a name in the Name field.
Click Finish. The new business object is added to the Data Types folder.

Click the Add a field to a business object icon and add the necessary fields
to the business object.

6. Click the Save icon.

7. Repeat the previous steps for each business object that you want to create.

A

* To import predefined business objects, complete the following steps.

1. Expand the new module located inside of the Business Integration section of
the IBM Integration Designer window.

Right-click the Data Types folder and select Import.

In the Select window, expand General and click File System.
Click Next.

Browse to the directory with the XSD file and click OK.
Select one or more business object XSD files and click Finish.

SIS EE NI

Results

The new business objects are defined.
What to do next

Create a project, which is used to organize the files associated with the adapter.
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Related concepts

[‘Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

Related reference

[“Business object information” on page 150

A business object is a structure that contains specific information about an e-mail
being processed by an inbound or outbound module. Business objects contain
information about how the adapter processes the e-mail content and attachments,
and also how the business objects are associated with an operation (such as
Create). Business object names are generated by the external service wizard and
are named according to their contents.

Creating a simple service with the adapter pattern wizard

Adapter patterns provide a quick and easy way of creating a simple service with
an adapter.

Before you begin

To use the WebSphere Adapter for Email pattern wizard, you must have already
created a module for the service.

About this task

The following adapter pattern is available for WebSphere Adapter for Email:
Table 4. Adapter pattern

Adapter pattern Description

Simple outbound e-mail | The "create an outbound Email service to send mail" pattern

pattern creates a service that sends simple e-mail messages using a mail
server.

In this example, create an outbound service that creates simple alert e-mails and
send them to a mail server for distribution.

Complete the following steps to create this service with the adapter pattern wizard.

Procedure

1. Right-click the module within the Business Integration section of the IBM
Integration Designer window and select New > External Service. The Select the
Service Type or Registry window opens.

2. Select Simple: Create an outbound e-mail service to send mail and click Next.
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Figure 15. Select the Service Type or Registry window

3. In the E-mail service name window, change the name to something meaningful
such as EmailOutboundInterface and click Next.
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4= New Outbound E-mail Service
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Figure 16. E-mail service name window

4. In the E-mail Server window, specify both the E-mail server host name and the
Port fields. For example, connecting to local host on port 25. Click Next.

5. In the E-mail server security credential window, select either No security,
Using an existing JAAS alias or Using user name and password and click
Next.
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Figure 17. E-mail server security credential window

Results

The outbound service is created, which includes the following artifacts:

Table 5. Artifacts for the outbound service

Artifact Name Description

Import EmailOutboundInterface The import exposes the
module internally, in this
case, to the mail server.

Interface EmailOutboundInterface This interface contains the
operation that can be
invoked.

Operation createEmail createEmail is the only

operation in the interface.

Starting the external service wizard

To begin the process of creating and deploying a module, you start the external
service wizard in IBM Integration Designer. The wizard creates a project that is
used to organize the files associated with the module.
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Before you begin

Make sure that you have gathered the information to establish a connection to the
mail server. For example, you need the name or IP address of the mail server and
the user ID and password to access it.

About this task

Start the external service wizard to create a project for the adapter in IBM
Integration Designer. If you have an existing project, you can select it instead of
having the wizard create one.

To start the external service wizard and create a project, use the following
procedure.

Procedure

1. To start the external service wizard, go to the Business Integration perspective
of IBM Integration Designer, and then click File > New > External Service.

2. In the External service window, expand Adapters and select Email, which is
the type of adapter you want to create. Then click Next.

3. In the Select an Adapter window, select the adapter name to create a project, or
select an existing project to reuse it.

* To create a project, perform the following steps:
a. Select IBM WebSphere Adapter for Email (IBM : 7.5.0.0) and click Next.

b. In the Adapter Import window, provide details about the project you
want to create.
1) In the Connector project field, optionally specify a different name for
the project.
2) In the Target runtime field, select the server (for example, IBM
Business Process Manager).
3) Click Next.

* To select an existing project, select the project folder under IBM WebSphere
Adapter for Email (IBM : 7.5.0.0) and then click Next.

Results

For a new project, the project is created and is listed in the Business Integration
perspective. The wizard creates the adapter artifacts in the specified project.

Configuring the module for outbound processing

To configure a module to use the adapter for outbound processing, use the external
service wizard in IBM Integration Designer to build business services, specify data
transformation processing, and generate business object definitions and related
artifacts.

Configuring the module using the simple e-mail data type

To configure a module for outbound processing using the simple e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services and generate business object definitions and related artifacts.
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Related concepts

[‘Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Resource adapter properties” on page 184

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Interaction specification properties” on page 188

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

Setting deployment and runtime properties for simple e-mail data type:

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

Before you begin

To perform this task, you must have created a module. The module name is
displayed in the Project Explorer view of the IBM Integration Designer.

About this task
To set connection properties, follow this procedure. For more information about

any of the properties in this topic, see the [“Managed connection factory properties’]
topic.

Procedure

1. In the Select the Processing Direction window, select Outbound and click Next.
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Figure 18. Choosing inbound or outbound in the external service wizard

The Specify the Security and Configuration Properties window is displayed.

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

3. Under the E-mail system connection information, type the Host name. The
properties in this window correspond to the managed connection factor
properties. For detailed information about these properties, see

[connection factory properties” on page 175
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Figure 19. Security and configuration properties window

4. Type the Port number. The default value for the SMTP protocol is 25. If your
SMTP mail server is listening on a different port number, change this value.

5. Clear the Select when antivirus or firewall software is running check box if
you do not want the adapter to close the managed connection after each
outbound request. If an antivirus program or firewall is running on your
system (the machine on which the adapter is deployed or the one that hosts the
mail server) and this check box is cleared, the adapter might fail to send
outbound e-mails. Leaving this check box selected is recommended.

6. Optional: Click Advanced and expand the Additional properties, Logging and
tracing , or Bidi properties sections as needed.
* Additional properties
a. Select Enable transport security (SSL) check box to specify if secure
socket layers are enabled for outbound communication. For more
information, see |"Secure connection (SSL) (enableSSL)” on page 181.|

b. In the Alternate e-mail ID in case of delivery failure field, specify an
alternate e-mail address to receive undeliverable mail notifications. This
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e-mail address can be a different e-mail address than the one you
specified in the From e-mail address. For more details about this property,
see |“Alternate e-mail ID in case of delivery failure” on page 179.

c. In the Maximum retries in case of system connection failure field, type
the number of times the adapter retries the connection before reporting a
polling error. For more information, see |“Maximum retries on connection|
[failure (connectionRetryLimit)” on page 179

d. In the Connection retry interval (in milliseconds) field, specify the time
interval between the attempts to reconnect to the mail server if the
connection fails. For more information, see [‘Retry interval if connection|
lfails (in milliseconds) entities” on page 178,

Logging and tracing

a. If you have multiple instances of the adapter, expand Logging and
tracing and enter a value in the Adapter ID field that is unique for this
instance. For more information about this property, see [Resource adapter]
[properties” on page 184/

b. If you want to mask certain information so that the information is not
displayed in the logs or traces, select Disguise user data as "XXX" in log
and trace files. For more information, see|“Disguise user data as "XXX" in|
llog and trace files (HideConfidentialTrace) ” on page 178)

Bidi properties

a. Select the Bidi transformation check box to specify bidirectional format.
For more information about setting the Bidi properties, refer to the
[“Globalization” on page 214| section.

In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

To use a J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

To use the security properties from the managed connection specification,
click Using security properties from the managed connection factory and
enter the following information:

— In the User name field, type the user name for the mail server.
— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. During outbound communication, you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the e-mails.

To administer the user name and password from another mechanism, click
Other.

Optional: Select the Change logging properties for wizard check box, if you
want to define the level of logging for this module.

For Data format, select Specify a data binding for each operation. Although
the default value is Use a data binding configuration for all operations, select
Specify a data binding for each operation, because the adapter has a different
data binding for each supported business object. These data bindings have
different properties, and need to be configured differently.
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Important: Do not click Next in this window until you have completed the
steps to create a data binding or browse for an existing one.

What to do next

Select the data type and operation name.
Related concepts

[“Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

[“User authentication” on page 22|

The adapter supports several methods for supplying the user name and password
that are needed to connect to the mail server. By understanding the features and
limitations of each method, you can pick a method that provides the appropriate
level of security and convenience for your application.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Resource adapter properties” on page 184]

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Interaction specification properties” on page 18§

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

[“Globalization” on page 214

WebSphere Adapter for Email is a globalized application that can be used in
multiple linguistic and cultural environments. Based on character set support and
the locale of the host server, the adapter delivers message text in the appropriate
language. The adapter supports bidirectional script data transformation between
integration components.

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

Selecting a data type and operation name:

Use the external service wizard to select a data type and name the operation
associated with this data type. For outbound communication, the external service
wizard gives you the choice of four different data types: simple e-mail, generic
e-mail, generic e-mail with business graph, and user-defined type. Each data type
corresponds to a business object structure.
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Before you begin

You must have specified the connection properties for the adapter to connect to the
mail server before you can specify the operation and data type for the module.

About this task

To select a data type and name the operation associated with it, follow this
procedure.

Procedure

1. In the Add, Edit, or Remove Operations window, click Add to create an
operation.

2. In the Specify the I/O Properties window, select the simple e-mail from The
data type for the input operation list and click Next. For more information
about data types and the types of e-mails they create, see the business object
structures section in this documentation.

Note: You can select the Enable response on delivery check box to configure
the outbound response from the mail server.

3. In the Specify the I/O Properties window, type an Operation name.

& Add Operation |Z|@”zl
Specify the 1/ 0 Properties

Operation name: = | sendSimpleAlertEmail |

Specify the Operation Input

Data format options: |Use suggested data format ‘EmailSimpleDataBinding' |W |

Specify the Operation Qutput

Data format options: |Use suggested data format EmailSimpleDataBinding' |+ |

® ext Firiish ] [ Cancel

Figure 20. Naming the operation
Name the operation something meaningful, for example,
sendSimpleAlertEmail. For more information about the types of operations the

adapter can perform, see the topic on Supported Operations in this
documentation.

Note: Names cannot contain spaces.
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4. The external service wizard defaults to the correct data binding,
EmailSimpleDataBinding.

5. Click Finish.
Results

A data type is defined for the module and the operation associated with this data
type is named.

What to do next

Specify interaction specification properties and generate artifacts for the module.
Related concepts

[“Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

[“The external service wizard” on page 16|
The external service wizard provides a blueprint to create services from existing
elements like business objects.

Setting interaction specification properties and generating the service:

Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level
business object.

Before you begin

To set interaction specification properties and generate artifacts for your module,
you must have specified the data type and operation name.

About this task

Interaction specification properties do not take precedence over request business
object attributes, except for the user name and password properties. User name
and password values specified in the interaction specification properties take
precedence over values set in the managed connection factory properties. To set
interaction specification properties and generate artifacts, follow this procedure.
For more information about interaction specification properties, see the
lspecification properties” on page 188 topic.

Procedure
1. Optional: To set interaction specification properties, complete these steps:
a. Click Advanced.
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|
|
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|
|
|
|

[Select... ]

© (oo o

Figure 21. Setting interaction specification properties

b. Type values for any fields you want to set as defaults.

c. Optional: In the EnvelopeForm field, type an e-mail address to receive
undeliverable mail notifications on a different e-mail address than the Form
e-mail address. For more details about this property, see
Bpecification properties” on page 188

d. Click Next.

2. In the Specify the Name and Location window, select the Module from the list.
For example, Outbound for outbound processing.

3. Optional: Name the Folder to store the artifacts.

4. Type a Name for the interface. This name displays in the IBM Integration
Designer assembly diagram.

5. Optional: Type a Description.
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6. Click Finish. The IBM Integration Designer assembly diagram opens and the
interface you created is displayed.

9& Outbound - Assembly Diagram 23 (2] Customer
4 oFPalette

NEEEAE
= Favorites @ @ CutboundInterface E

= Components

U’,Ji., Untyped Component
42 Human Task

Uﬂ Java

T, Mediation Flow

ﬁ" Process

Es Rule Group

S state Machine

(B Impart
%] Export

References

Figure 22. Interface in IBM Integration Designer

The business object you created is also displayed in a different tab.
Results
IBM Integration Designer generates the artifacts and an import. The outbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.
Related reference

[“Interaction specification properties” on page 18§|

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

Configuring the module using the generic e-mail data type

To configure a module for outbound processing using the generic e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.
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Related concepts

[‘Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Resource adapter properties” on page 184

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Interaction specification properties” on page 188

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

Setting deployment and runtime properties for generic e-mail data type:

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

Before you begin

To perform this task, you must have created a module. The module name is
displayed in the Project Explorer view of the IBM Integration Designer.

About this task
To set connection properties, follow this procedure. For more information about

any of the properties in this topic, see the [‘Managed connection factory properties’]
topic.

Procedure

1. In the Select the Processing Direction window, select Outbound and click Next.
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Figure 23. Choosing inbound or outbound in the external service wizard

The Specify the Security and Configuration Properties window is displayed.

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

3. Under the E-mail system connection information, type the Host name. The
properties in this window correspond to the managed connection factor
properties. For detailed information about these properties, see

[connection factory properties” on page 175
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Figure 24. Security and configuration properties window

4

5.

. Type the Port number. The default value for the SMTP protocol is 25. If your
SMTP mail server is listening on a different port number, change this value.

Clear the Select when antivirus or firewall software is running check box if
you do not want the adapter to close the managed connection after each
outbound request. If an antivirus program or firewall is running on your
system (the machine on which the adapter is deployed or the one that hosts the
mail server) and this check box is cleared, the adapter might fail to send
outbound e-mails. Leaving this check box selected is recommended.

Optional: Click Advanced and expand the Additional properties, Logging and
tracing , or Bidi properties sections as needed.
* Additional configuration
a. Select Enable transport security (SSL) check box to specify if secure
socket layers are enabled for outbound communication. For more
information, see I"Secure connection (SSL) (enableSSL)” on page 181.|

b. In the Alternate e-mail ID in case of delivery failure field, specify an
alternate e-mail address to receive undeliverable mail notifications. This
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e-mail address can be a different e-mail address than the one you
specified in the From e-mail address. For more details about this property,
see|“Alternate e-mail ID in case of delivery failure” on page 179.

c. In the Maximum retries in case of system connection failure field, type
the number of times the adapter retries the connection before reporting a
polling error. For more information, see |”Maximum retries on connection|
[failure (connectionRetryLimit)” on page 179

d. In the Connection retry interval (in milliseconds) field, specify the time
interval between the attempts to reconnect to the mail server if the
connection fails. For more information, see [‘Retry interval if connection|
lfails (in milliseconds) entities” on page 178,

* Logging and tracing
a. If you have multiple instances of the adapter, expand Logging and
tracing and enter a value in the Adapter ID field that is unique for this
instance. For more information about this property, see [Resource adapter]
[properties” on page 184/

b. If you want to mask certain information so that the information is not
displayed in the logs or traces, select Disguise user data as "XXX" in log
and trace files. For more information, see|“Disguise user data as "XXX" in|
llog and trace files (HideConfidentialTrace) ” on page 178)

* Bidi properties
a. Select the Bidi transformation check box to specify bidirectional format.

For more information about setting the Bidi properties, refer to the
[“Globalization” on page 214| section.

7. In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

* To use a J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the managed connection specification,
click Using security properties from the managed connection factory enter
the following information:

— In the User name field, type the user name for the mail server.

— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. During outbound communication, you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the e-mails.

* To administer the user name and password from another mechanism, click
Other.

8. Optional: Select the Change logging properties for wizard check box, if you
want to define the level of logging for this module.

9. For Data format, select Specify a data binding for each operation. Although
the default value is Use a data binding configuration for all operations, select
Specify a data binding for each operation, because the adapter has a different
data binding for each supported business object. These data bindings have
different properties, and need to be configured differently.
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Important: Do not click Next in this window until you have completed the
steps to create a data binding or browse for an existing one.

What to do next

Select the data type and operation name.
Related concepts

[“Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Resource adapter properties” on page 184

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Interaction specification properties” on page 18|

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

[‘Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

Selecting a data type and operation name:

Use the external service wizard to select a data type and name the operation
associated with this data type. For outbound communication, the external service
wizard gives you the choice of four different data types: simple e-mail, generic
e-mail, generic e-mail with business graph, and user-defined type. Each data type
corresponds to a business object structure.

Before you begin

You must have specified the connection properties for the adapter to connect to the
mail server. You have chosen to specify a data binding for each operation.

About this task

To select a data type and name the operation associated with it, follow this
procedure.
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Procedure

1. In the Add, Edit, or Remove Operations window, click Add to create an
operation.

2. In the Specify the I/O Properties window, select a data type from The data
type for the input operation list. The Generic e-mail business object and
Generic e-mail business object with business graph are the available generic
e-mail data types. Click Next. For more information about data types and the
types of e-mails they create, see the business object structures section in this
documentation.

Note: You can select the Enable response on delivery check box to configure
the outbound response from the mail server.

3. In the Specify the I/O Properties window, type an Operation name.

# Add Operation |Z||E|El
Specify the 1/ 0 Properties

Operation name: = | sendEmailBG |

Specify the Operation Input
Data format: = Mot defined

Specify the Operation Output
Data format: = Mot defined

Figure 25. Naming the operation

Name the operation something meaningful. To use this module to create and
send e-mails constructed using information supplied in customer business
objects, name it something like sendEmailBG. For more information about the
types of operations the adapter can perform, see the topic on Supported
Operations in this documentation.

Note: Names cannot contain spaces.

Results

A data type is defined for the module and the operation associated with this data
type is named.

What to do next
Browse for or create a data binding for the module.
Configuring the data binding:
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Data bindings read the fields in a business object and fill the corresponding fields
in an e-mail. In the external service wizard, you add a data binding to your
module and configure it to correspond with your data type. This way, the adapter
knows how to populate the fields in an e-mail with information it receives in the
business object.

Before you begin

You must have entered service configuration properties for the connection to the
mail server. You have defined the data type for the module and named the
operation associated with this data type. You have chosen to specify a data binding
for each operation.

About this task
To browse for or create a data binding for the module, follow this procedure.

Note: You can configure the data bindings before running the external service
wizard using IBM Integration Designer. To configure the data bindings, select New
> Configure Binding Resource in IBM Integration Designer and complete the data
binding windows described in this documentation.

Procedure

1. In the Specify the I/O Properties window, click Select next to the Data format
field.

2. In the Select a Data Format Transformation window, select the Use existing
data format transformation from the list option. From the list, select
EmailWrapperDataBinding. To configure a custom data binding, select the
Select your custom data format transformation from the workspace option.
Click Next.
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& Data Binding Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To uze your own custom data
transformation, select the second radio button to add your custom transformation,

() Use existing data format transformation from the list

@ EmailWWrapperDataBinding

[15haw the deprecated data format transformations

Description:

This Data Binding handles the transformations that are required for the Email adapter

®

ack [ MNext = H Finish

] [ Cancel

Figure 26. Selecting the data binding

3. In Specify the Data Transformation Properties window, click Next.

Note: This window is used for configuring the data handlers.

configuration details.

a. In the Configure a New Data Transformation window, the Module defaults
to the module name you typed earlier in the wizard. To use a different
module that you want to create a data binding for, select New to create a

module.
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& Data Binding Configuration
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Create a data transformation configuration. |

Module or library:

lMamespace: http: /{EmailModule femail Default
Folder: email
[Mame: DataBindingConfiguration

Description:

@] Finish ] [ Cancel

Figure 27. Naming the data binding configuration
b. If you want to select a new folder for the artifact, click Browse and select a

new folder location. If you do not browse for a new folder location, the
artifacts are created in the root directory for the module.

c. Type a Name for the data binding configuration and click Finish.
Results
A data binding is configured for use with the module.
What to do next
Specify data binding properties.
Configuring business object properties and data handlers:
When you intend to use a data type that contains business objects, you must
specify properties for those business objects. Completing this step does not add
child business objects to the Email parent object. Rather, it tells the adapter how to
process particular types of business objects. Data handlers perform the conversions
between a business object and a particular MIME format.

Before you begin

You must have created a data binding before specifying business object properties
and data handlers for the module. Also, you must have predefined business objects
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using IBM Integration Designer Business Object Editor. If you stop the wizard here
to create business objects, you must start the wizard steps from the beginning and
your work is not saved.

Note: Data handlers can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data handler
windows described in this documentation.

About this task
To specify business object properties and data handlers, follow this procedure.

Note: For operations that do not require data transformation (pass-through
operations), you do not need to fill out this window. Click Finish and complete the
data binding configuration wizard.

Procedure

1. In Specify the Data Transformation Properties window, click Add to add
business object types to the data binding description .

2. In the Add/Edit properties window, ensure that DataHandler is selected in
the Binding type field.

3. In the Business object type field, click Browse for existing business objects or
New to create a business object. These business objects must be imported to
IBM Integration Designer before you start the external service wizard.
Selecting business objects here does not physically add child business objects.
Adding business objects at this stage in the wizard tells the adapter that you
are going to use certain business object types with your module. It enables the
adapter to know what data binding to apply to any child business objects it
processes.

& Add/Edit

Add/ Edit properties
ﬂ Data handler configuration: cannot be empty.

Binding type: | Datatandler v|

Busnessobject type: = | Whiaddress {nttp://Gener| [Browse. .. | [rew... |
Mime type: = | |

Encoding: [uTFa | select... |

Data handler configuration: = Mot defined

@

Figure 28. Adding or editing business object data binding properties
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Note: The encoding specified for configuring the XML data handler for mime
type (text/xml) must have the same value that is specified for Encoding in the
EmailWrapperDataBinding properties.

4. If you selected Browse for the Business object type field, select a data type
from the Data Type Selection window and click OK.

5. If you selected New for the Business object type field, complete the following
steps.

&= New Business Object

Create a Business Object o]
Business objects are containers for application data that represent business functions or elements, such as a
customer or an invoice,
Module ar library: IOuthound vl [ Browse... ] [ Mew... ]
MNamespace: ‘ http: {fOutbound | Default
Folder: ‘ | [ Browse... J
Mame: ‘ Customer |
Inherit from: [ <nong> l [ Browse... ] [ New... ] [Clear ]

Business objects, by default, are created as global complex types. However, some integration scenarios might
require a global element, Mare...

[l create the business ohject as an element

@ < Back [ Mext = ][ Finish H Cancel

Figure 29. Specifying business object properties for the module

a. Select the Module from the list. If the correct module is not shown,
Browse for it or click New to create a module.

b. Optional: Type a Folder name or Browse for the folder on your local drive
where business object schema files (XSD files) generated by the external
service wizard are stored.

c. Type a Name for the business object.

d. If you do not want to populate the business object with fields from one or
more existing business objects, click Finish.

e. If you want to populate the business object with fields from one or more
existing business objects, click Next.

Email 73



74

4= New Business Object

Derived Business Object

Populate the new business object with fields frorr%ﬂe or more existing business objects, |
Available business objects: Fields to include:

| [C1Email Mame Type

| C]Header

O Elmailattachment

L} [Zl UnstructuredContent
L 2] Whiaddress :
4] C]'\‘Ubiphone http:

x.ibm. com fn

S
|

@ ext I‘ Finish ][ Cancel

Figure 30. Deriving business object fields from an existing business object

f. Select the correct business object and click Finish. The Business object type
in the Add/Edit properties window is populated.

6. In the Add/Edit properties window, select a Mime type such as text/xml or
text/html for your business object. The mime type corresponds to the data
handler that is used by the adapter to perform data transformation from one
format to another. This step enables the adapter to decide which format it has
to convert the content to when it encounters the business object.

7. In the Encoding field, click Select if you want to choose a different encoding
value.

8. In the Data handler configuration field, click Select. Complete the following
steps to create and configure a data handler.

a. In the Select a Data Format Transformation window, click Use existing
data format transformation from the list option. Select XML data handler
from the list and click Next.
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& Data Handler Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To use your own custom data L
transformation, select the second radio button to add your custom transformation, i

() Use existing data format transformation from the list

[ pelimited

[ Fived width

@ Handled by WTX

%. Handled by WTX Invoker
2 1s0n

= 0N

[]5haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

0n inbound, parses XML data into & business object. On outbound, serializes business object to XML data

\

Figure 31. Selecting the data handler configuration type

Note: The Select your custom data format transformation from the
workspace option is available for advanced users who want to use a
custom data handler. A custom data handler, once placed in the class path,
shows when this option is selected.

9. In the Specify the Data Transformation Properties window, select the
Encoding value, and click Next. This value indicates the type of character
encoding the adapter uses during data transformation. For more information
about the encoding property, see the [“Email business object properties” on|
[page 155 topic

10. In the Configure a New Data Transformation window, select the Module from
the list. If the correct module is not displayed, click New to create a new one.

a. Optional: Type a Folder name to specify a folder for the artifacts.

b. Leave the default data handler Name or type a new one and click Next.
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& Data Handler Configuration

Configure a New Data Transformation

Create a data transformation configuration. L

=y

Module or library: |Outbnund - | l Browse. .. ] [ Mew. .. ]
MNamespace: |I1tt|J:_."_."OuﬂJDund | Default

Folder: | | ’ Browse... ]

Mame: | DataHandlerConfiguration |

Description:

® Finish ] [ Cancel

Figure 32. Creating a data handler

c. Click Finish.

11. In the Add/Edit Properties window, click Finish.

12. Optional: If you want to add another business object type to the module, click
Add in the Specify the Data Transformation Properties window. Repeat the
steps in this topic to specify business object properties and a data handler for

each business object.

Results

Business object properties and their data handlers are created.

What to do next

Set interaction specification properties and generate artifacts for your module.

Setting interaction specification properties and generating the service:

Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level

business object.
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Before you begin

To set interaction specification properties and generate artifacts for your module,
you must have already configured data bindings and selected business objects.

About this task

Interaction specification properties do not take precedence over request business
object attributes, except for the user name and password properties. User name
and password values specified in the interaction specification properties take more
precedence over values set in the managed connection factory properties. To set
interaction specification properties and generate artifacts, follow this procedure.
For more information about interaction specification properties, see the
specification properties” on page 188] topic.

Procedure
1. Optional: To set interaction specification properties complete these steps:
a. Click Advanced.
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#* New External Service

Add, Edit, or Remove Operations

The adapter will use these operations to access native functions.

Operations:

£

3 sendEmailBG (fhttp: /S ibm,comfxmins jorod fwebsphere fj2ca/email femailbg  EmailBs) @ fhttp:| | Add

Edit...

ek

Remave

Operation Properties
InteractionSpec Properties for 'sendEmailBG’

Additional properties

From:

Reply to:

To:

G

E-mail subject:

User name:

Password:

|
|
|
|
Bec: |
|
|
|
|

Encoding:

[Select. - ]

® « Back ][ MNext =

Cancel

Figure 33. Setting interaction specification properties

b. Type values for any fields you want to set as defaults.

c. Click Next.

2. In the Specify the Name and Location window, select the Module from the list.

For example, Emai1Module for outbound processing.
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#= New External Service

Specify the Name and Location

ol
Specify the name and location of the new service and its interface.
Properties for Service
Module: | Lser w |
Use the default namespace
Folder: | | [Bro'a'-.'se... ]

Mame: >=U| OutboundInterface |

[]save business objects to a library

Description: |

® axt > Finish H Cancel

Figure 34. Naming the artifact

3. Optional: Name the Folder that is used to store the artifacts.

4. Type a Name for the interface. This name displays in the IBM Integration
Designer assembly diagram.

5. Optional: Type a Description.

6. Click Finish. The IBM Integration Designer assembly diagram opens and the
interface you created is displayed.
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9& Outbound - Assembly Diagram 23 (2] Customer
4 oFPalette

NEEEAE
= Favorites @ @ CutboundInterface E

= Components

U’,Ji., Untyped Component
42 Human Task

Uﬂ Java

T, Mediation Flow

ﬁ" Process

Es Rule Group

S state Machine

(B Impart
%] Export

References

Figure 35. Interface in IBM Integration Designer

The business object you created is also displayed in a different tab.

Results

IBM Integration Designer generates the artifacts and an import. The outbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.

Configuring the module using the user-defined data type

To configure a module for outbound processing using the user-defined data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

About this task

You can create a custom data type and specify the required mail content and
attachment business object information for the data type. To do this configuration,
you need to create an inbound module with the user-defined data type using the
EmailFixedStructureDataBinding data binding.
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Related concepts

[‘Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Resource adapter properties” on page 184

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Interaction specification properties” on page 188

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

Setting deployment and runtime properties for user-defined data type:

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

Before you begin

To perform this task, you must have created a module. The module name is
displayed in the Project Explorer view of the IBM Integration Designer.

About this task
To set connection properties, follow this procedure. For more information about

any of the properties in this topic, see the [‘Managed connection factory properties’]
topic.

Procedure

1. In the Select the Processing Direction window, select Outbound and click Next.
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&~ New External Service

Select the Processing Direction 9—
Select the direction of adapter processing at run time., ;
) Inbound

Inbound processing passes data from the adapter to your service export.

=

{*) Outbound

Qutbound processing passes data from your service impart to the adapter,

>

@ <Bak_text> ]

Figure 36. Selecting inbound or outbound in the external service wizard

The Specify the Security and Configuration Properties window is displayed.

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

3. Under the E-mail system connection information, type the Host name. The
properties on this window correspond to the managed connection factor
properties. For detailed information about these properties, see

[connection factory properties” on page 175
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#= New External Service

Specify the Security and Configuration Properties —
s
Deploy connector project: with module for use by single application v | 3
Connection properties
E-mail system connection information
Host name: | localhost |
Port number: | 25 |
Protocol: smtp
Select when antivirus or firewall software is running
Service properties
How do you want to specify the security credentials?
(") Using an existing JAAS slias (recommended)
{#) Using security properties from the managed connection factory
The properties will be stored as plain text; no encryption is used.
User name: | username |
Password: | ”””””””” |
() Other ]
Data format options: Spedfy a data format for each operation w
b/
<
@) ’ < Back ” Mext = l

Figure 37. Security and configuration properties window

4

5.

. Type the Port number. The default value for the SMTP protocol is 25. If your
SMTP mail server is listening on a different port number, change this value.

Clear the Select when antivirus or firewall software is running check box if
you do not want the adapter to close the managed connection after each
outbound request. If an antivirus program or firewall is running on your
system (the machine on which the adapter is deployed or the one that hosts the
mail server) and this check box is cleared, the adapter might fail to send
outbound e-mails. Leaving this check box selected is recommended.

Optional: Click Advanced and expand the Additional properties, Logging and
tracing , or Bidi properties sections as needed.
* Additional configuration
a. Select Enable transport security (SSL) check box to specify if secure
socket layers are enabled for outbound communication. For more
information, see I"Secure connection (SSL) (enableSSL)” on page 181.|

b. In the Alternate e-mail ID in case of delivery failure field, specify an
alternate e-mail address to receive undeliverable mail notifications. This
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e-mail address can be a different e-mail address than the one you
specified in the From e-mail address. For more details about this property,
see|“Alternate e-mail ID in case of delivery failure” on page 179.

c. In the Maximum retries in case of system connection failure field, type
the number of times the adapter retries the connection before reporting a
polling error. For more information, see |”Maximum retries on connection|
[failure (connectionRetryLimit)” on page 179

d. In the Connection retry interval (in milliseconds) field, specify the time
interval between the attempts to reconnect to the mail server if the
connection fails. For more information, see [‘Retry interval if connection|
lfails (in milliseconds) entities” on page 178,

* Logging and tracing
a. If you have multiple instances of the adapter, expand Logging and
tracing and enter a value in the Adapter ID field that is unique for this
instance. For more information about this property, see [Resource adapter]
[properties” on page 184/

b. If you want to mask certain information so that the information is not
displayed in the logs or traces, select Disguise user data as "XXX" in log
and trace files. For more information, see|“Disguise user data as "XXX" in|
llog and trace files (HideConfidentialTrace) ” on page 178)

* Bidi properties
a. Select the Bidi transformation check box to specify bidirectional format.

For more information about setting the Bidi properties, refer to the
[“Globalization” on page 214| section.

7. In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

* To use a J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the managed connection specification,
click Using security properties from the managed connection factory enter
the following information:

— In the User name field, type the user name for the mail server.

— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. Also, for outbound communication you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the e-mails.

* To administer the user name and password from another mechanism, click
Other.

8. Optional: Select the Change logging properties for wizard check box, if you
want to define the level of logging for this module.

9. For Data format, select Specify a data binding for each operation. Although
the default value is Use a data binding configuration for all operations, select
Specify a data binding for each operation, because the adapter has a different
data binding for each supported business object. These data bindings have
different properties, and need to be configured differently.
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Important: Do not click Next in this window until you have completed the
steps to create a data binding or browse for an existing one.

What to do next

Select the data type and operation name.
Related concepts

[“Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Resource adapter properties” on page 184

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Interaction specification properties” on page 18|

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

[‘Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

Selecting a data type and operation name:

Use the external service wizard to select a data type and name the operation
associated with this data type. For outbound communication, the external service
wizard gives you the choice of four different data types: simple e-mail, generic
e-mail, generic e-mail with business graph, and user-defined type. Each data type
corresponds to a business object structure. Use the user-defined data type if you
want to configure your own business object wrapper instead of using the generic
e-mail business object.

Before you begin

You must have specified the connection properties for the adapter to connect to the
mail server. You have chosen to specify a data binding for each operation.

About this task

To select the user-defined data type, name the operation associated with it, create a
wrapper business object, and specify child business objects, follow this procedure.
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Procedure

1. In the Add, Edit, or Remove Operations window, click Add to create an
operation.

2. In the Specify the I/O Properties window, select the User defined email
business object from The data type for the input operation list and click Next.
For more information about data types and the types of e-mails they create, see
the business object structures section in this documentation.

Note: You can select the Enable response on delivery check box to configure
the outbound response from the mail server.

3. In the Specify the I/O Properties window, type an Operation name.
4. Click New for the Input type.

& Add Operation

Specify the 1/ 0 Properties

Operation name: = | send |

Specify the Operation Input

Input type: = | | [Bro'.\'se... ] [Ne‘.\'... l

Data format: = Mot defined

Specify the Operation Output

| |
Data format: = Mot defined

@

Figure 38. Selecting the input type

5. In Specify the Location window, provide the module name and the name of the
folder where the wrapper business object (the input type) is to be generated.
Click Next.

6. In Specify the Properties window, provide the wrapper Business object name.
a. Select the Generate a business graph for the business object check box.
b. Specify the properties for the e-mail type. Click Add to add child business
objects to the table.

You can generate the wrapper business object and specify the child business
objects that are used inside the wrapper business object and specify which
parts of the e-mail you want to use (such as mailContent or attachmentl).
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% New Business Object From External Data

Specify the Properties Q\ :

-t
Business object name: = | WhiAddress\Wrapper |
Business object namespace: | ht'q:-:,f',-'";-.";-.";-.'.il:-m.com,-"xrnlns,f'prc-d,-'";-.'ebsphe|
[JGenerate a business graph for the business object
Properties for e-mail type:

E-mail part Business abject type Default attz| | Add...

@ ext I Finish H Cancel ]

Figure 39. Specify the properties for the new business object

In the Add/Edit Properties window, select either the mailContent or the
Attachmentl as the E-mail part. If you select the attachment] part of the e-mail,
then you can also specify the default attachment name that is used with this
business object.

Note: You can have a wrapper business object without having a mailContent
business object, for example, if you are not sending any content in the e-mail or
if the e-mail polled by the adapter does not have any content.

7. When you have finished adding child business objects to the table, click Finish.
For each business object you add, a row is created in the table. The following
figure shows the generated wrapper business object.
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Ci WhisddressWirapper 23 \

vBusiness object £ T & =

(") ‘whiaddressiwrapper & [C) Header

— =[] Whiaddress
& To string [
[€] From string = (2] Whiphone [€] Addressid integer
[Elcc string m' [e] Addriine1 string
[€lBcC string [8] Phonenumber string [] Addrins2 string
[€] Reply-To string [€] Phonetype  string [€] Customerdity skring
[€] subject string L >
[€] Enceding string .~
[e] Date shring
[€] HeaderList Header [ ]
[€] mailContent ‘Whiaddress
[€] attachment1 ‘whiphone

|€] attachmentiMame string

Figure 40. The generated wrapper business object

8. In the Specify the Properties window, click Finish.

Results

A data type is defined for the module and the operation associated with this data
type is named. A wrapper business object is created, and the child business objects
that are used inside the wrapper business object are specified.

What to do next

Generate the data binding configuration for the module.
Related concepts

[‘Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

[‘The external service wizard” on page 16|
The external service wizard provides a blueprint to create services from existing
elements like business objects.

Configuring the data binding:

Data bindings read the fields in a business object and fill the corresponding fields
in an e-mail. In the external service wizard, you add a data binding to your
module and configure it to correspond with your data type. This way, the adapter
knows how to populate the fields in an e-mail with information it receives in the
business object.
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Before you begin

You must have entered service configuration properties for the connection to the
mail server. You have defined the data type for the module and named the
operation associated with this data type. You have chosen to specify a data binding
for each operation.

About this task
To browse for or create a data binding for the module, follow this procedure.

Note: The user-defined data type can only be used in a data transformation (non
pass-through) mode. You cannot use the unstructured content business object.

Note: Data bindings can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data binding
windows described in this documentation.

Procedure

1. In the Specify the I/O Properties window, click Select next to the Data format
field.

2. In the Select a Data Format Transformation window, select the Use existing
data format transformation from the list option. From the list, select
EmailFixedStructuredDataBinding. To configure a custom data binding, select
the Select your custom data format transformation from the workspace
option. A custom data binding, once placed in the class path, shows when this
option is selected. Click Next.
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# Data Binding Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To uze your own custom data L
transformation, select the second radio button to add your custom transformation, —ml

() Use existing data format transformation from the list

& EmailFivedStructuredDataBinding

%- EmailSimpleDataBinding
@ EmailwrapperDataBinding

[15haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:
This Data Binding handles the transformations that are required for the Email adapter

@

Figure 41. Selecting the data binding

Note: When you configure the EmailFixedStructuredDataBinding, you create a
custom data type with the required mail content and the attachment business
objects.

3. In Specify the Data Transformation Properties window, click Next.

Note: This window is used for configuring the data handlers.

4. In Configure a New Data Transformation window, provide the data binding
configuration details.
a. In the Configure a New Data Transformation window, the Module defaults
to the module name you typed earlier in the wizard. If you do not want to
create a data binding for this module, select New to create a module.
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& Data Binding Configuration

Configure a New Data Transformation

Create a data transformation configuration. |

Module or library:

lMamespace: http: /{EmailModule femail Default
Folder: email
[Mame: DataBindingConfiguration

Description:

@] Finish ] [ Cancel

Figure 42. Naming the data binding configuration
b. If you want to select a new folder for the artifact, click Browse and select a

new folder location. If you do not browse for a new folder location, the
artifacts are created in the root directory for the module.

c. Type a Name for the data binding configuration and click Finish.
Results
A data binding is configured for use with the module.
What to do next
Configure business object properties and data handlers.
Configuring business object properties and data handlers:
When you intend to use a data type that contains business objects, you must
specify properties for those business objects. Completing this step does not add
child business objects to the Email parent object. Rather, it tells the adapter how to
process particular types of business objects. Data handlers perform the conversions
between a business object and a particular MIME format.

Before you begin

You must have created a data binding before specifying business object properties
and data handlers for the module. Also, you must have predefined business objects
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using IBM Integration Designer Business Object Editor. If you stop the wizard here
to create business objects, you must start the wizard steps from the beginning and
your work is not saved.

Note: Data handlers can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data handler
windows described in this documentation.

About this task
To specify business object properties and data handlers, follow this procedure.

Procedure

1. In Specify the Data Transformation Properties window, select a row and click
Edit.

Note: For the user-defined type, the following warning message is displayed if
you click Add in this window. The User cannot add new row to the table.
Adapter has parsed your Input type and filled the table. This warning
appears because the adapter has determined which business objects the data
binding must know about and pre-filled the table. To provide values for the
rest of the properties, select individual rows and click Edit.

Important: If you are repeating these steps to configure a child data binding
for the user-defined data type, you cannot select between data handler and
data binding when you click Edit. The binding type option (to select between
data binding and data handler) does not function correctly for the
EmailFixedStructuredDataBinding. To configure a child data binding for
EmailFixedStructuredDataBinding, click the Binding type field and select
DataBinding.

2. In the Add/Edit properties window, ensure that DataHandler is selected in the
Binding type field.

3. In the Business object type field, click Browse for existing business objects or
New to create a business object. Selecting business objects here does not
physically add child business objects. Adding business objects at this stage in
the wizard tells the adapter that you are going to use certain business object
types with your module. It enables the adapter to know what data binding to
apply to any child business objects it processes.

a. If you selected Browse for the Business object type field, select a data type
from the Data type selection window and click OK.

b. If you selected New for the Business object type field, complete the
following steps.
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& New Business Object

Create a Business Object

Business objects are containers for application data that represent business functions or elements, such as a
customer or an invoice,

Module o ibrary: | Outbound v|[ Bowse.. | [ new.. |
Namespace: | http://Outbound | [¥IDefault

Folder: \ | [ Browse... |

Name: | Customer |

Inherit from: [<ncnne> l[ Browse. .. ] [ New... ] [Clear]

Business objects, by default, are created as alobal complex types. However, some intearation scenarios might
require a global element. Mare...

[l create the business ohject as an element

® . Back [ MNext = ” Finish ][ Cancel J

Figure 43. Specifying business object properties for the module

c. Select the Module. If the correct module is not shown, Browse for it or click
New to create a module.

d. Optional: Type a Folder name or Browse for the folder on your local drive
where business object schema files (XSD files) generated by the external
service wizard are stored.

e. Type a Name for the business object.

f. If you do not want to populate the business object with fields from one or
more existing business objects, click Finish.

g. If you want to populate the business object with fields from one or more
existing business objects, click Next.
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4= New Business Object

Derived Business Object

Available business objects:

Populate the new business object with fields frorr%ﬂe or more existing business objects,

Fields to indude:

[l [C1Email

| [ClHeader

O Elmailattachment

L} [Zl UnstructuredContent
L 2] Whiaddress

4] C]Wbiphone

‘ £

w.ibm.comfxn

w.ibm.comfxn
Jibm,com/xn|
ww.ibm.comxn
. ibm, comfxn
http: ffwww.ibm. comfxn

|

Mame

Type

L Finish .][ Cancel

Figure 44. Deriving business object fields from an existing business object

h. Select the correct business object and click Finish. The Business object type
in the Add/Edit properties window is populated.

4. In the Add/Edit properties window, select a Mime type such as text/xml or
text/html for your business object. The mime type corresponds to the data
handler that is used by the adapter to perform data transformation from one
format to another. This step enables the adapter to decide which format it has
to convert the content to when it encounters the business object.

& Add/Edit

Add/ Edit properties
ﬂ Data handler configuration:

Binding type:

Business object type:

cannot be empty.

- B

| DataHandler w |

= | {htn::ﬂCusmeer}Addressl [Browse... l ’New... l

@

Mime type: * | vl
Encoding: | UTF-8 | [ Select... ]

Data handler configuration:= Mot defined

Cancel

Figure 45. Adding or editing business object data binding properties
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Note: The encoding specified for configuring the XML data handler for Mime
type (text/xml) must have the same value that is specified for Encoding in the
EmailFixedStructuredDataBinding properties.

5. In the Encoding field, click Select if you want to choose a different encoding
value.
6. In the Data handler configuration field, click Select. Complete the following
steps to create and configure a data handler.
a. From the Use existing data format transformation from the list option,
select the XML data handler. Click Next.
The Select your custom data format transformation from the workspace

& Data Handler Configuration |Z|@”z|

Select a Data Format Transformation

Select a data format transformation entry from the list. To use your own custom data L
transformation, select the second radio button to add your custom transformation, i

() Use existing data format transformation from the list

[ pelimited

[ Fived width

@ Handled by WTX

%. Handled by WTX Invoker
2 1s0n

= 0N

[]5haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

0n inbound, parses XML data into & business object. On outbound, serializes business object to XML data

\

Figure 46. Selecting the data handler configuration type

option is available for advanced users who want to use a custom data
handler. A custom data handler, once placed in the class path, shows when
this option is selected.

b. In the Specify the Data Transformation Properties window, select an
Encoding value. Click Next.

Note: This value indicates the type of character encoding the adapter uses
during data transformation. For more information about the encoding
property, see the [“Email business object properties” on page 155|topic.
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c. In the Configure a New Data Transformation window, select the module. If
the correct module is not displayed, click New to create a new one.

Optional: Type a Folder name to specify a folder for the artifacts.
Leave the default data handler Name or type a new one.

& Data Handler Configuration

Configure a New Data Transformation

Create a data transformation configuration. | LJ

Moduleorlibrary:lOuﬂ:nund VH Browse. .. ] [ Mew. .. ]
Namespace: [ttp: /Outbound | [F]Defauit

Folder: | || sromse... |

Mame: | DataHandlerConfiguration |

Description:

® ext Finish ] [ Cancel

Figure 47. Creating a data handler

f. Click Finish.
7. In the Add/Edit properties window, click Finish.

Results
Business object properties and their data handlers are created.
What to do next

Set interaction specification properties and generate artifacts for your module.
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Related concepts

[‘Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

[“The external service wizard” on page 16|
The external service wizard provides a blueprint to create services from existing
elements like business objects.

Setting interaction specification properties and generating the service:

Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level
business object.

Before you begin

To set interaction specification properties and generate artifacts for your module,
you must have already configured data bindings and selected business objects.

About this task

Interaction specification properties do not take precedence over request business
object attributes, except for the user name and password properties. User name
and password values specified in the interaction specification properties take more
precedence over values set in the managed connection factory properties. To set
interaction specification properties and generate artifacts, follow this procedure.
For more information about interaction specification properties, see the
specification properties” on page 188]topic.

Procedure
1. Optional: To set interaction specification properties complete these steps:
a. Click Advanced.
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4= New External Service

Add, Edit, or Remove Operations

The adapter will use theze operations to access native functions. )ﬁs

Operations:
- g8 send (fhttp: ffwww.ibm. comxmins fprodfwebsphere i 2ca femail fixedstructureemailUserCustom| | Add. ..

<_ i}

%

Operation Properties

InteractionSpec Properties for 'send’

|+ Additional properties

Fraom:

Reply to:

To:

Cez

E-mail subject:

User name:

Password:

|
|
|
|
Bee: |
|
|
|
|

Encoding: ’ Select... l

@ ’ < Back ][ Mext = Finish

Figure 48. Setting interaction specification properties

b. Type values for any fields you want to set as defaults.
c. Click Next.
2. In the Specify the Name and Location window, select the Module.
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#= New External Service

Specify the Name and Location

ol
Specify the name and location of the new service and its interface.
Properties for Service
Module: | Lser w |
Use the default namespace
Folder: | | [Bro'a'-.'se... ]

Mame: >=U| OutboundInterface |

[]save business objects to a library

Description: |

® axt > Finish H Cancel

Figure 49. Naming the artifact

3. Optional: Name the Folder to store the artifacts.

4. Type a Name for the interface. This name displays in the IBM Integration
Designer assembly diagram.

5. Optional: Type a Description.

6. Click Finish. The IBM Integration Designer assembly diagram opens and the
interface you created is displayed.

Email 99



100

9& Outbound - Assembly Diagram 23 (2] Customer
4 oFPalette
[:3 'I'E'\ 'EI" %, &)
(= Favorites @ @ QutboundInterface E
= Components
U’,Ji., Untyped Component
42 Human Task
Uﬂ Java
T, Mediation Flow
ﬁ" Process

Es Rule Group
S state Machine

(B Impart

%] Export
References

Figure 50. Interface in IBM Integration Designer

The business object you created is also displayed in a different tab.
Results
IBM Integration Designer generates the artifacts and an import. The outbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.

Configuring the module for inbound processing

To configure a module to use the adapter for inbound processing, use the external
service wizard in IBM Integration Designer to build business services, specify data
transformation processing, and generate business object definitions and related
artifacts.

Setting deployment and runtime properties for inbound
processing

Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

Before you begin

Before you can set the connection properties in this section, you must have created
your module in IBM Integration Designer. It is displayed in the Business
Integration pane below the adapter project. Also, you must have created a staging
directory on your local system for storing e-mails that have been polled by the
adapter but which are yet to be turned into business objects.
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About this task

To set connection properties, follow this procedure. For more information about

any of the properties in this topic, see the [“Activation specification properties” on|
topic.

Procedure

1. In the Select the Processing Direction window, select Inbound and click Next.
The Specify the Security and Configuration Properties window opens.

& New External Service |._|@|g|

Select the Processing Direction 9—
Select the direction of adapter processing at run time. ;
() Inbound

Inbound processing passes data from the adapter to your service export.

=

(") Outbound

Cutbound processing passes data from vour service impart to the adapter.

>

@j ’ < Back ” Mext = l

Figure 51. Choosing inbound or outbound in the external service wizard

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.
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d= New External Service

Specify the Security and Configuration Properties —
s
Deploy connector project: with module for use by single application v | 1
Connection properties
Staging directory: = | C:\5taging | [Browse... l
E-mail system connection information
Host name: | loczlhost |
Port number: | 110 |
Protocol: | pop3 w |
Service properties
How do you want to specify the security credentials?
) Using an existing JAAS alias (recommended)
() Using security properties from the activation specification
The properties will be stored as plain text; no encryption is used.
Uzer name: | Ugername |
Password: | R |
) other
b,
<
@) ’ < Back ][ Mext = l ’ Finish ] [ Cancel

Figure 52. Specifying inbound connection properties

3. Browse for the Staging Directory you created on your local system. If you have
not already created a staging directory, create one and then restart the external
service wizard.

4. Define the Connection properties for your module. For more details about
these properties, see [“Activation specification properties” on page 196

a. Under the E-mail system connection information, type the Host name.
b. Type the Port number.

c. Optional: Select the e-mail Protocol. For more information about the POP3
and IMAP e-mail protocols, see [“Supported inbound protocols” on page 9)

5. Click Advanced and specify values as needed. These include activation
specification properties designed to alter the default behavior of the adapter
during inbound communication. For more information about any of the
Advanced properties for event polling, event delivery, event persistence,

archiving, or setting search criteria see [“Activation specification properties” on|
‘ae 196,
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Event delivery configuration

Event polling configuration

Event persistence configuration

Additional properties

Bidi properties

Logging and tracing

Figure 53. Advanced properties

Event delivery configuration

a.

In the Type of delivery field, select the delivery method. The methods
are described in [“Delivery type (DeliveryType)” on page 200.|

If you want to ensure that events are delivered only once and to only one
export, select the Ensure assured-once event delivery check box. This
option might reduce performance but does not result in duplicate or
missing event delivery. For more information, see [“Ensure once-only|
levent delivery (AssuredOnceDelivery)” on page 201

In the Retry limit for failed events field, specify the number of times to
try to deliver an event after a delivery failure. For more information, see
[“Retry limit for failed events (FailedEventRetryLimit)” on page 203

Event polling configuration

In the Interval between polling periods (milliseconds) field, type the
time in milliseconds, that the adapter waits between polling periods. For
more information about the property, see [“Interval between polling|
[periods (PollPeriod)” on page 204)

In the Maximum events in polling period field, type the number of
events to deliver in each polling period. For more information about the
property, see [“Maximum events in polling period (PollQuantity)” on pagd
i

To specify the time interval between attempts to connect to the mail server
if a connection fails, set Time between retries in case of system
connection failure (in milliseconds) to a value in milliseconds. For more
%rmation, see [“Retry interval if connection fails (RetrylInterval)” on page|
210.

To specify the number of connection exceptions during the inbound
operation, set Maximum number of retries in case of system connection
failure to a value greater than or equal to 0. For more information, see
‘Number of times to retry the system connection (RetryLimit)” on page]
R07)

If you want the adapter to stop if polling errors occur, select the Stop the
adapter when an error is encountered while polling check box. If you do
not select this option, the adapter logs an exception but continues to run.
For more information, see [“Stop the adapter when an error is encountered|
fwhile polling (StopPollingOnError)” on page 210
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— Select the Retry EIS connection on startup check box, if you want the
adapter to retry a failed connection when starting. For more information,
see [‘Retry EIS connection on startup (RetryConnectionOnStartup)” on|

lpage 209

— Select the calendar based scheduling option to create calendar based
polling for inbound activities. You can schedule your business activities,
when you create a new calendar in IBM Integration Designer. The option
of working with the calendar based scheduling feature is only possible
with IBM Integration Designer as the tooling environment. The following
figure helps you to schedule a calendar polling option.

Ewent polling configuration

Interval between polling periods (miliseconds): I 2000
Maxinium events in paling period: I 10

Time between retries in case of system connection Failuredin miliseconds): I 60000

Maximum number of retries in case of svstem connection Failure; I 0

™ 5top the adapter when an errar is encountered while polling

I Retry EIS connection an startup

Palling based on calendar: I Browse. ., | Mew. ..
Time interval For paling unchanged files (in miliseconds): I 0

Figure 54. Polling based on calendar

You can either select a blank calendar or create a new calendar for a
module or library. When you select a blank calendar, you will not be able
to set pre-defined time intervals. You have to define your time intervals.
When you create a calendar using a pre-defined template, you can define
time intervals for each template.

a. Click New to create a new calendar entry for a module or library.
You can choose an existing calendar, or create a new calendar instance.

- Click Browse to select an existing calendar module. Or click New to
create a module for the new calendar.

- Click Browse to choose a folder for the calendar. (Optional).
- Enter a name for the new calendar.

- Click Next if you want to generate the calendar, through a
predefined template. Or, click Finish, to create a non template
calendar.

b. Click Browse to select an existing calendar for a module or library. In
the Select a Business Calendar screen you can search for all currently
existing calendar files (*cal) in the IBM Integration Designer
workspace.

- In the Name field, type the calendar name or click the calendar in
the Matching business calendars screen. Click OK to open the
external service wizard.

- In the WebSphere Integration workspace, select the Calendar
module, and browse Integration logic->Calendars, to view or
modify the calendar schedules. You can modify the intervals and
exceptions, or add new entries for these elements. For more
information, refer to the information at |http:/ / |
publib.boulder.ibm.com /infocenter/dmndhelp /v7r5mx /|
index.jsp?topic=/com.ibm.wbpm.wid.bpel.doc/topics /cbuscal.html]|
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Note: You must deploy the Business Calendar module to the same
IBM Business Process Manager or WebSphere Enterprise Service Bus
instance, along with the inbound application. If you do not map
these two connections to the same server instance, the inbound
application using the business calendar will by default, poll as there
is no calendar configured.

* Event persistence configuration

a.

Select Auto create event table check box if you want the adapter to
create the Event Persistence table. For more information, see
“ Automatically create event table property (EP_CreateTable)” on pagel

£

In the Event recovery table name field, specify the name of the table that
the adapter uses for event persistence. For more information, see f’Evenﬂ
[recovery table name property (EP_TableName)” on page 202)

In the Event recovery data source (JNDI) name field, specify the JNDI
name of the data source that event persistence uses to connect to the
JDBC database. For more information, see [“Event recovery data source]
[INDI) name property (EP_DataSource JNDIName)” on page 202

In the User name used to connect to event data source field, specify the
user name that the event persistence uses to connect to the database from
the data source. For more information, see [“User name used to connect td
levent data source property (EP_UserName)” on page 211

In the Password used to connect to event data source field, specify the
password that the event persistence uses to connect to the database from
the data source. For more information, see [“Password used to connect to|
levent data source property (EP_Password)” on page 207

In the Database schema name field, specify the schema name of the
database that the event persistence uses. For more information, see
[“Database schema name (EP_SchemaName)” on page 200.|

* Additional configuration

a.

Select the Enable transport security (SSL) check box if you want to
enable Secure Sockets Layer (SSL). For more information, see |”Enabla
[transport security (SecureConnectionProperty)” on page 201

Select the Emit individual business objects from a multipart e-mail
check box, to specify if the adapter creates individual business objects for
each part of a multipart e-mail. For more information, see ["“Emif]
individual business objects from a multipart e-mail (EmitIndividualBOs)”]|

on page 201.|

In the Match all search criteria field, specify the search criteria to filter
which events are polled from the mail server. The events that meet the
ANDed conditions are polled. For more information, see
[search criteria (MatchAllCriteria)” on page 204

In the Match some search criteria field, specify the search criteria to filter
which events are polled from the mail server. The events that meet the
ORed conditions are polled. For more information, see |”Match somel
lsearch criteria (MatchSomeCriteria)” on page 205/

In the Archive file naming pattern field, you can specify a
comma-delimited pattern of header names which are used to name
archived files being stored in the archive folder. For more information,
see[“Archive file naming pattern (ArchiveFile)” on page 198/

* Bidi properties
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a. Select the Bidi transformation check box to specify bidirectional format.
For more information about setting the Bidi properties, refer to the
[“Globalization” on page 214| section.

* Logging and tracing
a. If you have multiple instances of the adapter, enter a value in the

Adapter ID that is unique for this instance. For more information, see
[“Adapter ID (AdapterID)” on page 185

b. You can select the Disguise user data as 'XXX' in log and trace files
check box to prevent sensitive user data from being written to log and
trace files.

6. In Service properties, specify how you want the adapter to connect to the mail

server by selecting any one of these authentication methods.

* To use a ]2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the activation specification, click Using
security properties from the activation specification enter the following
information:

— In the User name field, type the user name for the mail server.
— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. Also, for outbound communication you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the e-mails.

* To administer the user name and password from another mechanism, click
Other.

To use an existing function selector configuration, use the default value
(EmailFunctionSelector). To configure a custom function selector, click Select.
Clicking Select allows you to select a pre-configured function selector. You
would only configure a function selector if you want to implement a custom
function selector. This configuration is an advanced concept. By default, the
e-mail function selector is used, which does not require any configuration.

Optional: Select the Change logging properties for wizard check box if you
want to define the level of logging for this module.

What to do next

Browse for or create a data binding for the module.
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Related concepts

[“Inbound processing” on page 7|

WebSphere Adapter for Email supports inbound processing of e-mail events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new e-mails that are ready for processing. When the adapter detects
an event that is ready to be processed, it converts the event data into a business
object and sends it to the consuming service.

[“User authentication” on page 22|

The adapter supports several methods for supplying the user name and password
that are needed to connect to the mail server. By understanding the features and
limitations of each method, you can pick a method that provides the appropriate
level of security and convenience for your application.

Related reference

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

[“Resource adapter properties” on page 184

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

[“Connection properties for the external service wizard” on page 171

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

[“Inbound configuration properties” on page 193

WebSphere Adapter for Email has several categories of inbound connection
configuration properties, which you set with the external service wizard while
generating or creating objects and services. You can change the resource adapter
and activation specification properties after you deploy the module using IBM
Integration Designer or the administrative console, but connection properties for
the external service wizard cannot be changed after deployment.

[“Globalization” on page 214

WebSphere Adapter for Email is a globalized application that can be used in
multiple linguistic and cultural environments. Based on character set support and
the locale of the host server, the adapter delivers message text in the appropriate
language. The adapter supports bidirectional script data transformation between
integration components.

Selecting a data type and operation name

Use the external service wizard to select a data type and name the operation
associated with this data type. For inbound communication, the external service
wizard gives you the choice of three different data types: generic e-mail, generic
e-mail with business graph, and user-defined type. Each data type corresponds to
a business object structure.

Before you begin
You must have specified the connection properties for the adapter to connect to the

mail server, data bindings, and data handlers before you can specify the operation
and data type for the module.
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About this task

To select a data type and name the operation associated with it, follow this
procedure.

Procedure
1. In the Add, Edit, or Remove Operations window, click Add.
2. In the Specify the I/O Properties window, type an Operation name.

4 Add Operation |Z'E]

Specify the 1/ 0 Properties
@

Operation name: = | emitEmail |

Specify the Operation Input

Data format: = DataBindingConfiguration

':':’:' Finish ] [ Cancel

Figure 55. Naming the operation

Name the operation something meaningful. If this module is going to be used
to convert a simple e-mail business object, name it something like SendEmail.
Or, if it is going to be used to create a parent Email business object with a
customer child business object, name it something like SendCustomerEmail. For
more information about the types of operations the adapter can perform, see
the topic on Supported Operations in this documentation.

Note: Names cannot contain spaces.

3. The external service wizard defaults to the correct data binding for the data
type you selected in the Operation window. If you want to use a different data
binding, click Browse for a data binding or create a new one using the
instructions in the sections "Configuring the data binding" and "Configuring
business object properties and data handlers."

4. In the Specify the I/O Properties window, click Finish.
5. In the Add, Edit, or Remove Operations window, click Next.

Results

A data type is defined for the module and the operation associated with this data
type is named.
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What to do next

Generate artifacts for the module.

Related concepts

|”Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

[“The external service wizard” on page 16|
The external service wizard provides a blueprint to create services from existing
elements like business objects.

Configuring the data binding

Data bindings read the fields in a business object and fill the corresponding fields
in an e-mail. In the external service wizard, you add a data binding to your
module and configure it to correspond with your data type. This way, the adapter
knows how to populate the fields in an e-mail with information it receives in the
business object.

Before you begin

You must have entered service configuration properties for the connection to the
mail server.

About this task
To add and configure a data binding for the module, follow this procedure.

Note: You can configure data bindings before running the external service wizard
by using IBM Integration Designer. To do this configuration, select New >
Configure Binding Resource in IBM Integration Designer and complete the data
binding windows described in this documentation.

Procedure

1. In the Specify the Security and Configuration Properties window, select a value
for the Data format options from the list. You can choose to use the data
binding configuration for all operations or you can choose to specify a data
binding for each operation. If you use the data binding configuration for all
operations, then the data binding configured here is used as the default data
binding configuration for all the operations. If you choose to specify a data
binding for each operation, then you must configure a data binding for each
operation. In these steps, the Use a data format configuration for all
operations option is selected.

Important: If associate your inbound module with a particular user-defined
business object type, the steps for defining your data binding in this section
dictates which events the adapter processes at run time. At run time, inbound
events that are symmetric to the custom data type are processed by the adapter.
Those events that are not symmetric to the custom data type are not processed.
For these events, the adapter throws an exception and logs an error message.

2. In the Data format field, click Select.

3. In the Select a Data Format Transformation window, select the Use existing
data format transformation from the list option to use one of the data
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bindings included with IBM Integration Designer. Click Next. The Select your
custom data format transformation from the workspace option is available for
advanced users who want to use a custom data binding. A custom data
binding, once placed in the class path, shows when this option is selected.

# Data Binding Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To uze your own custom data L
transformation, select the second radio button to add your custom transformation, —ml

() Use existing data format transformation from the list

& EmailFivedStructuredDataBinding

%- EmailSimpleDataBinding

@ EmailwrapperDataBinding

[15haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

This Data Binding handles the transformations that are required for the Email adapter

®

Figure 56. Selecting a data binding

The following data types are matched with the following data bindings.
Table 6. Data types and their data binding equivalents

Data type Data binding

Generic e-mail Email Wrapper Data Binding
Generic e-mail with business graph Email Wrapper Data Binding
User-defined Email business object EmailFixedStructureDataBinding

4. In Specify the Data Transformation Properties window, click Next.

Note: This window is used for configuring the data handlers.

5. In Configure a New Data Transformation window, provide the data binding
configuration details.
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a. In the New Data Binding Configuration window, the Module defaults to
the module name you typed earlier in the wizard. To create a data binding
for a different module, select New to create a module.

4 Data Binding Configuration |Z|E“z|

Configure a New Data Transformation

Create a data transformation configuration. ILJ
Module or library: |In|:u:und b | ’_ Browse. .. ] [ New... l
Mamespace: |I1t‘tp:_-"_-"Inb0und | Default

Folder: | | [ Browse.., ]

Mame: | DataBindingConfiguration |

Description:

® ext = [ Finish ][ Cancel

Figure 57. Naming the data binding configuration

b. If you want to select a new folder for the artifact, click Browse and select a
new folder location. If you do not browse for a new folder location, the
artifacts are created in the root directory for the module.

c. Type a Name for the data binding configuration and click Finish.

The data binding class name populates in the Specify the Security and
Configuration Properties window.

Results
A data binding is configured for use with the module.
What to do next

Specify data binding properties.
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Configuring business object properties and data handlers

When you select a data type that contains business objects, you must specify
properties for those business objects. However, this step does not add child
business object to the Email parent object. Rather, they tell the adapter how to
process particular types of business objects. Data handlers perform the conversions
between a business object and a particular MIME format.

Before you begin

You must have created a data binding before specifying business object properties
and data handlers for the module. Also, you must have predefined business objects
using IBM Integration Designer Business Object Editor. If you stop the wizard here
to create business objects, you must start the wizard steps from the beginning.

Note: Data handlers can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data handler
windows described in this documentation.

About this task

You must define business object properties and data handlers if you have selected
the generic Email, Email with business graph, or user-defined type as the data
type. The simple alert Email data type does not have properties that need to be
configured. To specify business object properties and data handlers, follow this
procedure.

Procedure

1. If you chose the Email with business object or Email with business graph data
types, click Add to add the business object types to the data binding
description in the Add/Edit properties window.

Note: For the user-defined type, the following warning message is displayed if
you click Add in this window. The User cannot add new row to the table.
Adapter has parsed your Input type and filled the table. This warning
appears because the adapter has determined which business objects the data
binding must know about and pre-filled the table. To provide values for the
rest of the properties, select individual rows and click Edit.

Important: If you are repeating these steps to configure a child data binding
for the user-defined data type, note that you cannot select between data
handler and data binding when you click Edit. The binding type option (to
select between data binding and data handler) does not function correctly for
the EmailFixedStructuredDataBinding data binding. To configure a child data
binding for EmailFixedStructuredDataBinding, click the Binding type field and
select DataBinding.

2. In the Add/Edit properties window, ensure that DataHandler is selected in the
Binding type field.

3. In the Business object type field, click Browse for existing business objects or
New to create a business object. Selecting business objects here does not
physically add child business objects. Adding business objects at this stage in
the wizard tells the adapter that you are going to use certain business object
types with your module. It enables the adapter to know what data binding to
apply to any child business objects it processes.
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a. If you selected Browse for the Business object type field, select a data type
from the Data Type Selection window and click OK.

b. If you selected New for the Business object type field, complete the
following steps.

# New Business Object

Create a Business Object
Business objects are containers for application data that represent business functions or elements, such as a

customer or an invoice,

Moduie or lbrary: | Inbound v|[ Browse.. | [ mew.. |
Namespace: | http:/finbound | MIpefauit

Folder: \ [ Browse... |

Mame: | Custamer |

Inherit from: l<none> I[ Browse... ] [ Mew. .. ] [Clear]

Business abjects, by default, are created as alobal complex types. However, some intearation scenarios might
require a global element. More...

[]create the business object as an element

@I < Back [ Mext = ] l Finish ] [ Cancel

Figure 58. Specifying business object properties for the module

c. Select the Module. If the correct module is not shown, Browse for it or click
New to create a module.

d. Optional: Type a Folder name or Browse for the folder on your local drive
where business object schema files (XSD files) generated by the external
service wizard are stored.

e. Type a Name for the business object.

f. If you do not want to populate the business object with fields from one or
more existing business objects, click Finish.

g. If you want to populate the business object with fields from one or more
existing business objects, click Next.
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4= New Business Object

Derived Business Object

Populate the new business object with fields frorr%ﬂe or more existing business objects,
Available business objects: Fields to include:

[ Elemail o ibm.comfxn| | Name Type

| [ClHeader

O Elmailattachment
L} [Zl UnstructuredContent ww.ibm.comxn
[ £ vibiaddress b, com fxn
4] [ Whiphone http: ffwww.ibm. comfxn

w.ibm.comfxn
Jibm,com/xn|

S
|

@ ext L Finish .][ Cancel

Figure 59. Deriving business object fields from an existing business object

h. Select the correct business object and click Finish. The Business object type
in the Add/Edit properties window is populated.

4. In the Add/Edit properties window, select a Mime type such as text/xml or
text/html for your business object. The mime type corresponds to the data
handler that is used by the adapter to perform data transformation from one
format to another. This step enables the adapter to decide which format it has
to convert the content to when it encounters the business object.

# Add/Edit M=

Add/ Edit properties
ﬂ Data handler configuration: cannot be empty.

Binding type: | Datatandler v|

Busnessobject type: = | Whiaddress {nttp://Gener| [Browse. .. | [rew... |
Mime type: = | |

Encoding: [uTFa | select... |

Data handler configuration: = Mot defined

@

Figure 60. Adding or editing business object data binding properties
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5. In the Encoding field, click Select if you want to choose a different encoding
value.

6. In the Data handler configuration field, click Select. Complete the following
steps to create and configure a data handler.

a. From the Use existing data format transformation from the list option,
select the XML data handler. Click Next.

& Data Handler Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To use your own custom data L
transformation, select the second radio button to add your custom transformation, i

() Use existing data format transformation from the list

[ pelimited

[ Fived width

@ Handled by WTX

%. Handled by WTX Invoker
2 1s0n

= 0N

[]5haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

0n inbound, parses XML data into & business object. On outbound, serializes business object to XML data

\

Figure 61. Creating a data handler

b. In the Specify the Data Transformation Properties window, select an
Encoding value. Click Next.

c. In the Configure a New Data Transformation window, select the module. If
the correct module is not displayed, click New to create a new one.

Optional: Type a Folder name to specify a folder for the artifacts.
Leave the default data handler Name or type a new one.
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& Data Handler Configuration |Z|@“z|

Configure a New Data Transformation

Create a data transformation configuration. L
»

Module or library:

MNamespace: |I1ttp:_."_."[nb0L|nd | Default
Folder: | | ’ Browse...
Mame: | DataHandlerConfiguration |

Description:

@) Finish ] [ Cancel

Figure 62. Creating a data handler

f. Click Finish.
7. In the Add/Edit properties window, click Finish.

Results
Business object properties and their data handlers are created.
What to do next

Specify interaction specification properties and generate artifacts for the module.
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Related concepts

[‘Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

[“The external service wizard” on page 16|
The external service wizard provides a blueprint to create services from existing
elements like business objects.

Setting deployment properties and generating the service
The export file is generated when the adapter creates artifacts for the module and
contains the operation for the top-level business object.

Before you begin

To generate artifacts for your module you must have already configured data
bindings and selected business objects.

About this task
To generate artifacts for your module, follow this procedure.

Procedure
1. In the Specify the Name and Location window, select the Module.
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#= New External Service

Specify the Name and Location i
Specify the name and location of the new service and its interface, U:lj

Properties for Service

Module: | Inbound w |

Use the default namespace

Folder: | | [Browse. = ]

Mame: >=U| InboundInterface |

Description: | |

@j Finish ] [ Cancel

Figure 63. Naming the artifact

2. Optional: Name the Folder to store the artifacts.

3. Type a Name for the interface. This name displays in the IBM Integration
Designer assembly diagram.

4. Optional: Type a Description.

5. Click Finish. The IBM Integration Designer assembly diagram opens and the
interface you created is displayed.
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9& Inbound - Assembly Diagram &3
{53 Palette
NECEN
[-=-Favorites @ 7 InboundInterface
(= Components
% Untyped Component
aj Human Task
E,ﬂ Java
"B, Mediation Flow
S?_ Process

Fis Rule Graup
S state Machine

| Import
&g Expart
References

Figure 64. Interface in IBM Integration Designer

The business object you created is also displayed in a different tab.

Results

The IBM Integration Designer generates the artifacts and an export. The inbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.

Related reference

[“Interaction specification properties” on page 18§

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

Changing interaction specification properties using the assembly
editor

To change interaction specification properties for your adapter module after
generating the service, use the assembly editor in IBM Integration Designer.

Before you begin

You must have used the external service wizard to generate a service for the
adapter.

About this task

You might want to change interaction specification properties after you have
generated a service for the adapter. Interaction specification properties, which are
optional, are set at the method level, for a specific operation on a specific business
object. The values you specify appear as defaults in all parent business objects
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generated by the external service wizard. You can change these properties before
you export the EAR file. You cannot change these properties after you deploy the
application.

To change the interaction specification properties, use the following procedure:

Procedure

1. From the Business Integration perspective of IBM Integration Designer, expand
the module name.

2. Expand Assembly Diagram and double-click the interface.

3. Click the interface in the assembly editor. (It shows the module properties if
you do not do the extra click.)

4. Click the Properties tab. (You can also right-click the interface in the diagram
and click Show in Properties.)

5. Under Binding, click Method bindings. The methods for the interface are
displayed, one for each combination of business object and operation.

6. Select the method whose interaction specification property you want to change.

7. Click Advanced and change the property in the Generic tab. Repeat this step
for each method whose interaction specification property you want to change.

Results

The interaction specification properties associated with your adapter module are
changed.

What to do next

Deploy the module.
Related reference

[“Interaction specification properties” on page 18|

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

Deploying the module

Deploy a module to place the files that make up your module and adapter into an
operational environment for production or testing. In IBM Integration Designer, the
integrated test environment features runtime support for IBM Business Process
Manager or WebSphere Enterprise Service Bus, or both, depending on the test
environment profiles that you selected during installation.

Deployment environments

There are test and production environments into which you can deploy modules
and adapters.

In IBM Integration Designer, you can deploy your modules to one or more servers
in the test environment. This is typically the most common practice for running
and testing business integration modules. However, you can also export modules
for server deployment on IBM Business Process Manager or WebSphere Enterprise
Service Bus as EAR files using the administrative console or command-line tools.
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Deploying the module for testing

In IBM Integration Designer, you can deploy a module that includes an embedded
adapter to the test environment and work with server tools that enable you to
perform such tasks as editing server configurations, starting, and stopping servers
and testing the module code for errors. The testing is generally performed on the
interface operations of your components, which enables you to determine whether
the components are correctly implemented and the references are correctly wired.

Generating and wiring a target component for testing inbound
processing

Before deploying to the test environment a module that includes an adapter for
inbound processing, you must first generate and wire a target component. This
target component serves as the destination to which the adapter sends events.

Before you begin

You must have generated an export module, using the external service wizard.
About this task

Generating and wiring a target component for inbound processing is required in a
testing environment only. It is not necessary when deploying the adapter in a
production environment.

The target component receives events. You wire the export to the target component
(connecting the two components) using the assembly editor in IBM Integration
Designer. The adapter uses the wire to pass event data (from the export to the
target component).

Procedure
1. Create the target component

a. From the Business Integration perspective of IBM Integration Designer,
expand Assembly Diagram and double-click the export component. If you
did not change the default value, the name of the export component is the
name of your adapter + InboundInterface.

An interface specifies the operations that can be called and the data that is
passed, such as input arguments, returned values, and exceptions. The
InboundInterface contains the operations required by the adapter to
support inbound processing and is created when you run the external
service wizard.

b. Create a new component by expanding Components, selecting Untyped
Component, and dragging the component to the Assembly Diagram.

The cursor changes to the placement icon.
c. Click the component to have it displayed in the Assembly Diagram.
2. Wire the components.
a. Click and drag the export component to the new component.
b. Save the assembly diagram. Click File > Save.
3. Generate an implementation for the new component.

a. Right-click on the new component and select Generate Implementation >
Java.

b. Select (default package) and click OK. This creates an endpoint for the
inbound module.
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The Java implementation is displayed in a separate tab.

c. Optional: Add print statements to print the data object received at the
endpoint for each of the endpoint methods.

d. Click File > Save to save the changes.
What to do next

Continue deploying the module for testing.

Adding the module to the server
In IBM Integration Designer, you can add modules to one or more servers in the
test environment.

Before you begin

If the module you are testing uses an adapter to perform inbound processing,
generate and wire a farget component to which the adapter sends the events.

About this task

In order to test your module and its use of the adapter, you need to add the
module to the server.

Procedure

1. Conditional: If there are no servers in the Servers view, add and define a new
server by performing the following steps:

a. Place your cursor in the Servers view, right-click and select New > Server.
b. From the Define a New Server window, select the server type.
c. Configure servers settings.
d. Click Finish to publish the server.
2. Add the module to the server.

a. Switch to the servers view. In IBM Integration Designer, select Windows >
Show View > Servers.

a. Start the server. In the Servers tab in the lower-right pane of the IBM
Integration Designer screen, right-click on the server, and then select Start.

3. When the server status is Started, right-click on the server, and select Add and
Remove Projects.

4. In the Add and Remove Projects screen, select your project and click Add. The
project moves from the Available projects list to the Configured projects list.

5. Click Finish. This deploys the module on the server.

The Console tab in the lower-right pane displays a log while the module is
being added to the server.

What to do next

Test the functionality of your module and the adapter.

Testing the module for outbound processing using the test client
Test the assembled module and adapter for outbound processing using the IBM
Integration Designer integration test client.
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Before you begin

You need to add the module to the server first.

About this task

Testing a module is performed on the interface operations of your components,

which enables you to determine whether the components are correctly
implemented and the references are correctly wired.

Procedure
1. Select the module you want to test, right-click on it, and select Test > Test
Module.

2. For information about testing a module using the test client, see the Testing
modules and components topic in the IBM Integration Designer information
center.

What to do next

If you are satisfied with the results of testing your module and adapter, you can
deploy the module and adapter to the production environment.

Deploying the module for production

Deploying a module created with the external service wizard to IBM Business
Process Manager or WebSphere Enterprise Service Bus in a production
environment is a two-step process. First, you export the module in IBM Integration
Designer as an enterprise archive (EAR) file. Second, you deploy the EAR file
using the IBM Business Process Manager or WebSphere Enterprise Service Bus
administrative console.

Installing the RAR file (for modules using stand-alone adapters
only)

If you chose not to embed the adapter with your module, but instead choose to
make the adapter available to all deployed applications in the server instance, you
need to install the adapter in the form of a RAR file to the application server. A
RAR file is a Java archive (JAR) file that is used to package a resource adapter for
the Java 2 Connector (J2C) architecture.

Before you begin

You must set Deploy connector project to On server for use by multiple adapters
in the Specify the Service Generation and Deployment Properties window of the
external service wizard.

About this task

Installing the adapter in the form of a RAR file results in the adapter being
available to all J2EE application components running in the server runtime.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.
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3. Log on to the administrative console.
4. Click Resources > Resource Adapters > Resource adapters.
5. In the Resource adapters page, click Install RAR.

. Admin Console X

Integrated Solutions Console Welcome Help Logout .-I-

| View: | All tasks : FESOURCE. S0 JpLErs

welcome Resource adapters rE

Guided Activities Resatreelsaprers

Servers Use this page to manage resource adapters, which provide
— the fundamental interface for connecting applications to an
E Applications Enterprise Information System (EIS). The WebSphere(R)

Relational Resource Adapter is embedded within the
product to provide access to relational databases. To
zccess another type of EIS, use this page to install 2
standalane resource adapter archive (RAR) file. You can
configure multiple resource adapters for each installed RAR

B Resources

Schedulers

Object pool managers

B 1ms file.
People directory providi E Scope: =All scopes
Extended messaging pr
webSphere Business In Scope specifies the level at which the resource
Adapters definition is visible. For detailed infermation on
what scope is and how it works, see the scope
E 1pBC

settings help

El Resource Adapters
Resource adapters All scopes b

J2C connection facts
o | Preferences
J2C activation speci

J2C administered ob Install RAR | Mew| | Delsts

[ Asynchronous beans el
[H Cache instances 3 =

Figure 65. The Install RAR button on the Resource adapters page

6. In the Install RAR file page, click Browse and navigate to the RAR file for
your adapter.

The RAR files are typically installed in the following path:
IID installation_directory/ResourceAdapters/adapter_name/adapter.rar

7. Click Next.

8. Optional: In the Resource adapters page, change the name of the adapter and
add a description.

9. Click OK.
10. Click Save in the Messages box at the top of the page.

What to do next

The next step is to export the module as an EAR file that you can deploy on the
server.

Exporting the module as an EAR file

Using IBM Integration Designer, export your module as an EAR file. By creating
an EAR file, you capture all of the contents of your module in a format that can be
easily deployed to IBM Business Process Manager or WebSphere Enterprise Service
Bus.

Before you begin

Before you can export a module as an EAR file, you must have created a module
to communicate with your service. The module should be displayed in the IBM
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Integration Designer Business Integration perspective.
About this task

To export the module as an EAR file, perform the following procedure.

Procedure

1. Right-click the module and select Export.
2. In the Select window, expand Java EE.

3. Select EAR file and click Next.
4

. Optional: Select the correct EAR application. The EAR application is named
after your module, but with “App” added to the end of the name.

o

Browse for the folder on the local file system where the EAR file will be placed.

6. To export the source files, select the Export source files check box. This option
is provided in case you want to export the source files in addition to the EAR
file. Source files include files associated with Java components, data maps, and
SO on.

7. To overwrite an existing file, click Overwrite existing file.
8. Click Finish.

Results
The contents of the module are exported as an EAR file.
What to do next

Install the module in the administrative console. This deploys the module to IBM
Business Process Manager or WebSphere Enterprise Service Bus.

Installing the EAR file

Installing the EAR file is the last step of the deployment process. When you install
the EAR file on the server and run it, the adapter, which is embedded as part of
the EAR file, runs as part of the installed application.

Before you begin

You must have exported your module as an EAR file before you can install it on
IBM Business Process Manager or WebSphere Enterprise Service Bus.

About this task

To install the EAR file, perform the following procedure. For more information
about clustering adapter module applications, see the Ihttp:/ /www.ibm.com/ |
lsoftware / webservers/appserv /was /library /|

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Applications > New Application > New Enterprise Application.
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Figure 66. Preparing for the application installation window

5. Click Browse to locate your EAR file and click Next. The EAR file name is the
name of the module followed by "App."

6. Optional: If you are deploying to a clustered environment, complete the
following steps.

a. On the Step 2: Map modules to servers window, select the module and
click Next.

b. Select the name of the server cluster.
c. Click Apply.

7. Click Next. In the Summary page, verify the settings and click Finish.

8. Optional: If you are using an authentication alias, complete the following steps:
a. Expand Security and select Business Integration Security.

b. Select the authentication alias that you want to configure. You must have
administrator or operator rights to make changes to authentication alias
configurations.

c. Optional: If it is not already filled in, type the User name.
If it is not already filled in, type the Password.

If it is not already filled in, type the password again in the Confirm
Password field.

f. Click OK.
Results
The project is now deployed and the Enterprise Applications window is displayed.
What to do next
If you want to set or reset any properties or you would like to cluster adapter

project applications, make those changes using the administrative console before
configuring troubleshooting tools.
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Administering the adapter module

When you are running the adapter in a stand-alone deployment, use the
administrative console of the server to start, stop, monitor, and troubleshoot the
adapter module. In an application that uses an embedded adapter, the adapter
module starts or stops when the application is started or stopped.

Changing configuration properties for embedded adapters

To change configuration properties after you deploy the adapter as part of a
module, you use the administrative console of the runtime environment. You can
update resource adapter properties (used for general adapter operation), managed
connection factory properties (used for outbound processing), and activation
specification properties (used for inbound processing).

Related reference

Configuration properties|

IBM WebSphere Adapter for Email has several categories of configuration
properties, which you set with the external service wizard while generating or
creating objects and services. You can change the resource adapter, managed
connection factory, and activation specification properties after you deploy the
application to IBM Business Process Manager or WebSphere Enterprise Service Bus.

Setting resource adapter properties for embedded adapters

To set resource adapter properties for your adapter after it has been deployed as
part of a module, use the administrative console. You select the name of the
property you want to configure and then change or set the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

Custom properties are default configuration properties shared by all IBM
WebSphere Adapters.

To configure properties using the administrative console, use the following
procedure:

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Select Applications > Application Types > WebSphere enterprise
application.

5. From the Enterprise Applications list, click the name of the adapter module
whose properties you want to change. The Configuration page is displayed.
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Figure 67. The Manage Modules selection in the Configuration tab

6. Under Modules, click Manage Modules.
Click IBM WebSphere Adapter for Email.
From the Additional Properties list, click Resource Adapter.

© © N

On the next page, from the Additional Properties list, click Custom
properties.

10. For each property you want to change, perform the following steps.

Note: See ['Resource adapter properties” on page 184] for more information
about these properties.

a. Click the name of the property. The Configuration page for the selected
property is displayed.

b. Change the contents of the Value field or type a value, if the field is
empty.

c. Click OK.

11. In the Messages area, click Save.
Results

The resource adapter properties associated with your adapter module are changed.
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Related reference

[‘Resource adapter properties” on page 184|

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

Setting managed (J2C) connection factory properties for
embedded adapters

To set managed connection factory properties for your adapter after it has been
deployed as part of a module, use the administrative console. You select the name
of the property you want to configure and then change or set the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

You use managed connection factory properties to configure the target mail server
instance.

Note: In the administrative console, the properties are referred to as "J2C
connection factory properties.”

To configure properties using the administrative console, use the following
procedure.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Select Applications > Application Types > WebSphere enterprise
application.

5. In the Enterprise Applications list, click the name of the adapter module
whose properties you want to change.
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Figure 68. The Manage Modules selection in the Configuration tab
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10.

11.

12.

13.

Under Modules, click Manage Modules.
Click IBM WebSphere Adapter for Email.
In the Additional Properties list, click Resource Adapter.

On the next page, from the Additional Properties list, click J2C connection
factories.

Click the name of the connection factory associated with your adapter
module.

In the Additional Properties list, click Custom properties.

Custom properties are those J2C connection factory properties that are unique
to IBM WebSphere Adapter for Email. Connection pool and advanced
connection factory properties are properties you configure if you are
developing your own adapter.

For each property you want to change, perform the following steps.

Note: See [‘Managed connection factory properties” on page 175 for more
information about these properties.

a. Click the name of the property.

b. Change the contents of the Value field or type a value, if the field is
empty.
c. Click OK.

In the Messages area, click Save.
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Results

The managed connection factory properties associated with your adapter module
are changed.

Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

Setting activation specification properties for embedded
adapters

To set activation specification properties for your adapter after it has been
deployed as part of a module, use the administrative console. You select the name
of the message endpoint property you want to configure, and then change or set
the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

You use activation specification properties to configure the endpoint for inbound
processing.

To configure properties using the administrative console, use the following
procedure.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Select Applications > Application Types > WebSphere enterprise
application.

5. From the Enterprise Applications list, click the name of the adapter module
whose properties you want to change.
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Figure 69. The Manage Modules selection in the Configuration tab
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10.

11.

12.

13.

Under Modules, click Manage Modules.
Click IBM WebSphere Adapter for Email.
From the Additional Properties list, click Resource Adapter.

On the next page, from the Additional Properties list, click J2C activation
specifications.

Click the name of the activation specification associated with the adapter
module.

From the Additional Properties list, click J2C activation specification custom
properties.

For each property you want to change, perform the following steps.

Note: See [“Activation specification properties” on page 196 for more
information about these properties.

a. Click the name of the property.

b. Change the contents of the Value field or type a value, if the field is
empty.

c. Click OK.

In the Messages area, click Save.

Results

The activation specification properties associated with your adapter module are
changed.
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Related reference

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

Changing configuration properties for stand-alone adapters

To set configuration properties after you install a stand-alone adapter, use the
administrative console of the runtime environment. Provide the general
information about the adapter and then set the resource adapter properties (which
are used for general adapter operation). If the adapter is used for outbound
operations, create a connection factory and then set the properties for it. If the
adapter is used for inbound operations, create an activation specification and then
set the properties for it.

Setting resource adapter properties for stand-alone adapters

To set resource adapter properties for your stand-alone adapter after it has been
installed on IBM Business Process Manager or WebSphere Enterprise Service Bus,
use the administrative console. You select the name of the property you want to
configure and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

Custom properties are default configuration properties shared by all IBM
WebSphere adapters.

To configure properties using the administrative console, use the following
procedure.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

Log on to the administrative console.

Click Resources > Resource Adapters > Resource adapters.

In the Resource adapters page, click IBM WebSphere Adapter for Email.
In the Additional Properties list, click Custom properties.

N o ok~

For each property you want to change, perform the following steps.

Note: See[“Resource adapter properties” on page 184| for more information
about these properties.

a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is empty.
c. Click OK.

8. In the Messages area, click Save.
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Results

The resource adapter properties associated with your adapter are changed.
Related reference

[“Resource adapter properties” on page 184]

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

Setting managed (J2C) connection factory properties for
stand-alone adapters

To set managed connection factory properties for your stand-alone adapter after it
has been installed on IBM Business Process Manager or WebSphere Enterprise
Service Bus, use the administrative console. You select the name of the property
you want to configure and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

You use managed connection factory properties to configure the target mail server
instance.

Note: In the administrative console, the properties are referred to as "J2C
connection factory properties.”

To configure properties using the administrative console, use the following
procedure:

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

Log on to the administrative console.

Click Resources > Resource Adapters > Resource adapters.

In the Resource adapters page, click IBM WebSphere Adapter for Email.
In the Additional Properties list, click J2C connection factories.

N O~

If you are going to use an existing connection factory, skip ahead to
[from the list of existing connection factories|

Note: If you have selected Specify connection properties when you use the
external service wizard to configure the adapter module, you do not need to
create a connection factory.

If you are creating a connection factory, perform the following steps:
a. Click New.

b. In the General Properties section of the Configuration tab, type a name
for the connection factory. For example, you can type AdapterCF.
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c. Type a value for JNDI name. For example, you can type
com/eis/AdapterCF.

d. Optional: Select an authentication alias from the Component-managed
authentication alias list.

e. Click OK.
f. In the Messages area, click Save.
The newly created connection factory is displayed.

Preferences

New Delete | Manage state...
ek | [y
FlekE
Select| Name 2 INDI name J;
Fl AdapterCF com/eis/AdapterCF

Figure 70. User-defined connection factories for use with the resource adapter

8. In the list of connection factories, click the one you want to use.
9. In the Additional Properties list, click Custom properties.

Custom properties are those J2C connection factory properties that are unique
to WebSphere Adapter for Email. Connection pool and advanced connection
factory properties are properties you configure if you are developing your
own adapter.

10. For each property you want to change, perform the following steps.

Note: See ["Managed connection factory properties” on page 175|for more
information about these properties.

a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is
empty.
c. Click OK.
11. After you have finished setting properties, click Apply.
12. In the Messages area, click Save.

Results

The managed connection factory properties associated with your adapter are set.
Related reference

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

Setting activation specification properties for stand-alone
adapters

To set activation specification properties for your stand-alone adapter after it has
been installed on IBM Business Process Manager or WebSphere Enterprise Service
Bus, use the administrative console. You select the name of the message endpoint
property you want to configure, and then change or set the value.
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Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

You use activation specification properties to configure the endpoint for inbound
processing.

To configure properties using the administrative console, use the following
procedure.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

Log on to the administrative console.

Click Resources > Resource Adapters > Resource adapters.

In the Resource adapters page, click IBM WebSphere Adapter for Email.
In the Additional Properties list, click J2C activation specifications.

No ok~

If you are going to use an existing activation specification, skip ahead to
[from an existing list of activation specifications]

Note: If you have selected Use predefined connection properties when you
use the external service wizard to configure the adapter module, you do not
need to create an activation specification.

If you are creating an activation specification, perform the following steps:
a. Click New.

b. In the General Properties section of the Configuration tab, type a name
for the activation specification. For example, you can type AdapterAS.

c. Type a value for JNDI name. For example, you can type
com/eis/AdapterAS.

Optional: Select an authentication alias from the Authentication alias list.
Select a message listener type.

Click OK.

Click Save in the Messages box at the top of the page.

@ ™o a

The newly created activation specification is displayed.
8. In the list of activation specifications, click the one you want to use.

9. In the Additional Properties list, click J2C activation specification custom
properties.

10. For each property you want to set, perform the following steps.

Note: See [“Activation specification properties” on page 196/ for more
information about these properties.

a. Click the name of the property.

b. Change the contents of the Value field or type a value, if the field is
empty.

c. Click OK.
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11. After you have finished setting properties, click Apply.
12. In the Messages area, click Save.

Results

The activation specification properties associated with your adapter are set.
Related reference

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

Starting the application that uses the adapter

Use the administrative console of the server to start an application that uses the
adapter. By default, the application starts automatically when the server starts.

About this task

Use this procedure to start the application, whether it is using an embedded or a
stand-alone adapter. For an application that uses an embedded adapter, the
adapter starts when the application starts. For an application that uses a
stand-alone adapter, the adapter starts when the application server starts.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Applications > Application Types > WebSphere enterprise applications.

Note: The administrative console is labeled “Integrated Solutions Console”.

5. Select the application that you want to start. The application name is the name
of the EAR file you installed, without the .EAR file extension.

6. Click Start.
Results

The status of the application changes to Started, and a message stating that the
application has started displays at the top of the administrative console.

Stopping the application that uses the adapter

Use the administrative console of the server to stop an application that uses the
adapter. By default, the application stops automatically when the server stops.

About this task

Use this procedure to stop the application, whether it is using an embedded or a
stand-alone adapter. For an application with an embedded adapter, the adapter
stops when the application stops. For an application that uses a stand-alone
adapter, the adapter stops when the application server stops.
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Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Applications > Application Types > WebSphere enterprise applications.

Note: The administrative console is labeled “Integrated Solutions Console”.

5. Select the application that you want to stop. The application name is the name
of the EAR file you installed, without the .EAR file extension.

6. Click Stop.
Results

The status of the application changes to Stopped, and a message stating that the
application has stopped displays at the top of the administrative console.

Monitoring performance using Performance Monitoring
Infrastructure

Performance Monitoring Infrastructure (PMI) is a feature of the administrative
console that allows you to dynamically monitor the performance of components in
the production environment, including the IBM WebSphere Adapter for Email. PMI
collects adapter performance data, such as average response time and total number
of requests, from various components in the server and organizes the data into a
tree structure. You can view the data through the Tivoli® Performance Viewer, a
graphical monitoring tool that is integrated with the administrative console in IBM
Business Process Manager or WebSphere Enterprise Service Bus.

About this task

You can monitor the performance of your adapter by having PMI collect data at
the following points:

* At outbound processing to monitor outbound requests

¢ At inbound event retrieval to monitor the retrieval of an event from the event
table

e At inbound event delivery to monitor the delivery of an event to the endpoint
or endpoints

Before you enable and configure PMI for your adapter, you must first set the level
of tracing detail and run some events from which to gather performance data.

To learn more about how PMI can help you monitor and improve the overall
performance of your adapter environment, search for PMI on the IBM Business
Process Manager or WebSphere Enterprise Service Bus web site:

lhttp:/ /www.ibm.com /software /webservers /appserv/was/library /|

Configuring Performance Monitoring Infrastructure

You can configure Performance Monitoring Infrastructure (PMI) to gather adapter
performance data, such as average response time and total number of requests.
After you configure PMI for your adapter, you can monitor the adapter
performance using Tivoli Performance viewer.
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Before you begin

Before you can configure PMI for your adapter, you must first set the level of

tracing detail and run some events from which to gather performance data.

1. To enable tracing and to receive event data, the trace level must be set to either
fine, finer, finest, or all. After *=info, add a colon and a string, for example:

*=info: WBILocationMonitor.CEI.ResourceAdapter.
*=finest: WBILocationMonitor.LOG.ResourceAdapter.*=finest:

For instructions on setting the trace level, refer to[“Enabling tracing with the]
[Common Event Infrastructure (CEI)” on page 141

2. Generate at least one outbound request or inbound event to produce
performance data that you can configure.

Procedure
1. Enable PMI for your adapter.

a. In the administrative console, expand Monitoring and Tuning, and then
select Performance Monitoring Infrastructure (PMI).

From the list of servers, click the name of your server.

c. Select the Configuration tab, and then select the Enable Performance
Monitoring (PMI) check box.

d. Select Custom to selectively enable or disable statistics.

Performance Monitoring Infrastructure (PMI) > serverl

Configuration and Runtime Settings for Performance Monitoring Infrastructure (PMI)

Runtime Configuration

General Properties

Enable Performance Monitoring Infrastructure (PMI)
D Use sequential counter updates

Currently monitored statistic set

O None

Mo statistics are enzabled

OBEIEiE

Provides basic monitoring (J2EE + Top statistics)

) Extended

Provides extended monitoring (Basic + WebSphere
components)

Qan

All statistics are enabled

@ Custom

Provides fine-grained control to selectively enable statistics

Figure 71. Enabling Performance Monitoring Infrastructure

e. Click Apply or OK.
f. Click Save. PMI is now enabled.
2. Configure PMI for your adapter.

a. In the administrative console, expand Monitoring and Tuning, and then
select Performance Monitoring Infrastructure (PMI).

b. From the list of servers, click the name of your server.
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c. Select Custom.
d. Select the Runtime tab. The following figure shows the Runtime tab.

Performance Monitoring Infrastructure (PMI) > serverl > Custom monitoring level

Configuration and Runtime Settings for Performance Monitoring Infrastructure (PMI)
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T BR D BadRequests CountStatistic| myS5t
| BSM
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| MEDIATION Fl ResponseTime | TimeStatistic | mysSt
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[ bpe
1 (=]

Figure 72. Runtime tab used for configuring PMI
e. Click WBIStats.RootGroup. This is a PMI sub module for data collected in

the root group. This example uses the name WBIStats for the root group.

f. Click ResourceAdapter. This is a sub module for the data collected for the
JCA adapters.

g. Click the name of your adapter, and select the processes you want to
monitor.

h. In the right pane, select the check boxes for the statistics you want to
gather, and then click Enable.

Results
PMI is configured for your adapter.
What to do next

Now you can view the performance statistics for your adapter.

Viewing performance statistics

You can view adapter performance data through the graphical monitoring tool,
Tivoli Performance Viewer. Tivoli Performance Viewer is integrated with the
administrative console in IBM Business Process Manager or WebSphere Enterprise
Service Bus.

Before you begin

Configure Performance Monitoring Infrastructure for your adapter.
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Procedure
1. In the administrative console, expand Monitoring and Tuning, expand

Performance Viewer, then select Current Activity.

In the list of servers, click the name of your server.

Under your server name, expand Performance Modules.

Click WBIStatsRootGroup.

Click ResourceAdapter and the name of your adapter module.

If there is more than one process, select the check boxes for the processes

2

whose statistics you want to view.

Results

The statistics are displayed in the right panel. You can click View Graph to view a
graph of the data, or View Table to see the statistics in a table format.

The following figure shows adapter performance statistics.

Tivoli Performance Viewer > serverl
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GO0 |
|
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™ |
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|

[ ] Enterprise Beans |
|
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|
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|
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- ’ [ Fomitozers ]| Clear ouffe

[ ] system Data

Figure 73. Adapter performance statistics, using graph view

Enabling tracing with the Common Event Infrastructure (CEI)

The adapter can use the Common Event Infrastructure, a component embedded in
the server, to report data about critical business events such as the starting or
stopping of a poll cycle. Event data can be written to a database or a trace log file

depending on configuration settings.
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About this task

Use this procedure to report CEI entries in the trace log file by using the Common
Base Event Browser within the administrative console.

Procedure

1.

6.

In the administrative console, click Troubleshooting.

2. Click Logs and Trace.
3.
4. In the Change Log Detail Levels box, click the name of the CEI database (for

From the list of servers, click the name of your server.

example, WBIEventMonitor.CEL.ResourceAdapter.*) or the trace log file (for
example, WBIEventMonitor. LOG.ResourceAdapter.*) to which you want the
adapter to write event data.

Select the level of detail about business events that you want the adapter to
write to the database or trace log file, and (optionally) adjust the granularity of
detail associated with messages and traces.

* No Logging. Turns off event logging.
* Messages Only. The adapter reports an event.
* All Messages and Traces. The adapter reports details about an event.

* Message and Trace Levels. Settings for controlling the degree of detail the
adapter reports about the business object payload associated with an event. If
you want to adjust the detail level, select one of the following options:

Fine. The adapter reports the event but none of the business object payload.

Finer. The adapter reports the event and the business object payload
description.

Finest. The adapter reports the event and the entire business object payload.

Note: The WebSphere Adapter for Email also provides the following logging
information.

— Logs all the SMTP, POP, and IMAP commands issued to the mail server
and their responses in the trace log file.

— Logs the adapter foundation class (AFC) version, Java Mail API version,
and third-party version artifacts in the trace file.

Click OK.

Results

Event logging is enabled. You can view CEI entries in the trace log file or by using
the Common Base Event Browser within the administrative console.

Troubleshooting and support

142

Common troubleshooting techniques and self-help information help you identify
and solve problems quickly.
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Related reference
The messages issued by IBM WebSphere Adapters are documented in the
WebSphere Adapters, version 6.1.0 information center.

Adapter returns version conflict exception message
Adapter returns version conflict exception message

Problem

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation.jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during runtime, the adapter will return
the ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for Email version 7.5, the following error message is
displayed: IBM WebSphere Adapter for Email has loaded file:/C:/IBM/
WebSphere/ProcServer7 /profiles /ProcSrv01/installedConnectors /
CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with version 7.0.0.3.
However, the base level of this jar required is version 7.5. When you install
multiple adapters with different CWYBS_AdapterFoundation.jar versions, the
adapter returns the ResourceAdapterInternalException message, due to a version
conflict. To overcome this conflict, you must migrate all adapters to the same
version level. For further assistance, contact WebSphere Adapters Support for help.

Solution

Migrate all adapters to the same version level.

For further assistance, visit [http:/ /www-947.ibm.com /support/entry/portal /|
Overview /Software /WebSphere / WebSphere_Adapters_Family]|

Log and Trace Analyzer

The adapter creates log and trace files that can be viewed with the Log and Trace
Analyzer.

The Log and Trace Analyzer can filter log and trace files to isolate the messages
and trace information for the adapter. It can also highlight the adapter's messages
and trace information in the log viewer.

The adapter's component ID for filtering and highlighting is a string composed of
the characters EMARA plus the value of the adapter ID property. For example, if the
adapter ID property is set to 001, the component ID is EMARAGO1.

If you run multiple instances of the same adapter, ensure that the first eight
characters of the adapter ID property are unique for each instance so that you can
correlate the log and trace information to a particular adapter instance. By making
the first seven characters of an adapter ID property unique, the component ID for
multiple instances of that adapter is also unique, allowing you to correlate the log
and trace information to a particular instance of an adapter. For example, when
you set the adapter ID property of two instances of WebSphere Adapter for Email
to 001 and 002. The component IDs for those instances, EMARAOO1 and EMARAGO2, are
short enough to remain unique, enabling you to distinguish them as separate
adapter instances. However, instances with longer adapter ID properties cannot be
distinguished from each other. If you set the adapter ID properties of two instances
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to Instance@l and Instance02, you will not be able to examine the log and trace
information for each adapter instance because the component ID for both instances
is truncated to EMARAInstanc.

For outbound processing, the adapter ID property is located in both the resource
adapter and managed connection factory property groups. If you update the
adapter ID property after using the external service wizard to configure the
adapter for outbound processing, be sure to set the resource adapter and managed
connection factory properties consistently. It prevents inconsistent marking of the
log and trace entries. For inbound processing, the adapter ID property is located
only in the resource adapter properties, so this consideration does not apply.

The data binding component, which converts between business objects and the
native data formats in e-mail text and attachments, does not use the adapter
component ID when generating log and trace messages. Instead, it uses a string
that indicates which data binding generated the message. lists the
component ID used by each adapter-specific data binding for WebSphere Adapter
for Email. For custom data bindings, the data binding must set the component ID.

Table 7. Component IDs for adapter-specific data bindings

Data binding Component ID
EmailSimpleDataBinding EMARASEDB
EmailWrapperDataBinding EMARAEWDB
EmailFixedStructureDataBinding EMARAFSDB

For more information about the adapter ID property, see [“Adapter 1D

l(AdapterID)” on page 185]

Configuring logging and tracing

Configure logging and tracing to suit your requirements. Enable logging for the
adapter to control the status of event processing. Change the adapter log and trace
file names to separate them from other log and trace files.

Configuring logging properties
Use the administrative console to enable logging and to set the output properties
for a log, including the location, level of detail, and output format of the log.

About this task

Before the adapters can log monitored events, you must specify the service
component event points that you want to monitor, what level of detail you require
for each event, and format of the output used to publish the events to the logs.
Use the administrative console to perform the following tasks:

* Enable or disable a particular event log

* Specify the level of detail in a log

* Specify where log files are stored and how many log files are kept
* Specify the format for log output

If you set the output for log analyzer format, you can open trace output using
the Log Analyzer tool, which is an application included with your IBM Process
Server. This is useful if you are trying to correlate traces from two different
server processes, because it allows you to use the merge capability of the Log
Analyzer.
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For more information about monitoring on a IBM Process Server, including service
components and event points, see the documentation for your IBM Process Server.

You can change the log configuration statically or dynamically. Static configuration
takes effect when you start or restart the application server. Dynamic, or run time,
configuration changes apply immediately.

When a log is created, the detail level for that log is set from the configuration
data. If no configuration data is available for a particular log name, the level for
that log is obtained from the parent of the log. If no configuration data exists for
the parent log, the parent of that log is checked, and so on, up the tree, until a log
with a non-null level value is found. When you change the level of a log, the
change is propagated to the children of the log, which recursively propagate the
change to their children, as necessary.

To enable logging and set the output properties for a log, use the following
procedure.

Procedure

1. In the navigation pane of the administrative console, click Servers >
Application Servers.

Click the name of the server that you want to work with.
Under Troubleshooting, click Logs and trace.

Click Change Log Detail Levels.

Specify when you want the change to take effect:

o k0N

 For a static change to the configuration, click the Configuration tab.
* For a dynamic change to the configuration, click the Runtime tab.

6. Click the names of the packages whose logging level you want to modify. The
package names for WebSphere Adapters start with com.ibm.j2ca.*:

 For the adapter base component, select com.ibm.j2ca.base.*.

* For the adapter base component and all deployed adapters, select
com.ibm.j2ca.”.

* For the WebSphere Adapter for Email only, select the com.ibm.j2ca.email.*
package.

7. Select the logging level.

Logging Level Description

Fatal The task cannot continue or the component cannot function.

Severe The task cannot continue, but the component can still function.
This logging level also includes conditions that indicate an
impending fatal error, that is, situations that strongly suggest that
resources are on the verge of being depleted.

Warning A potential error has occurred or a severe error is impending.
This logging level also includes conditions that indicate a
progressive failure, for example, the potential leaking of

resources.

Audit A significant event has occurred that affects the server state or
resources.

Info The task is running. This logging level includes general

information outlining the overall progress of a task.

Config The status of a configuration is reported or a configuration
change has occurred.

Email 145



Logging Level Description

Detail The subtask is running. This logging level includes general
information detailing the progress of a subtask.

8. Click Apply.
9. Click OK.

10. To have static configuration changes take effect, stop and then restart the IBM
Process Server.

Results

Log entries from this point forward contain the specified level of information for
the selected adapter components.

Changing the log and trace file names

To keep the adapter log and trace information separate from other processes, use
the administrative console to change the file names. By default, log and trace
information for all processes and applications on a IBM Process Server is written to
the SystemOut.log and trace.log files.

Before you begin

You can change the log and trace file names at any time after the adapter module
has been deployed to an application server.

About this task

You can change the log and trace file names statically or dynamically. Static
changes take effect when you start or restart the application server. Dynamic or
run time changes apply immediately.

Log and trace files are in the install_root/profiles/profile_name/logs/
server_name folder.

To set or change the log and trace file names, use the following procedure.

Procedure

1. In the navigation pane of the administrative console, select Applications >
Enterprise Applications.

2. In the Enterprise Applications list, click the name of the adapter application.
This is the name of the EAR file for the adapter, but without the ear file
extension. For example, if the EAR file is named Accounting_OutboundApp.ear,
then click Accounting_OutboundApp.

In the Configuration tab, in the Modules list, click Manage Modules.

In the list of modules, click IBM WebSphere Adapter for Email.

In the Configuration tab, under Additional Properties, click Resource Adapter.
In the Configuration tab, under Additional Properties, click Custom properties.

N o~ o

In the Custom Properties table, change the file names.

a. Click either logFilename to change the name of the log file or
traceFilename to change the name of the trace file.

b. In the Configuration tab, type the new name in the Value field. By default,
the log file is called SystemOut.log and the trace file is called trace.log.
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c. Click Apply or OK. Your changes are saved on your local machine.

d. To save your changes to the master configuration on the server, use one of
the following procedures:

* Static change: Stop and restart the server. This method allows you to
make changes, but those changes do not take effect until you stop and
start the server.

* Dynamic change: Click the Save link in the Messages box above the
Custom properties table. Click Save again when prompted.

First-failure data capture (FFDC) support

The adapter supports first-failure data capture (FFDC), which provides persistent
records of failures and significant software incidents that occur during run time in
IBM Business Process Manager or WebSphere Enterprise Service Bus.

The FFDC feature runs in the background and collects events and errors that occur
at run time. The feature provides a means for associating failures to one another,
allowing software to link the effects of a failure to their causes, and thereby
facilitate the quick location of the root cause of a failure. The data that is captured
can be used to identify exception processing that occurred during the adapter run
time.

When a problem occurs, the adapter writes exception messages and context data to
a log file, which is located in the install_root/profiles/profile/1ogs/ffdc
directory.

For more information about first-failure data capture (FFDC), see the IBM Business
Process Manager or WebSphere Enterprise Service Bus documentation.

Endpoint application of the passive adapter instance listens to
the events when enableHASupport is set to True

Problem

In the active-passive configuration mode of the adapters, the endpoint application
of the passive adapter instance also listens to the events/messages even if the
enableHASupport property is set to True.

Cause

By default, in WebSphere Application Server, version 7.0, the
alwaysactivateA11MDBs property in the JMS activation specification is set to True.
This enables the endpoint application of all the adapter (active/passive) instances
to listen to the events.

Solution

To stop the endpoint application of the passive adapter instance from listening to
the events, you must set the alwaysactivateAT1MDBs property value to False. The
JMS activation specification is associated with one or more MDBs and provides the
necessary configuration to receive events. If the alwaysActivateAT1MDBs property is
set to False, then the endpoint application of only the active adapter instance
receives the events.
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Perform the following procedure, to set the alwaysActivateATTMDBs property to
False.

1. Log on to the administrative console.

Go to Resources> JMS > Activation specifications.

Click the activation specification corresponding to the application from the list.
Click Custom properties under Additional properties.

Click alwaysActivateAlIMDBs.

Change the value to False.

Click Apply and OK.

N ook

Result

The endpoint application of only the active adapter instance listens to the events.

Solutions to common problems

Some of the problems you might encounter while running WebSphere Adapter for
Email with your database are described along with solutions and workaround.
These problems and solutions are in addition to those documented as technotes on
the software support website.

For a complete list of technotes about WebSphere Adapters, see
http:/ /www.ibm.com /support/search.wss?tc=SSMKUK &rs=695&rank=8|
&dc=DB520+D800+D900+DA900+DA800-+DB560&d tm|

Adapter returns version conflict exception message
Problem

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during runtime, the adapter will return
the ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for Email version 7.5, the following error message is
displayed: IBM WebSphere Adapter for Email has loaded file:/C:/IBM/
WebSphere/ProcServer7 /profiles /ProcSrv01/installedConnectors /
CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with version 7.0.0.3.
However, the base level of this jar required is version 7.5. When you install
multiple adapters with different CWYBS_AdapterFoundation.jar versions, the
adapter returns the ResourceAdapterInternalException message, due to a version
conflict. To overcome this conflict, you must migrate all adapters to the same
version level. For further assistance, contact WebSphere Adapters Support for help.

Solution

Migrate all adapters to the same version level.

For further assistance, visit [http: / /www-947.ibm.com /support/ entry/portal / |
Overview /Software / WebSphere / WebSphere_Adapters_Familyl]

Self-help resources

Use the resources of IBM software support to get the most current support
information, obtain technical documentation, download support tools and fixes,
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and avoid problems with WebSphere Adapters. The self-help resources also help
you diagnose problems with the adapter and provide information about how to
contact IBM software support.

Support Web site

The WebSphere Adapters software support Web site at Ihttp:/ /www-947 ibm.com/ |

support/entry /portal /Overview /Software / WebSphere /|

WebSphere_Adapters_Family| provides links to many resources to help you learn

about, use, and troubleshoot WebSphere Adapters, including:

¢ Flashes (alerts about the product)

* Technical information including the product information center, manuals, IBM
Redbooks®, and whitepapers

* Educational offerings

* Technotes

Recommended fixes

A list of recommended fixes you must apply is available at the following location:
http:/ /www.ibm.com /support/docview.wss?fdoc=aimadp&rs=695|
&uid=swg27010397]

Technotes

Technotes provide the most current documentation about the WebSphere Adapter

for Email, including the following topics:

* Problems and their currently available solutions

* Answers to frequently asked questions

* How to information about installing, configuring, using, and troubleshooting the
adapter

* IBM Software Support Handbook

For a list of technotes for WebSphere Adapters, visit this address:

http:/ /www.ibm.com /support/search.wss?tc=SSMKUK &rs=695&rank=8|
&dc=DB520+D800+D900+DA900+DA800+DB560&d tm|

Plug-in for IBM Support Assistant

WebSphere Adapter for Email provides a plug-in for IBM Support Assistant, which
is a free, local software serviceability workbench. The plug-in supports the
dynamic trace feature. For information about installing or using IBM Support
Assistant, visit this address:

|http: / /www.ibm.com/software/support/isa/ |

Reference information

To support you in your tasks, reference information includes details about business
objects that are generated by the external service wizard and information about
adapter properties, including those that support bidirectional transformation. It
also includes pointers to adapter messages and related product information.
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Business object information

A business object is a structure that contains specific information about an e-mail
being processed by an inbound or outbound module. Business objects contain
information about how the adapter processes the e-mail content and attachments,
and also how the business objects are associated with an operation (such as
Create). Business object names are generated by the external service wizard and
are named according to their contents.

Business object structures

The adapter supports three different types of business object structures: simple
alert e-mail, Email business object, and a user-defined type business object. The
simple alert e-mail structure sends text-only messages without attachments, the
Email business object sends and receives all types of messages both for
transformed and non-transformed types, and the user-defined type sends and
receives your own fixed structure transformed type messages only.

All the business object structures include standard headers such as To and From in
the wrapper business object. For more information about the headers supported by
the adapter, see the [“Header business object properties” on page 158 topic.

Simple alert e-mail business object structure

The simple alert e-mail business object structure (SimpleAlertEmail) sends a single
string e-mail message to the mail server. This structure is supported only during
the outbound communication. With the SimpleAlertEmail structure, the e-mail
message does not undergo any formatting or transformation. The intended
recipient is a human and the body mime type is text/plain. As shown in the
following illustration, it is composed of a single business object.

[] simpleAlertEmail
[

To string

CcC string

BCC string

Subject string
Reply-To  string
Encoding  string
mailContent string

Figure 74. SimpleAlertEmail business object structure

With this business object structure, the only required values are the From and To
fields. For more information about the values of the SimpleAlertEmail business
object structure, see the section on the SimpleAlertEmail business object structure
in the reference section of this documentation.

Email business object structure

The Email business object structure is used both during inbound and outbound
communication. The adapter always creates an Email business object for its specific
use. The Email business object is a parent business object consisting of attributes
that directly relate to the fields in an e-mail message. If you choose, it can also
contain child business objects for e-mail mailContent business object and
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attachments. The following illustration shows the Email business object with two
child business objects: header and mailAttachments.

% (=] Email = [2J Header

[ [ = [Z] Mailattachment
From string headerMame string I |
To string headerValue string attachmentMame string
CC string appBOData anyType
BCC string
Subject string
Reply-To string
Date string
headerList Header []
Encoding string

mailCaontent string
mailattachments MailAttachment [ ]
fileReferences  string []

Figure 75. Email business object with mail attachment and header child objects

The header child business object shown in stores header information for
an e-mail. The headerList attribute in the Email wrapper object is an array of
header business objects. The headerList attribute might contain all the headers for
an e-mail, each represented by a header business object. However, the standard
headers present in the Email wrapper business object takes precedence over the
headers in the headerList attribute.

Note: Bcc and Resent-bec headers, cannot be retrieved from an inbound e-mail, but
they can be set for outbound e-mails.

For each attachment on an inbound e-mail, the adapter creates a separate mail
attachment business object. For every mail attachment business object the adapter
receives during outbound communications, the adapter creates a separate e-mail
attachment. As noted in the illustration, the mail attachment business object
consists of an attachment name and the data in the attachment.

The data in an attachment that can be of any type. Business objects such as
Customer or PurchaseOrder, which have been defined in the business object editor
before being processed by external service wizard and have a specific structure
outlined by you, are called structured content business objects. Similarly, you can
specify a structured business object for the mailContent attribute of the Email
wrapper business object.

Structured content business objects are decomposed by the data binding and their
content is recorded into individual logical fields within the business object
structure. Unstructured content business objects are provided by the adapter and
allow a user to send string (AsText) or bytes (AsBinary) through the adapter.
Unstructured content business objects are used for pass-through processing during
outbound communication.

Note: Because the adapter expects to decompose each business object added to the

module, you must define a data binding mime type and a data handler during the
data binding configuration portion of the external service wizard. The adapter does
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not automatically associate a data binding mime type and data handler type with
your business object because it has no way of knowing what type of conversion is
necessary for the objects you import.

The following illustration shows a mail attachment business object with a customer
child object.

& MailAttachment = [Z] Customer
[ L |
attachmentiame string Mame  string
appBOData Customer Address string
Phone string

Figure 76. Mail attachment business object with structured content child object

Unstructured content business objects are used to store unstructured data, such as
rich text, PDF, or images (as binary content). They are not decomposed by the data
binding because their content is not placed into specific fields in the business
object. Instead, unstructured content is supplied as a single string or binary field in
the business object structure. The following illustration shows a mail attachment
business object with an unstructured content child object.

[C] MailAttachment = [£] UnstructuredContent
[ [ ]
attachmentiame string ContentType siring
appBOData UnstructuredContent: ChjectMame  string
% AsText string

AsBinary hexBinary

Figure 77. Mail attachment business object with unstructured content

Unstructured business objects have the following attributes:

Table 8. Unstructured business object attributes

Attribute name Value

Type of content being sent. For example,
text/xml, application/binary, or image/jpeg.

Content type

AsText Value to be sent as e-mail text

Value to be sent as binary data

AsBinary

User-defined business object structure

Like the Email business object structure, the user-defined business object structure
consists of attributes that directly relate to the fields in an e-mail message and
child business objects for e-mail attachments and headers. While the Email
business object structure can contain child objects of any type, the user-defined
business object structure requires that you know the structure of all e-mails being
sent or received by the adapter in advance. For example, if all incoming and
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outgoing e-mails contain mail content of customer type, attachmentl of account
type, and attachment2 of account type, as shown in [User-defined business object]
istructure with child objects|

By selecting the user-defined data type in the external service wizard, you can
define your own fixed structure wrapper business object. This configuration
enables you to use ordinary mapping tools to consume and work with your
business objects without having to determine the business object type at run time.

The following illustration shows an example of a user-defined business object with
Order, Customer, and Account child business objects.

[C] FixedStructureEmail = [C] Header
[ ] [ ] = [C] Customer
From string headerMame string I i
To string headerValue string MName  string
cCc string Address string
BCC string Phone  string
Subject string
Reply-To string I
Date string I
headerlist  Header [] = () Order
Encoding string l 3 e | | = [C] Account |
maillContent Customer ;
type string

attachmentl Order
Attachment2 Account

address string

Figure 78. User-defined business object structure with child objects

If you select user-defined Email business object in the external service wizard
when creating your inbound module, the adapter only processes events symmetric
to the user-defined Email business object you define in the
EmailFixedStructureDataBinding data binding. If the adapter receives an event that
is not symmetric to the specified custom data type, it does not process the event.
Instead, the adapter throws an exception with the appropriate error message.

The adapter logs an error if an event:

* Contains a different type of mail or attachment content than the type defined in
the EmailFixedStructureDataBinding.

e Contains a different number of attachments than defined in the
EmailFixedStructureDataBinding.

¢ Is missing mail content or attachments.
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Related reference

[“Supported operations’]

Each business object is associated with an operation, such as create. Operations
might be stored in a business graph, which is like an enhanced business object, if
you choose to use business graphs. Each operation tells the adapter what to do
with the business object. For outbound communication, there are three different
create operations used to create an e-mail from the contents of a business object.
For inbound communication, only the emit e-mail operation is supported.

[“Interaction specification properties” on page 188§|

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

Supported operations

Each business object is associated with an operation, such as create. Operations
might be stored in a business graph, which is like an enhanced business object, if
you choose to use business graphs. Each operation tells the adapter what to do
with the business object. For outbound communication, there are three different
create operations used to create an e-mail from the contents of a business object.
For inbound communication, only the emit e-mail operation is supported.

Create Email

In the external service wizard, you specify a name for the operation. This name
can be anything meaningful to you, such as SendEmail or SendEmailwithBO. The
operations listed here represent the three examples of types of outbound create
options that the adapter can invoke. The emit operation is always used for
inbound communication, as it is the only supported inbound operation.

The create e-mail operation is used with the Email business object. When invoked,
the create e-mail operation creates an e-mail message from the attributes in the
Email business object.

Create address

The create address operation is used when the adapter creates an e-mail from a
fixed structure business object structure that includes an address business object.

Create customer

The create customer operation is used when the adapter creates an e-mail from a
fixed structure business object structure that includes a customer business object.

Emit Email
For inbound communication, emit e-mail is the only supported operation. When

invoked, this operation instructs the adapter to take information from an e-mail
and convert it to representative business objects.
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Related concepts

[‘Business objects” on page 12|

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an e-mail attachment. The adapter
uses business objects to either obtain information from an e-mail or to produce an
e-mail.

[“Business object structures” on page 150

The adapter supports three different types of business object structures: simple
alert e-mail, Email business object, and a user-defined type business object. The
simple alert e-mail structure sends text-only messages without attachments, the
Email business object sends and receives all types of messages both for
transformed and non-transformed types, and the user-defined type sends and
receives your own fixed structure transformed type messages only.

Naming conventions
When the external service wizard generates a business object, it provides a name
for the business object based on the business object schema file (XSD file) name.

When the external service wizard provides the business object name, it converts
the name of the object to mixed case, which means that it removes any separators,
such as spaces or underscores, and then capitalizes the first letter of each word.
For example, if the external service wizard uses a mail server object called
CUSTOMER_ADDRESS to generate a business object, it generates a business object
called CustomerAddress.

The generated business object name can indicate the structure of the business
object. Names are derived during the metadata import process and are the same as
the name given by the user to the pre-generated XSD files. Business objects names
have no semantic value to the adapter. It means that if you change the business
object name, the behavior of the business object remains the same.

Important: If you choose to rename a business object, use the refactoring
functionality in IBM Integration Designer to ensure that you update all the
business object dependencies. For instructions on using refactoring to rename
business objects, refer to the following link: |http:/ /bidoc.torolab.ibm.com:7500 /|
lhelp /topic/com.ibm.wbpm.wid.bpel.doc /selector/topics / trefacts.html

Business graphs take the name of the business object followed by "BG". For
example, a business graph for a customer business object would be called
CustomerBG.

Note: Business graph generation is optional.

Email business object properties

During external service discovery, the adapter generates the Email business object.
This parent business object includes all the header, encoding, and mail content
details that the adapter needs to process both inbound and outbound requests.

The following table lists the attributes of the Email business object. For the simple
alert e-mail business object structure, a number of header fields (such as To and
From) are part of the Email wrapper business object. These header fields are not
part of the Email wrapper business object with other business object structures
(such as the generic e-mail data type). For this reason, all the header values
available in the simple alert e-mail wrapper business object are not listed in this
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topic. A list and description for each of the properties available in the simple alert
e-mail version of the wrapper business object are available in the [“Header business

fobject properties” on page 158 topic.

Each property available with all versions of the Email business object is described
completely in the sections that follow the table.

Note: In business object attributes, the use of the [] symbol denotes an array of
values.

Table 9. Email business object attributes

Business object attribute name Description
Contains outbound data encoding information when you

do not use data transformation

Contains the list of files that must be attached to an
outbound e-mail
Contains header details for all the headers listed in an

inbound e-mail request

[Mail attachments|

Stores the content for the attachments of an e-mail

Stores the content for the body of an e-mail. This
attribute does not include e-mail attachments.

Encoding

This attribute is set during outbound communications to indicate the type of
character encoding the adapter will use.

Table 10. Encoding details

Required

No

Default

No default value

Attribute type

String

Usage Encoding is used for headers, mail content, and attachment business objects.
Example ASCII for character encoding based on the English alphabet
Bigb for character encoding based on traditional Chinese characters
GB18030 for globalized characters in a business graph
Globalized No
Bidi supported No

File references

This attribute contains a list of files that must be attached to an outbound e-mail.
This attribute is not used during inbound processing.

Table 11. File references details

Required

No

Default

No default value

Attribute type

String []

Usage

During outbound communication, the run time specifies absolute paths for the referenced files
listed in this field. The adapter reads these files, which are located on the local system with the
adapter, and includes them as attachments to the outbound e-mail.
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Table 11. File references details (continued)

Globalized

Yes

Bidi supported

No

Header List

This attribute is populated with the header details for all the headers listed in a
polled e-mail request.

Table 12. Header list details

Required

No

Default

No

default value

Attribute type

Header([]

Usage Headers are the fields in an e-mail, such as To, From, Cc, Bec, and Subject.
Globalized Yes
Bidi supported Yes

Mail attachments

This attribute stores the content details for an attachment in an inbound e-mail
request.

Table 13. Mail attachments details

Required

No

Default

No

default value

Attribute type

MailAttachment][]

Usage Stores the content details for an attachment in an inbound e-mail request
Globalized Yes
Bidi supported No

Mail content

During inbound communication, this attribute stores any content found in the
body of the e-mail request. During outbound communication, this attribute
contains the data that becomes the body of the e-mail being sent to the mail server.
This attribute does not include e-mail attachments.

Table 14. Mail content details

Required

Yes

Default

No

default value

Attribute type

anylype

Usage Contains body content of an e-mail
Globalized Yes
Bidi supported No
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Header business object properties

Header business object properties are used to store standard (RFC822) e-mail
headers as well as headers customized by you. They are populated dynamically by
the adapter and comprise a name and value pair. Customized headers and their
related information are tracked by the adapter with the help of the headerList
entries in the Email business object.

The adapter picks up the header name from the HeaderList property in the Email
business object. Each header can have multiple values, but Bcc and Resent-bcc
headers cannot be retrieved from an e-mail. However, they can be sent on an
e-mail.

All headers are encoded by the adapter in the specified character set. Because To
and From header values are required, the adapter will end the outbound Create
operation if the encoding of either of those header values fails. The Java Mail API
does not provide enough information to decipher the character set and encoding
information for the header content; hence header content might not be globalized

The following table provides example header business object name and value
pairs.

Table 15. Examples of header business object name and value pairs

Name

Value

HeaderName = to

HeaderValue = abc@xyz.com

HeaderName = cc

HeaderValue = def@xyz.com

HeaderName =
mimetype

HeaderValue = text/plain

The following table lists the Standard Email Headers supported by the adapter. A
more detailed description of each property is provided in the sections that follow
the table. For more information about how to read the property detail tables in the
sections that follow, see [Guide to information about properties

Table 16. Standard Email Headers supported by the adapter

Description

The blind carbon copy addresses for the e-mail

The e-mail addresses for secondary recipients of the e-mail

Specifies whether text comments can be added to the message body

The date the e-mail was created

ncrypte

Specifies whether the body of a message was encrypted by the sender

The address that the e-mail was sent from

Subject line of previous correspondence that the e-mail message is responding to

Keywords or phrases contained in the e-mail separated by commas

The unique identifier (local-part address unit) referring to the particular version of a particular
message

eferences|

Other pieces of e-mail correspondence referenced by this e-mail

eply to

Addresses where responses to the e-mail will be sent
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E-mail addresses for secondary or informational recipients of the e-mail
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Table 16. Standard Email Headers supported by the adapter (continued)

Property name

Description

[Resent - date]

The date the e-mail was forwarded

[Resent - from|

The address that the e-mail was resent from

Resent - messaged
identifier|

The unique identifier (local-part address unit) that refers explicitly to a particular version of a
particular message

[Resent - reply to

Addresses where responses to the e-mail will be sent

[Resent - sender|

Authenticated identity of the agent (person, system, or process) sending the e-mail message

[Resent - tof Addresses for the primary recipients of the e-mail

[Sender] Authenticated identity of the agent (person, system, or process) sending the e-mail message
|Subject]| Summary of what the e-mail is about

Addresses for the primary recipients of the e-mail

Blind carbon copy (Bcc)

This property specifies blind carbon copy addresses for the e-mail. The addresses
listed in this field are not included in copies of the message sent to the primary
and secondary recipients.

Table 17. Blind carbon copy details

Required No
Default No default value
Property type String
Usage This header is only supported for outbound communication.
Some systems choose to include the text of the Bcc field only in the copy of the author,
while some systems include these addresses to all those recipients listed in the Bcc field.
Globalized Yes

Bidi supported

Yes

Carbon copy (Cc)

This property specifies the e-mail addresses of secondary recipients of the e-mail.

Table 18. Carbon copy details

Required

No

Default

No default value

Property type

String

Usage Specifies e-mail addresses of secondary recipients of the e-mail. All recipients listed in this field
are visible to anyone receiving the e-mail.
Globalized Yes
Bidi supported Yes
Comments

This property permits the addition of text comments to the message body without
disturbing the message body content.
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Table 19. Comments details

Required No
Default No default value
Property type String
Usage Permits the addition of text comments to the message body without disturbing the message
body content.
Bidi supported No
Date

The date set by the mail server of the sender during inbound processing. The date
the e-mail is created during outbound processing.

Table 20. Date details

Required

No

Default

No default value

Property type

String

Usage

The date set by the mail server of the sender during inbound processing. The date the e-mail is
created during outbound processing.

Globalized

Yes

Bidi supported

Yes

Encrypted

This property indicates whether the body of a message was encrypted by the
sender. If set to True, the message was encrypted.

Table 21. Encrypted details

Required

No

Default

No default value

Property type

String

Usage

Setting the encrypted header value to True does not enable encryption. This property only
notes whether the message has been encrypted for informational purposes.

Bidi supported

No

From

This property specifies the address that the e-mail was sent from.

Table 22. From details

Required Yes

Default No default value

Property type String

Usage Specifies the address that the e-mail was sent from.
Globalized Yes

Bidi supported Yes
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In reply to

The contents of this field identify which piece of previous correspondence is being
answered with a new e-mail message.

Table 23. In reply to details

Required

No

Default

No default value

Property type

String

Usage Identifies which piece of previous correspondence is being answered with a new e-mail
message.
Bidi supported No
Keywords

This property specifies keywords or phrases contained in the e-mail, which are
separated by commas.

Table 24. Keywords details

Required No

Default No default value

Property type String

Usage Keywords specified using this field are used during selective polling.

Bidi supported

No

Message Identifier (Message ID)

This property specifies the unique identifier (local-part address unit) that refers
explicitly to a particular version of a particular message.

Table 25. Message ID details

Required

No

Default

No default value

Property type

String

Usage

Each revision of a given e-mail message is assigned a new message ID. The uniqueness of the
message ID is guaranteed by the host system that generates it. It is machine readable and does
not include any meaningful syntax for users.

Bidi supported

No

References

The contents of this field identify other pieces of e-mail correspondence referenced
by the e-mail.

Table 26. References details

Required No

Default No default value

Property type String

Usage Identifies other pieces of e-mail correspondence referenced by the e-mail.
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Table 26. References details (continued)

Bidi supported

|N0

Reply to

This property specifies the addresses where responses to the e-mail are to be sent.

Table 27. Reply to details

Required

No

Default

No default value

Property type

String

Usage

Specifies the addresses where responses to the e-mail are to be sent.

Bidi supported

No

Resent - blind carbon copy (Resent-bcc)

This property specifies the blind carbon copy addresses for the e-mail.

Table 28. Resent-blind carbon copy details

Required

No

Default

No default value

Property type

String

Usage

This value is only supported during outbound communication.

The addresses listed in this field are not included in copies of the message

sent to the primary and secondary recipients. Some systems choose to include

the text of the Bec field only in the copy of the author, while some systems include these
addresses to all those recipients listed in the Bcc field.

Bidi supported

No

Resent - carbon copy (Resent-cc)

This property specifies the e-mail addresses for secondary recipients of the e-mail.

Table 29. Resent-carbon copy details

Required No

Default No default value

Property type String

Usage Specifies the e-mail addresses for secondary recipients of the e-mail.

Bidi supported

No

Resent - date

This property specifies the date that the e-mail was forwarded.

Table 30. Resent - date details

Required No
Default No default value
Property type String
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Table 30. Resent - date details (continued)

Usage

Specifies the date that the e-mail was forwarded.

Bidi supported

No

Resent - from

This property specifies the address that the e-mail was resent from.

Table 31. Resent - from details

Required No

Default No default value

Property type String

Usage Specifies the address that the e-mail was resent from.

Bidi supported

No

Resent message identifier (Resent-message-ID)

This property specifies the unique identifier (local-part address unit) that refers
explicitly to a particular version of a particular message.

Table 32. Resent-message-ID details

Required No

Default No default value

Property type String

Usage Each revised e-mail message is assigned a new message ID. The uniqueness of the message 1D

is guaranteed by the host system that generates it. It is machine readable and does not include
any meaningful syntax for users.

Bidi supported

No

Resent - reply to

This property specifies the addresses where responses to the e-mail are to be sent.

Table 33. Resent reply to details

Required No

Default No default value

Property type String

Usage Specifies the addresses where responses to the e-mail are to be sent.

Bidi supported

No

Resent - sender

This property specifies the authenticated identity of the agent (person, system, or
process) that is sending the e-mail message.

Table 34. Resent sender details

Required

No
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Table 34. Resent sender details (continued)

Default

No default value

Property type

String

Usage Specifies the authenticated identity of the agent (person, system, or process) that is sending the
e-mail message.
Bidi supported No
Resent - to

This field contains the addresses for the primary recipients of the e-mail.

Table 35. Resent - to details

Required No
Default No default value
Property type String
Usage Contains the addresses for the primary recipients of the e-mail.
Bidi supported No
Sender

This property specifies the authenticated identity of the agent the (person, system,
or process) that is sending the e-mail message.

Table 36. Sender details

Required

No

Default

No default value

Property type

String

Usage Specifies the authenticated identity of the agent the (person, system, or process) that is sending
the e-mail message.
Bidi supported No
Subject

This property contains a summary of what the e-mail is about.

Table 37. Subject details

Required No

Default No default value

Property type String

Usage Contains a summary of what the e-mail is about.
Globalized Yes

Bidi supported Yes
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Table 38. To details

To

This field contains the addresses for the primary recipients of the e-mail.

Required

No

Default

No default value

Property type

String

Usage Contains the addresses for the primary recipients of the e-mail.
Globalized Yes
Bidi supported Yes

Mail attachment business object properties

Each e-mail attachment is stored in its own Mail Attachment object. Mail
Attachment business objects consist of an attachment name and data worth of one
e-mail attachment.

During inbound processing, the attachments are parsed and the contents sent out
as business objects. By default, each attachment is parsed into one MailAttachment
business object. However, you can select to emit the entire e-mail as a single Email
business object by setting the activation specification property Emit individual
business objects from a multipart e-mail to false in the external service wizard.

During outbound processing, IBM Business Process Manager or WebSphere
Enterprise Service Bus sets the data within the MailAttachment business object.
The data in this business object then becomes an e-mail attachment when the
e-mail message is created by the adapter.

Note: MailAttachment objects can store e-mail attachments of any user-defined
type (such as Customer or PurchaseOrder).

The following table describes the attribute values for the mail attachment business
object. A more detailed description of each property is provided in the sections that
follow the table. For more information about how to read the property detail tables
in the sections that follow, see|Guide to information about properties

Table 39. MailAattachment business object attribute values

Attribute name

Purpose

| Attachment] The name of the e-mail attachment

[name”|

|“ Application| Data contained in the e-mail attachment.
usiness objec

|data

l(AppBOData)” on|
||Eage 166|

Attachment name

This attribute value specifies the name of the file attached to the e-mail.

Table 40. Attachment name attribute characteristics

Required

Yes
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Table 40. Attachment name attribute characteristics (continued)

Default

No default value

Attribute type

String

Usage The fully qualified path of the e-mail attachment
Globalized Yes
Bidi supported No

Application business object data (AppBOData)

This attribute comprises the data in the file attached to the e-mail.

Table 41. Application business object data attribute characteristics

Required

Yes

Default

No default value

Attribute type

anyType

Usage The anyType attribute type can hold hexBinary content or a child business-object.
For hexBinary type, the data binding deciphers the data and converts it to an unstructured
content business object.

Globalized Yes

Bidi supported No

Email outbound response business object properties

To support business faults, the WebSphere Adapter for Email must be configured
to receive the outbound responses from the mail server. The response from the
mail server contains recipient IDs to which the e-mail has been successfully
delivered, the recipient IDs to which the e-mail is not delivered, the delivery
status, and the message ID of the e-mail. The adapter then builds a response
business object from the response received from the mail server.

Note: You can configure the time period for which the adapter waits to receive a
response from the mail server by setting the ["Response set timeout]
[(ResponseSetTimeout)” on page 181| property.

The following table describes the attribute values for the Email outbound response
business object. A more detailed description of each property is provided in the
sections that follow the table. For more information about how to read the

property detail tables in the sections that follow, see|Guide to information about]

Note: In the business object attributes description, the use of the [] symbol denotes
an array of values.

Table 42. Email outbound response business object attributes

Business object attribute name Description
DeliveredTo Contains the recipient addresses to which the e-mail is

delivered

[UndeliveredTo

Contains the recipient addresses to which the e-mail is
not delivered
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Table 42. Email outbound response business object attributes (continued)

Business object attribute name

Description

|“Status”|

Contains information about the delivery status of the
e-mail

[“MessagelD” on page 16§

Contains the message ID of the e-mail

DeliveredTo

This attribute contains information about delivered recipient addresses.

Table 43. Delivered e-mail attribute details

Required

No

Default

No default value

Attribute type

String []

Usage This attribute contains the list of all the e-mail addresses to which the e-mail has been
successfully delivered.

Globalized Yes

Bidi supported Yes

UndeliveredTo

This attribute contains information about undelivered recipient addresses.

Table 44. Undelivered e-mail attribute details

Required No
Default Null
Attribute type String []

Usage This attribute contains list of all the e-mail addresses to which the e-mail is not delivered and
displays null if the e-mail is delivered to all addresses.
Globalized Yes
Bidi supported Yes
Status

This attribute stores the delivery status of the e-mail.

Table 45. Status attribute details

Required

No

Default

No default value

Possible Values

MESSAGE DELIVERED SUCCESSFULLY
MESSAGE NOT DELIVERED

Attribute type

String

Usage This attribute shows the delivery status of the e-mail. The adapter shows the status as either
message delivered successfully or message not delivered.

Globalized Yes

Bidi supported No
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MessagelD

This attribute stores the message ID of the e-mail.

Table 46. MessagelD attribute details

Required

Default

No default value

Attribute type

String

Usage

During outbound operation, this attribute stores the message ID of e-mail. The adapter then
returns the message ID in the response business object.

Globalized

Bidi supported

Business faults

The adapter supports business faults, which are exceptions that are anticipated and
declared in the outbound service description, or import. Business faults occur at
predictable points in a business process, and are caused by a business rule
violation or a constraint violation.

Although IBM Business Process Manager and WebSphere Enterprise Service Bus
support other types of faults, the adapter generates only business faults, which are
called simply faults in this documentation. Not all exceptions become faults. Faults
are generated for errors that are actionable, that is, errors that can have a recovery
action the ones that does not require the termination of the application. For
example, the adapter generates a fault when it receives a business object for
outbound processing that does not contain the required data or when the adapter
encounters certain errors during outbound processing.

Fault business objects

The external service wizard creates a business object for each fault that the adapter
can generate. In addition, the wizard creates a WBIFault superset business object,
which has information common to all faults, such as the message, errorCode, and
primaryKeySet attributes as shown in

= [Z] WBIFault
[ |
[e] message string

[e] errarCode string
[€] primaryKeySet PrimaryKeyPairType []

Figure 79. The structure of the WBIFault business object

The WebSphere Adapter for Email enables faults for you. Manual configuration of
faults is not required. The adapter provides the following fault business objects
that the wizard creates:
¢ EmailSendFault
When processing any create operation, the adapter generates this fault when
sending an e-mail if an exception occurs that is not related to connection to the
mail server.
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* MissingDataFault

If the business object that is passed to the outbound operation does not have all
the required attributes, the adapter returns this fault. This fault can occur for the
Create, Delete, Update, Retrieve, ApplyChanges and Exists operations.

Event store structure

Each time an e-mail is read by the adapter during inbound communication, the
adapter updates the status of the event in an event store. The status of each event
is continually updated by the adapter for recovery purposes until the events are
delivered to a configured export on the run time.

When event persistence is optionally configured, the adapter implements the event
store in an Email-specific relational table called EmailEventTable. This table is tied
to event recovery operations. When event persistence is not configured, the adapter
determines which events need to be recovered based on the e-mails present in the
staging directory. The event recovery feature is activated when the adapter
terminates abruptly. Upon termination, events that are still being processed, or
have been processed but not completely posted to the service, still require
completion. The adapter reads the event store to determine which events still need
to be processed and then facilitates their completion. The event persistence
framework takes care of delivering the event only once to the target service.

Each inbound module has a unique connection and is associated with one event
store. Multiple modules pointing to the same event store is not supported

The following table illustrates the structure of the WebSphere Adapter for Email
event store.

Table 47. Event table structure

Column name Property type Description

EVNTID Varchar (255)

The event ID associated with the polled
inbound event. The ID is taken from the
message ID of the polled e-mail.

The status of the event as it moves
through the system. Valid values are NEW
and INPROGRESS.

EVNTSTAT Integer

An event is logged in the event store as
NEW when the adapter discovers a new
e-mail on the mail server that meets the
specified search criteria noted in the
activation specification properties.

When the adapter copies an event from
the mail server to the local system in
RFC822 format, it is logged in the event
table as INPROGRESS.

XID

Varchar (255)

The XID. It is used by the adapter for
assured event delivery and recovery.

BQTOTAL

Integer

Not used by the adapter.

BQPROC

Integer

Not used by the adapter.

EVNTDATA

Varchar (255)

Stores the name of the folder on the mail
server where the e-mail event was polled.
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Related concepts

[“Event store” on page 12|
The event store is a persistent cache where event records are saved until the
polling adapter can process them.

Outbound configuration properties

IBM WebSphere Adapter for Email has several categories of outbound connection
configuration properties, which you set with the external service wizard while
generating or creating objects and services. You can change the resource adapter
and managed connection factory properties after you deploy the module to IBM
Business Process Manager or WebSphere Enterprise Service Bus using IBM
Integration Designer or the administrative console, but connection properties for
the external service wizard cannot be changed after deployment.

Guide to information about properties

The properties used to configure WebSphere Adapter for Email are described in
detail in tables included in each of the configuration properties topics, such as
Resource adapter properties, Managed connection factory properties, and so on. To
help you use these tables, information about each row you might see is explained
here.

The following table explains the meaning of each row that might be displayed in
the table for a configuration property.

Row Explanation

Required A required field (property) must have a value in order for the
adapter to work. Sometimes the external service wizard
provides a default value for required properties.

Removing a default value from a required field on the external
service wizard will not change that default value. When a
required field contains no value at all, the external service
wizard processes the field using its assigned default value,
and that default value is displayed on the administrative
console.

Possible values are Yes and No.

Sometimes a property is required only when another property
has a specific value. When this is the case, the table will note
this dependency. For example,

* Yes, when the EventQueryType property is set to Dynamic

* Yes, for Oracle databases

Possible values Lists and describes the possible values that you can select for
the property.

Default The predefined value that is set by the external service wizard.
When the property is required, you must either accept the
default value or specify one yourself. If a property has no
default value, the table will state No default value.

The word None is an acceptable default value, and does not
mean that there is no default value.

Unit of measure Specifies how the property is measured, for example in
kilobytes or seconds.
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Row

Explanation

Property type

Describes the property type. Valid property types include:
* Boolean

* String

¢ Integer

Usage

Describes usage conditions or restrictions that might apply to
the property. For instance, here is how a restriction would be
documented:

For Rational® Application Developer for WebSphere Software
version 6.40 or earlier, the password:

* Must be uppercase
* Must be 8 characters in length

For versions of Rational Application Developer for WebSphere
Software later than 6.40, the password:

* Is not case sensitive

* Can be up to 40 characters in length.

This section lists other properties that affect this property or
the properties that are affected by this property and describes
the nature of the conditional relationship.

Example

Provides sample property values, for example:

"If Language is set to JA (Japanese), code page number is set
to 8000".

Globalized

If a property is globalized, it has national language support,
meaning that you can set the value in your national language.

Valid values are Yes and No.

Bidi supported

Indicates whether the property is supported in bidirectional
(bidi) processing. Bidirectional processing refers to the task of
processing data that contains both right-to-left (Hebrew or
Arabic, for example) and left-to-right (a URL or file path, for
example) semantic content within the same file.

Valid values are Yes and No.

Connection properties for the external service wizard

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

The following table lists the connection properties for the external service wizard.
These properties can only be configured using the external service wizard and
cannot be changed after deployment. A more detailed description of each property
is provided in the sections that follow the table. For information about how to read
the property details tables in the following sections, see |Guide to information|

labout properties|

Table 48. Connection properties for the external service wizard

In the wizard

Description

|Adapter style]

Service type associated with the module.
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Table 48. Connection properties for the external service wizard (continued)

In the wizard

Description

[Business object type location|

Absolute path for the folder on the local drive where business objects

generated by the external service wizard are stored.

[Function selector]

The name of the function selector configuration during inbound
communication.

Operation name
L

Operation defined in the external service wizard.

Adapter style

This property specifies the service type associated with the module.

Table 49. Service type details

Required Yes
Default Outbound
Property type List of values
Possible values Outbound
Inbound
Usage Specifies the service type associated with the adapter module
Globalized No
Bidi supported No

Business object type location

This property specifies the absolute path of the folder on the local drive where
business objects generated by the external service wizard are stored.

Table 50. Business object type location details

Required No

Default No default value

Property type String

Usage Specifies the absolute path of the folder on the local drive where business objects generated by
the external service wizard are stored

Globalized No

Bidi supported No

Function selector

This property specifies the name of the function selector implementation when the
service type is inbound.

Table 51. Function selector details

Required When the service type is set to inbound, this property is required.

When the service type is set to outbound, this property is not valid.
Default For inbound processing, the default is EmailFunctionSelector.

For outbound processing, this field is not editable and there is no default.
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Table 51. Function selector details (continued)

Property type String

Usage There is no equivalent property for outbound communication.
Globalized No

Bidi supported (Not available)

Operation name

This property specifies the name you give to the operation being used with this

module.

Table 52. Operation name property details

Required Yes
Default No default value
Property type String
Usage This value is user-defined and something that is meaningful to you.
Example SendEmail
SendCustomerBO
Globalized No
Bidi supported (Not available)
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Related concepts

[“Inbound processing” on page 7|

WebSphere Adapter for Email supports inbound processing of e-mail events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new e-mails that are ready for processing. When the adapter detects
an event that is ready to be processed, it converts the event data into a business
object and sends it to the consuming service.

[“Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related tasks

[“Setting deployment and runtime properties for inbound processing” on page 100
Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

“Setting deployment and runtime properties for simple e-mail data type” on page
5]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for generic e-mail data type” on page]
63

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for user-defined data type” on pagd
1]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

[“Configuring the module using the simple e-mail data type” on page 53

To configure a module for outbound processing using the simple e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services and generate business object definitions and related artifacts.

[“Configuring the module using the generic e-mail data type” on page 62|

To configure a module for outbound processing using the generic e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

[“Configuring the module using the user-defined data type” on page 80|
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To configure a module for outbound processing using the user-defined data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

Managed connection factory properties
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

The following table lists and describes the managed connection factory properties
for outbound communication. You set managed connection factory properties using
the external service wizard and can change them using the IBM Integration
Designer Assembly Editor before deployment. After deployment, you can change
these values using the IBM Business Process Manager or WebSphere Enterprise
Service Bus administrative console.

A more detailed description of each property is provided in the sections that
follow the table. For information about how to read the property details tables in
the sections that follow, see |Guide to information about properties,

Note: The external service wizard refers to these properties as managed connection
factory properties, and the IBM Business Process Manager or WebSphere Enterprise
Service Bus administrative console refers to them as (J2C) connection factory

properties.

Table 53. Managed connection factory properties

In the wizard

In the administrative
console

Description

[Adapter ID|

AdapterID

Identifies the adapter instance for PMI events
and for logging and tracing.

“Alternate e-mail ID in|

alternateEmailldInCaseOf

Specifies the alternate e-mail address for

case of delivery failure”| |DeliveryFailures receiving bounced mails.
on page 179|
[Bidi format string] BIDIContextEIS The bidi format for string type business data

exchanged between the mail server and the
adapter.

“Retry interval if|
connection fails (in|
milliseconds) entities” on|

[page 178|

connectionRetryInterval

Specifies the time interval between the attempts
to reconnect to the mail server if the connection
fails.

Disguise user data as|
"XXX" in log and trace]
fileg

HideConfidentialTrace

Specifies whether to disguise potentially sensitive
information by writing X strings instead of user
data in the log and trace files.

[Host name] HostName The IP address of the host where the mail server
is running.

“Maximum retries on| ConnectionRetryLimit Specifies the maximum number of times the

connection failure| adapter tries to reestablish an outbound

(connectionRetryLimit)” connection to the EIS.

[on page 179

[Password| Password The password for the user name associated with

the mail server.

175

Email



Table 53. Managed connection factory properties (continued)

In the administrative

In the wizard console Description
Port The SMTP port where the mail server is
listening.
Protocol The protocol used for outbound communication
with the mail server.
|Response set timeout| Responsetimeout The specified time period for which the adapter
waits to receive a response from the mail server.
[Secure connection| enableSSL Specifies whether secure socket layers are
enabled for outbound communication.
Select when antivirus oy | closeConnection Specifies whether the adapter closes the
firewall software ig| managed connection with the mail server
running| after each request.
This property is recommended when
antivirus or firewall security software
is running on the system where the
adapter is deployed or the one that
hosts the mail server.
UserName The user name for the mail server used to send

outbound e-mails.

Adapter ID (AdapteriD)

This property identifies a specific deployment or instance of the adapter.

Table 54. Adapter ID details

Required Yes

Default 001

Property type

String
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Table 54. Adapter ID details (continued)

Usage

This property identifies the adapter instance in the log and trace files,
and also helps identify the adapter instance while monitoring adapters.
The adapter ID is used with an adapter-specific identifier, EMARA, to
form the component name used by the Log and Trace Analyzer tool.
For example, if the adapter ID property is set to 001, the component ID
is EMARAQOL.

If you run multiple instances of the same adapter, ensure that the first
eight characters of the adapter ID property are unique for each instance
so that you can correlate the log and trace information to a particular
adapter instance. By making the first seven characters of an adapter ID
property unique, the component ID for multiple instances of that
adapter is also unique, allowing you to correlate the log and trace
information to a particular instance of an adapter.

For example, when you set the adapter ID property of two instances of
WebSphere Adapter for Email to 001 and 002. The component IDs for
those instances, EMARAGO1 and EMARAGO2, are short enough to remain
unique, enabling you to distinguish them as separate adapter instances.
However, instances with longer adapter ID properties cannot be
distinguished from each other. If you set the adapter ID properties of
two instances to Instance0l and Instance02, you will not be able to
examine the log and trace information for each adapter instance
because the component ID for both instances is truncated to
EMARAInstanc.

For inbound processing, the value of this property is set at the resource
adapter level. For outbound processing, the value can be set both at the
resource adapter level and the managed connection factory level. After
you use the external service wizard to configure the adapter for
outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM
Integration Designer assembly editor or the administrative console to
reset these properties, ensure that you set them consistently, to prevent
inconsistent marking of the log and trace entries.

Globalized

Yes

Bidi supported

No

Bidi format string (BIDIContextEIS)

This property indicates the bidi format for string type business data exchanged
between the mail server and the adapter.

Table 55. Bidi format string details

Required

No

Possible values

IBM Business Process Manager and WebSphere Enterprise Service Bus use ILYNN (implicit,
left-to-right, on, off, nominal). These five attributes comprise the format used by Windows.

Default

No default value

Property type

String
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Table 55. Bidi format string details (continued)

Usage A five-character string that identifies the bidirectional format used by the mail server.

If the mail server that sends or receives data from the server uses a different format than
ILYNN, the adapter converts the format prior to introducing the data to the server. For the
conversion to occur, you use the external service wizard to set attribute values that represent
the bidirectional format used by the mail server. This is done when you configure the module
for the first time.

Example ILYNN
VRYNN
VLYNN

Globalized No

Bidi supported No

Retry interval if connection fails (in milliseconds) entities

This property specifies the time interval between attempts to reconnect to the mail
server if the connection fails.

Table 56. Retry interval if connection fails (milliseconds) property characteristics

Required No

Possible values Integers equal to and greater than 0

Default 60000

Unit of measure Milliseconds

Property type Integer

Usage This property is applicable only if the value of the property “Maximum retries on

connection failure” is set to greater than 0.

When the adapter encounters an error while establishing a connection to the mail
server, this property specifies the time interval the adapter waits between attempts to
reestablish a connection.

Globalized No

Bidi supported No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 57. Disguise user data as "XXX" in log and trace files details

Required No
Possible values True
False
Default False
Property type Boolean

178 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



Table 57. Disguise user data as "XXX" in log and trace files details (continued)

Usage If you set this property to True, the adapter replaces user data with a

string of X's when writing to log and trace files.

For inbound processing, the value of this property is set at the resource
adapter level. For outbound processing, the value can be set both at the
resource adapter level and the managed connection factory level. After
you use the external service wizard to configure the adapter for
outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM
Integration Designer assembly editor or the administrative console to
reset these properties, ensure that you set them consistently, to prevent
inconsistent marking of the log and trace entries.

Globalized No
Bidi supported No

Alternate e-mail ID in case of delivery failure

This property is used to specify an alternate e-mail address to send a bounced
e-mail notification, in case of delivery failure due to an incorrect To address in an
e-mail message.

Table 58. Alternate e-mail ID property details

Required No

Default No default value

Property type String

Usage When an incorrect To address is specified in the e-mail, a bounced e-mail notification is sent to
the alternate e-mail address specified in the managed factory connection properties. This
configuration ensures a backup address to receive notifications for mail delivery failures.
Note: The alternate e-mail address can be different from the From address.

Globalized No

Bidi supported

No

Host name (HostName)

This property specifies the IP address of the host where the mail server is running.

Table 59. Host name details

Required No
Default Tocalhost
Property type String

Usage Specifies the IP address of the host where the mail server is running
Globalized No
Bidi supported No

Maximum retries on connection failure (connectionRetryLimit)
This property specifies the number of times the adapter will attempt to reestablish

a connection to the EIS, when the adapter encounters an error related to the
outbound connection.
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Table 60. Maximum retries in case of system connection failure details

Required No

Possible values Integer equal to and greater than zero

Default 0

Property type Integer

Usage When the adapter encounters an error related to the outbound

connection, it attempts to reestablish a physical connection
(when physical connection is not established) for the number
of times specified for this property with a time delay specified
in the property [‘Retry interval if connection fails (in|
[milliseconds) entities” on page 178

If the value is set to 0, the adapter does not validate the
connection to the EIS and it executes the outbound operation.
If the EIS connection is invalid, the outbound operation fails.
The adapter does not attempt to reconnect to the EIS.

If the value is set to greater than 0, then during each request
the adapter validates if the connection to the EIS is active.

e If the connection is valid, the operation is completed.

* If connection is invalid, the adapter terminates the current
managed connection and a new managed connection is
created (new physical connection). If the adapter is
successful in reestablishing the connection to the EIS, the
outbound operation is completed otherwise the adapter
generates the ResourceException after trying to reconnect
for the specified number of times.

Globalized No

Bidi supported No

Password (Password)

This property specifies the password for the user name associated with the mail
server.

Table 61. Password details

Required

No

Default

No default value

Property type

String

Usage

Authenticates the outbound SMTP session with the mail server. IBM Business Process Manager
or WebSphere Enterprise Service Bus administrative console does not encrypt the Password
property the first time.

Globalized

No

Bidi supported

Yes

Port (Port)

This property specifies the SMTP port where the mail server is listening.

Table 62. Port details

Required

No
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Table 62. Port details (continued)

Default

25

Property type

Integer

Usage

If the Secure connection (SSL) property is set to True, this property must be updated.

Globalized

No

Bidi supported

No

Protocol (Protocol)

This property specifies the protocol to be used for outbound communication with
the mail server.

Table 63. Protocol details

Required No
Default SMTP
Property type String

Usage SMTP is the only supported value for this property.
Globalized Yes
Bidi supported No

Response set timeout (ResponseSetTimeout)

This property specifies the length of time the adapter waits for receiving a
response from the mail server.

Table 64. Response set timeout details

Required No

Possible values Any positive integer

Default 0

Unit of measure Milliseconds

Property type Integer

Usage You can configure the outbound response time for number of specified milliseconds that the
adapter waits for a response from the mail server. After the specified time period, the adapter
stops waiting for a response from the mail server.
Note: If the value is 0, the adapter continues to wait until it gets a response from the mail
server.

Example A value of 5 specifies that the adapter waits for 5 milliseconds to get a response from the mail
server.

Globalized No

Bidi supported No

Secure connection (SSL) (enableSSL)

This property specifies whether secure socket layers are enabled for outbound
communication.

Table 65. Enable secure socket layers details

Required

No
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Table 65. Enable secure socket layers details (continued)

Default False

Property type Boolean

Usage If set to True, the port property must be set to 465.
Globalized No

Bidi supported No

Select when antivirus or firewall software is running
(SecureConnection)

Selecting this option closes the managed connection with the mail server after each
outbound request. It is recommended to use this property when antivirus or
firewall security software is running on the system where the adapter is deployed
or the system that hosts the mail server.

Table 66. Select when antivirus or firewall software is running details

Required No
Default True
Property type Boolean
Possible values True
False
Usage This property has been provided because some antivirus programs consider the managed

connection between the adapter and the mail server malicious. This results in the mail sent by
the adapter to the mail server being blocked by an antivirus program or firewall.

If set to True, the adapter closes the managed connection after each outbound request, ensuring
that antivirus and firewall software do not block e-mails from the adapter.

If set to False, the adapter does not close the managed connection after each outbound request.
This setting might cause antivirus and firewall software to block e-mails from the adapter.

Globalized No

Bidi supported No

User name (UserName)

This property specifies the user name for the mail server to be used with the
outbound SMTP session.

Table 67. User name details

Required No

Default No default value

Property type String

Usage The mail server must be running on the host noted in this property.
Globalized Yes

Bidi supported Yes
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Related concepts

[‘Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

[“WebSphere Application Server environment variables” on page 15|

WebSphere Application Server environment variables can be used in the external
service wizard to specify directory values. You can now change any string property
values in inbound and outbound configuration by only changing the environment
variables.

[“Required folders for inbound processing” on page 21]
Several folders are required for activities such as archiving and storage before you
run the adapter for inbound processing.

Related tasks

“Setting deployment and runtime properties for simple e-mail data type” on pagel
5]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for generic e-mail data type” on page]
63

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for user-defined data type” on pagd
1]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

[‘Configuring the module using the simple e-mail data type” on page 53

To configure a module for outbound processing using the simple e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services and generate business object definitions and related artifacts.

[“Configuring the module using the generic e-mail data type” on page 62|

To configure a module for outbound processing using the generic e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

[“Configuring the module using the user-defined data type” on page 80|

To configure a module for outbound processing using the user-defined data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.
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[‘Defining WebSphere Application Server environment variables” on page 44|
Use the administrative console of IBM Business Process Manager or WebSphere
Enterprise Service Bus to define WebSphere Application Server environment
variables.

“Setting deployment and runtime properties for simple e-mail data type” on pagel
5]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for generic e-mail data type” on page
63)
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for user-defined data type” on paged
1]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

Resource adapter properties

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

The following table lists and describes the resource adapter properties. A more
detailed description of each property is provided in property details tables that
follow the table. For information about how to read the property details tables in
the sections that follow, see [Guide to information about propertied

Table 68. Resource adapter properties

In the administrative

In the wizard console Description

AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.

Disguise user data as "XXX'| | HideConfidentialTrace Specifies whether to disguise potentially sensitive

in log and trace fileg

information by writing X strings instead of user data in
the log and trace files.

(Not available)

[Enable HA support| Do not change this property.
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Adapter ID (AdapteriD)

This property identifies a specific deployment or instance of the adapter.

Table 69. Adapter ID details

Required

Yes

Default

001

Property type

String

Usage

This property identifies the adapter instance in the log and trace files,
and also helps identify the adapter instance while monitoring adapters.
The adapter ID is used with an adapter-specific identifier, EMARA, to
form the component name used by the Log and Trace Analyzer tool.
For example, if the adapter ID property is set to 001, the component ID
is EMARAQO1.

If you run multiple instances of the same adapter, ensure that the first
eight characters of the adapter ID property are unique for each instance
so that you can correlate the log and trace information to a particular
adapter instance. By making the first seven characters of an adapter ID
property unique, the component ID for multiple instances of that
adapter is also unique, allowing you to correlate the log and trace
information to a particular instance of an adapter.

For example, when you set the adapter ID property of two instances of
WebSphere Adapter for Email to 001 and 002. The component IDs for
those instances, EMARAOOL and EMARAGO2, are short enough to remain
unique, enabling you to distinguish them as separate adapter instances.
However, instances with longer adapter ID properties cannot be
distinguished from each other. If you set the adapter ID properties of
two instances to Instance0l and Instance02, you will not be able to
examine the log and trace information for each adapter instance
because the component ID for both instances is truncated to
EMARAInstanc.

For inbound processing, the value of this property is set at the resource
adapter level. For outbound processing, the value can be set both at the
resource adapter level and the managed connection factory level. After
you use the external service wizard to configure the adapter for
outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM
Integration Designer assembly editor or the administrative console to
reset these properties, ensure that you set them consistently, to prevent
inconsistent marking of the log and trace entries.

Globalized

Yes

Bidi supported

No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 70. Disguise user data as "XXX" in log and trace files details

Required No
Possible values True
False
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Table 70. Disguise user data as "XXX" in log and trace files details (continued)

Default

False

Property type

Boolean

Usage

If you set this property to True, the adapter replaces user data with a
string of X's when writing to log and trace files.

For inbound processing, the value of this property is set at the resource
adapter level. For outbound processing, the value can be set both at the
resource adapter level and the managed connection factory level. After
you use the external service wizard to configure the adapter for
outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM
Integration Designer assembly editor or the administrative console to
reset these properties, ensure that you set them consistently, to prevent
inconsistent marking of the log and trace entries.

Globalized

No

Bidi supported

No

Enable high availability support (enableHASupport)

Do not change this property. It must be set to true.
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Related concepts

[“Inbound processing” on page 7|

WebSphere Adapter for Email supports inbound processing of e-mail events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new e-mails that are ready for processing. When the adapter detects
an event that is ready to be processed, it converts the event data into a business
object and sends it to the consuming service.

[“Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

Related tasks

[“Setting deployment and runtime properties for inbound processing” on page 100
Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

“Setting deployment and runtime properties for simple e-mail data type” on page|
5]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for generic e-mail data type” on page]
63

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for user-defined data type” on pagd
1]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

[“Configuring the module using the simple e-mail data type” on page 53

To configure a module for outbound processing using the simple e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services and generate business object definitions and related artifacts.

[“Configuring the module using the generic e-mail data type” on page 62|

To configure a module for outbound processing using the generic e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

[“Configuring the module using the user-defined data type” on page 80|
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To configure a module for outbound processing using the user-defined data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

Interaction specification properties

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

The following table lists the Interaction specification properties. A complete
description of each property is provided in the sections that follow the table.

Table 71. Interaction specification properties

In the wizard

Description

[Blind carbon copy] Specifies blind carbon copy addresses for the e-mail.

Specifies e-mail addresses of secondary recipients of the e-mail.

The date set by the mail server of the sender during inbound processing.
The date the e-mail is created during outbound processing.

Encoding] The type of character encoding to use

From Specifies the address that the e-mail was sent from.

Password Specifies the password for the user name associated with the mail server.

Specifies the addresses where responses to the e-mail are to be sent.

ubjec

Contains a summary of what the e-mail is about.

Contains the addresses for the primary recipients of the e-mail.

[93)
EI?‘D’
2.
el I N
@)

[User name

Specifies the user name for the mail server to be used for the outbound
SMTP session.

Blind carbon copy (Bcc)

This property specifies blind carbon copy addresses for the e-mail. The addresses
listed in this field are not included in copies of the message sent to the primary
and secondary recipients.

Table 72. Blind carbon copy details

Required

No

Default

No default value

Property type

String

Usage This header is only supported for outbound communication.
Some systems choose to include the text of the Bcc field only in the copy of the author,
while some systems include these addresses to all those recipients listed in the Bec field.
Globalized Yes

Bidi supported

Yes
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Carbon copy (Cc)

This property specifies the e-mail addresses of secondary recipients of the e-mail.

Table 73. Carbon copy details

Required

No

Default

No default value

Property type

String

Usage Specifies e-mail addresses of secondary recipients of the e-mail. All recipients listed in this field
are visible to anyone receiving the e-mail.
Globalized Yes
Bidi supported Yes
Date

The date set by the mail server of the sender during inbound processing. The date
the e-mail is created during outbound processing.

Table 74. Date details

Required

No

Default

No default value

Property type

String

Usage The date set by the mail server of the sender during inbound processing. The date the e-mail is
created during outbound processing.
Globalized Yes
Bidi supported Yes
Encoding

This attribute is set during outbound communications to indicate the type of
character encoding the adapter will use.

Table 75. Encoding details

Required

No

Default

No default value

Attribute type

String

Usage Encoding is used for headers, mail content, and attachment business objects.
Example ASCII for character encoding based on the English alphabet
Bigb for character encoding based on traditional Chinese characters
GB18030 for globalized characters in a business graph
Globalized No
Bidi supported No

Email 189



From

This property specifies the address that the e-mail was sent from.

Table 76. From details

Required

Yes

Default

No default value

Property type

String

Usage Specifies the address that the e-mail was sent from.
Globalized Yes
Bidi supported Yes

Password (Password)

This property specifies the password for the user name associated with the mail
server.

Table 77. Password details

Required Yes
Default No default value
Property type String
Usage Authenticates the inbound POP3 or IMAP session with the mail server.
Globalized Yes
Bidi supported Yes
Reply to

This property specifies the addresses where responses to the e-mail are to be sent.

Table 78. Reply to details

Required No
Default No default value
Property type String
Usage Specifies the addresses where responses to the e-mail are to be sent.
Bidi supported No
Subject

This property contains a summary of what the e-mail is about.

Table 79. Subject details

Required No

Default No default value

Property type String

Usage Contains a summary of what the e-mail is about.
Globalized Yes

Bidi supported Yes
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Table 80. To details

To

This field contains the addresses for the primary recipients of the e-mail.

Required No

Default No default value

Property type String

Usage Contains the addresses for the primary recipients of the e-mail.
Globalized Yes

Bidi supported Yes

User name (UserName)

This property specifies the user name for the mail server to be used for the
outbound SMTP session.

Table 81. User name details

Required

Yes

Default

No default value

Property type

String

Usage This property specifies the user name for the mail server to be used for the outbound SMTP
session.

Globalized Yes

Bidi supported Yes
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Related concepts

[‘Outbound processing” on page 3|

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an e-mail message. The adapter then sends the
e-mail message to a mail server.

[“Outbound data transformation” on page 5
During outbound communication, the adapter transforms business objects into
multipart MIME e-mail messages.

[“Business object structures” on page 150)|

The adapter supports three different types of business object structures: simple
alert e-mail, Email business object, and a user-defined type business object. The
simple alert e-mail structure sends text-only messages without attachments, the
Email business object sends and receives all types of messages both for
transformed and non-transformed types, and the user-defined type sends and
receives your own fixed structure transformed type messages only.

Related tasks
“Setting deployment and runtime properties for simple e-mail data type” on page|

5]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for generic e-mail data type” on page]
63

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

“Setting deployment and runtime properties for user-defined data type” on pagd
51]
To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

[“Configuring the module using the simple e-mail data type” on page 53

To configure a module for outbound processing using the simple e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services and generate business object definitions and related artifacts.

[“Configuring the module using the generic e-mail data type” on page 62|

To configure a module for outbound processing using the generic e-mail data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

[“Configuring the module using the user-defined data type” on page 80|
To configure a module for outbound processing using the user-defined data type,
use the external service wizard in IBM Integration Designer to build business
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services, specify data transformation processing, and generate business object
definitions and related artifacts.

[‘Setting interaction specification properties and generating the service” on page 60|
Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level
business object.

[“Setting deployment properties and generating the service” on page 117
The export file is generated when the adapter creates artifacts for the module and
contains the operation for the top-level business object.

“Changing interaction specification properties using the assembly editor” on page|
119

To change interaction specification properties for your adapter module after
generating the service, use the assembly editor in IBM Integration Designer.

Inbound configuration properties

WebSphere Adapter for Email has several categories of inbound connection
configuration properties, which you set with the external service wizard while
generating or creating objects and services. You can change the resource adapter
and activation specification properties after you deploy the module using IBM
Integration Designer or the administrative console, but connection properties for
the external service wizard cannot be changed after deployment.

Related concepts

[“Inbound processing” on page 7|

WebSphere Adapter for Email supports inbound processing of e-mail events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new e-mails that are ready for processing. When the adapter detects
an event that is ready to be processed, it converts the event data into a business
object and sends it to the consuming service.

Related tasks

[“Setting deployment and runtime properties for inbound processing” on page 100)
Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

Guide to information about properties

The properties used to configure WebSphere Adapter for Email are described in
detail in tables included in each of the configuration properties topics, such as
Resource adapter properties, Managed connection factory properties, and so on. To
help you use these tables, information about each row you might see is explained
here.

The following table explains the meaning of each row that might be displayed in
the table for a configuration property.
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Row

Explanation

Required

A required field (property) must have a value in order for the
adapter to work. Sometimes the external service wizard
provides a default value for required properties.

Removing a default value from a required field on the external
service wizard will not change that default value. When a
required field contains no value at all, the external service
wizard processes the field using its assigned default value,
and that default value is displayed on the administrative
console.

Possible values are Yes and No.

Sometimes a property is required only when another property
has a specific value. When this is the case, the table will note
this dependency. For example,

* Yes, when the EventQueryType property is set to Dynamic
* Yes, for Oracle databases

Possible values

Lists and describes the possible values that you can select for
the property.

Default

The predefined value that is set by the external service wizard.
When the property is required, you must either accept the
default value or specify one yourself. If a property has no
default value, the table will state No default value.

The word None is an acceptable default value, and does not
mean that there is no default value.

Unit of measure

Specifies how the property is measured, for example in
kilobytes or seconds.

Property type

Describes the property type. Valid property types include:
* Boolean

e String

* Integer

Usage

Describes usage conditions or restrictions that might apply to
the property. For instance, here is how a restriction would be
documented:

For Rational Application Developer for WebSphere Software
version 6.40 or earlier, the password:

* Must be uppercase
* Must be 8 characters in length

For versions of Rational Application Developer for WebSphere
Software later than 6.40, the password:

* Is not case sensitive

* Can be up to 40 characters in length.

This section lists other properties that affect this property or
the properties that are affected by this property and describes
the nature of the conditional relationship.

Example

Provides sample property values, for example:

"If Language is set to JA (Japanese), code page number is set
to 8000".
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Row Explanation

Globalized If a property is globalized, it has national language support,
meaning that you can set the value in your national language.

Valid values are Yes and No.

Bidi supported Indicates whether the property is supported in bidirectional
(bidi) processing. Bidirectional processing refers to the task of
processing data that contains both right-to-left (Hebrew or
Arabic, for example) and left-to-right (a URL or file path, for
example) semantic content within the same file.

Valid values are Yes and No.

Connection properties for the external service wizard

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

The following table lists the connection properties for the external service wizard.
These properties can only be configured using the external service wizard and
cannot be changed after deployment. A more detailed description of each property
is provided in the sections that follow the table. For information about how to read
the property details tables in the following sections, see [Guide to information|
labout properties|

Table 82. Connection properties for the external service wizard

In the wizard Description

[Adapter style| Service type associated with the module.

[Business object type location| Absolute path for the folder on the local drive where business objects
generated by the external service wizard are stored.

[Function selector] The name of the function selector configuration during inbound
communication.

I|O}2era’cior1 name| Operation defined in the external service wizard.

Adapter style

This property specifies the service type associated with the module.

Table 83. Service type details

Required Yes
Default Outbound
Property type List of values
Possible values Outbound
Inbound
Usage Specifies the service type associated with the adapter module
Globalized No
Bidi supported No
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Business object type location

This property specifies the absolute path of the folder on the local drive where
business objects generated by the external service wizard are stored.

Table 84. Business object type location details

Required

No

Default

No default value

Property type

String

Usage Specifies the absolute path of the folder on the local drive where business objects generated by
the external service wizard are stored

Globalized No

Bidi supported No

Function selector

This property specifies the name of the function selector implementation when the
service type is inbound.

Table 85. Function selector details

Required When the service type is set to inbound, this property is required.
When the service type is set to outbound, this property is not valid.
Default For inbound processing, the default is EmailFunctionSelector.

For outbound processing, this field is not editable and there is no default.

Property type

String

Usage

There is no equivalent property for outbound communication.

Globalized

No

Bidi supported

(Not available)

Operation name

This property specifies the name you give to the operation being used with this
module.

Table 86. Operation name property details

Required Yes
Default No default value
Property type String
Usage This value is user-defined and something that is meaningful to you.
Example SendEmail
SendCustomerBO
Globalized No

Bidi supported

(Not available)

Activation specification properties
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.
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The following table lists the activation specification properties for inbound
communication. You set the activation specification properties using the external
service wizard and can change them before deployment using the IBM Integration
Designer Assembly Editor. After deployment, you can change these values using
the IBM Business Process Manager or WebSphere Enterprise Service Bus
administrative console.

A more detailed description of each property is provided in the sections that
follow the table. For information about how to read the property detail tables in
the sections that follow, see [Guide to information about properties.

Table 87. Activation specification properties

In the wizard

In the administrative
console

Description

[Archive file naming pattern|

ArchiveFileNamingPattern

A comma delimited pattern of header names used to
name archived files being stored in the archive folder.

[Archive folder]

ArchiveFolder

The file folder on the local system where successfully
processed e-mails are archived as files.

|Automatically create even
ltable]

EP_CreateTable

Specified whether the adapter should create a database
table for the event store if one does not exist

[Bidi format string|

BIDIContextEIS

Indicates the bidi format for string type business data
exchanged between the mail server and the adapter

[Database schema namé]

EP_SchemaName

The schema name for the database used by the
adapter's event persistence feature

delivery|

[Delivery type DeliveryType Determines the order in which events are delivered by
the adapter to the export.

Emit individual business| EmitIndividualBOs Specifies whether the adapter creates individual

objects from a multipart| business objects for each part of a multipart e-mail.

e-maill

[Enable transport security| enableSSL Specifies whether a Secure Sockets Layer (SSL)

[(SSL)| connection is enabled.

Ensure once-only event| AssuredOnceDelivery Specifies whether the adapter provides assured once

delivery of events.

|Event recovery data sourcel
|[JNDI) name|

EP_DataSource_JNDIName

The JNDI name of the data source used by the event
persistence class to acquire the JDBC database
connection

[Event recovery table name]

EP_TableName

The name of the event store used by the adapter

[Retry limit for failed events

FailedEventRetryLimit

The number of times the adapter attempts to redeliver
an event before marking the event as failed.

|period§

[Failed events folder| FailedEventsFolder The absolute path to the file folder on the local system
where unsuccessfully processed e-mail events are
archived in file format.

[Host nam¢] HostName The IP address of the host where the mail server is
running.

[Interval between polling PollPeriod The length of time that the adapter waits between

polling periods.

[Match all search criteria|

MatchAllSearchCriteria

The search criteria to filter which events are polled
from the mail server.

[Match some search criterial

MatchSomeSearchCriteria

The search criteria to filter which events are polled
from the mail server.
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Table 87. Activation specification properties (continued)

In the administrative

In the wizard console Description

[Maximum events in polling| | PollQuantity The number of events the adapter delivers to the

[period| export during each poll period.

[Maximum connections| MaximumConnections The maximum number of connections that the adapter
can use for inbound event delivery.

[Minimum connections| MinimumConnections The minimum number of connections that the adapter
can use for inbound event delivery.

Maximum number of retries| | RetryLimit The number of times the adapter tries to reestablish an

in case of system connection| inbound connection after an error.

failure|

[Password]| Password The password associated with the mail server user

name.

Password used to connect to|
event data sourcd

EP_Password

The password used by the adapter's event persistence
feature. It is used to acquire the JDBC database
connection from the data source configured in the
server.

Poll folder

Poll folder

The name of the mail folder or mail folders the
adapter polls for inbound requests (e-mails).

Port The POP3 or IMAP port where the mail server is
listening.
Protocol The protocol adapter uses for inbound communication

with the mail server.

Retry EIS connection on|
startu

|

RetryConnectionOnStartup

Controls whether the adapter retries the connection to
the mail server if it cannot connect at startup.

Time between retries in case| |RetryInterval The length of time that the adapter waits between

of system connection failure] attempts to reestablish connection after an error during

(milliseconds)| inbound operations.

[Staging directory] InProgressFolder The folder on the file system where e-mails polled
from the mail server are first written in file format.

[Stop polling on erroy| StopPollingOnError Specifies whether the adapter stops polling for events

when it encounters an error during polling.

(Not available)

“UseFiveLevelBO” on page|
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Specifies whether business graphs and wrappers are
generated for child business objects of the Email
parent business object.

[User name

UserName

The user name for the mail server.

[User name used to connect]
[to event data source|

EP_UserName

The user name used by the adapter's assured-once
delivery feature.

Archive file naming pattern (ArchiveFile)

This property is used to specify a comma delimited pattern of header names used
to name archived files being stored in the archive folder.

Table 88. Archive file naming pattern details

Required No

Default The message-ID of the e-mail event. This information is retrieved from the e-mail header.
Property type String

Usage This property is to be used with the[“Archive folder (ArchiveFolder)” on page 199 property.
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Table 88. Archive file naming pattern details (continued)

Example If the header values From, Date are specified, the adapter picks the From address and Date
from the e-mail headers and combines them with the message ID to form the file name (From
name + Date + Message ID).

Globalized Yes

Bidi supported No

Archive folder (ArchiveFolder)

This property specifies the file folder on the local system where successfully
processed e-mails are archived in RFC822 file format.

Table 89. Archive folder details

Required No

Default No default value

Property type String

Usage This folder must be manually created on the same system as the adapter before the adapter is
run. If no archive folder is specified, the adapter does not archive successfully e-mails. They are
deleted from the In progress folder.
You can use a WebSphere Application Server environment variable to represent the archive
folder. Specify the name of the environment variable in braces, preceded by a $ symbol. For
example: ${ARCHIVE_FOLDER}. See the topic on creating an environment variable in this
documentation.

Globalized Yes

Bidi supported Yes

Automatically create event table property (EP_CreateTable)

This property specifies whether the adapter should create an event store if it
detects one does not exist.

Table 90. Automatically create event table details

Required No
Possible values True
False
Default True
Property type Boolean
Usage If set to True, the adapter will create an event store if it detects that one does not exist.
If set to False, the adapter will not create an event store even if one does not already exist.
Make sure that an event store exists if you want to ensure the delivery of events.
Globalized No

Bidi supported

No

Bidi format string (BIDIContextEIS)

This property indicates the bidi format for string type business data exchanged
between the mail server and the adapter.
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Table 91. Bidi format string details

Required

No

Possible values

IBM Business Process Manager and WebSphere Enterprise Service Bus use ILYNN (implicit,
left-to-right, on, off, nominal). These five attributes comprise the format used by Windows.

Default No default value

Property type String

Usage A five-character string that identifies the bidirectional format used by the mail server.
If the mail server that sends or receives data from the server uses a different format than
ILYNN, the adapter converts the format prior to introducing the data to the server. For the
conversion to occur, you use the external service wizard to set attribute values that represent
the bidirectional format used by the mail server. This is done when you configure the module
for the first time.

Example ILYNN
VRYNN
VLYNN

Globalized No

Bidi supported No

Database schema name (EP_SchemaName)

This property specifies the schema name for the database used by the adapter's
assured-once delivery feature.

Table 92. Database schema name details

Required

No

Default

No default value

Property type

String

Usage

Specifies the schema name for the database used by the adapter's assured-once delivery feature.
This value is not case-sensitive.

Globalized

Yes

Bidi supported

Yes

Delivery type (DeliveryType)

This property specifies the order in which events are delivered by the adapter to
the export.

Table 93. Delivery type details

Required No
Possible values ORDERED
UNORDERED
Default ORDERED
Property type String
Usage The following values are supported:
* ORDERED: The adapter delivers events to the export one at a
time.
* UNORDERED: The adapter delivers all events to the export at
once.
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Table 93. Delivery type details (continued)
Globalized No
Bidi supported No

Emit individual business objects from a multipart e-mail
(EmitindividualBOs)

This property specifies whether the adapter creates individual business objects for
each part of a multipart e-mail.

Table 94. Emit individual business objects from a multipart e-mail details

Required No

Default False

Property type Boolean

Usage The split for individual business object is completed by the adapter and each of the business
objects is emitted as generic Email (emitEmail). Each part of a multipart e-mail is considered an
individual business object and emitted using the Email wrapper object, where content of each
part is set in the mail content attribute.

Globalized (Not available)

Bidi supported No

Enable transport security (SecureConnectionProperty)

This property specifies if the Secure Sockets Layer (SSL) connection is enabled for
the POP3 or IMAP protocol chosen in the Protocol property.

Table 95. Enable transport security details

Required No

Default False

Property type Boolean

Usage If set to True, the port value needs to be set to one of the following values:
For the POP3 protocol, 995
For the IMAP protocol, 993

Globalized No

Bidi supported No

Ensure once-only event delivery (AssuredOnceDelivery)

This property specifies whether to provide ensure once-only event delivery for
inbound events.

Table 96. Ensure once-only event delivery details

Required Yes
Possible values True
False
Default True
Property type Boolean
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Table 96. Ensure once-only event delivery details (continued)

When this property is set to True, the adapter provides
assured once event delivery. This means that each event will
be delivered once and only once. A value of False does not
provide assured once event delivery, but provides better
performance.

Usage

When this property is set to True, the adapter attempts to
store transaction (XID) information in the event store. If it is
set to False, the adapter does not attempt to store the
information.

This property is used only if the export component is
transactional. If it is not, no transaction can be used, regardless
of the value of this property.

Globalized No

Bidi supported No

Event recovery data source (JNDI) name property
(EP_DataSource_JNDIName)

This property specifies the JNDI name of the data source that will be used by the
event persistence class to acquire the JDBC database connection.

Table 97. Event recovery data source (JNDI) name details

Required

Yes, if the AssuredOnceDelivery property is set to true

Default

No default value

Property type

String

Usage

This value is case-sensitive.

The external service wizard does not create the data source on IBM Business Process Manager
or WebSphere Enterprise Service Bus. Make sure that the data source is defined on the server
before deploying the adapter.

Globalized

Yes

Bidi supported

Yes

Event recovery table name property (EP_TableName)

This property specifies the name of the event store that will be used by the adapter
for event persistence.

Table 98. Event recovery table name details

Required Yes, if the AssuredOnceDelivery property is set to true

Default EmailEventTable

Property type String

Usage The value specified for this property must be unique for each adapter instance and cannot be
used by another instance. This value is not case-sensitive.

Globalized Yes

Bidi supported Yes
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Retry limit for failed events (FailedEventRetryLimit)

This property specifies the number of times that the adapter attempts to redeliver
an event before marking the event as failed.

Table 99. Retry limit for failed events details

Required No
Possible values Integers
Default 5
Property type Integer
Usage Use this property to control how many times the adapter tries
to send an event before marking it as failed. It accepts the
following values:
Default
If this property is not set, the adapter tries five
additional times before marking the event as failed.
0 The adapter tries to deliver the event an infinite
number of times. When the property is set to 0, the
event remains in the event store and the event is
never marked as failed.
>0 For integers greater than zero, the adapter retries the
specified number of times before marking the event
as failed.
<0 For negative integers, the adapter does not retry
failed events.
Globalized No
Bidi supported No

Failed events folder (FailedEventsFolder)

This property specifies the file folder on the local system where unsuccessfully
processed e-mail events are archived in file format.

Table 100. Failed events folder details

Required

No

Default

No default value

Property type

String

Usage This folder must be manually created on the same system as the adapter before the adapter is
run. If you do not specify a failed events folder, the adapter does not archive any unsuccessful
e-mail event.

You can use a WebSphere Application Server environment variable to represent the failed
events folder. Specify the name of the environment variable in braces, preceded by a § symbol.
For example: ${FAILEDEVENTS_FOLDER}. See the topic on creating an environment variable in this
documentation.

Globalized Yes

Bidi supported No
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Host name (HostName)

This property specifies the IP address of the host where the mail server is running.

Table 101. Host name details

Required No
Default Tocalhost
Property type String

Usage Specifies the IP address of the host where the mail server is running
Globalized No
Bidi supported Yes

Interval between polling periods (PollPeriod)

This property specifies the length of time that the adapter waits between polling
periods.

Table 102. Interval between polling periods details

Required Yes

Possible values Integers greater than or equal to 0.

Default 2000

Unit of measure Milliseconds

Property type Integer

Usage The poll period is established at a fixed rate, which means that

if running the poll cycle is delayed for any reason (for
example, if a prior poll cycle takes longer than expected to
complete) the next poll cycle will occur immediately to make
up for the lost time caused by the delay.

Globalized No

Bidi supported No

Match all search criteria (MatchAlICriteria)

If set, this property specifies search criteria that the adapter uses to filter which
events are polled from designated poll folders on the mail server. Events that meet
the ANDed conditions are polled.

Table 103. Match all search criteria details

Required

No

Possible values

You can use any of the following header values when specifying search criteria:

content=
subject=
to=

cc=
from=
sender=
date=

Default

No default value. It means that you have not selected any filtering options.

204 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide




Table 103. Match all search criteria details (continued)

Property type

String

Usage

Specify AND conditions by separating them with a comma (,). This limits the event search to
only mail events in the poll folder that meet the ANDed specific search criteria.

Specify NOT conditions by separating them with an exclamation mark (!). This limits the event
search to only mail events in the poll folder that do not include the search options NOTed.

If both Match all search criteria and Match some criteria properties are set, the adapter uses
the AND operation between the fields. This means that the outputs of the first set of conditions
are subjected to the second set of conditions. For example, if sender=xyz@abc.com,
to=pqr@abc.com is set for Match all search criteria property and subject=test,
from!=Tmn@abc.com is set for Match some search criteria property, the adapter searches for
events with a sender value of xyz@abc.com and a to value of pqr@abc.com that might also
have a subject value of test and which does not have a from value of Imn@abc.com.

Example

sender=xyz@abc.com, to=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and a to value of to=pqr@abc.com.

sender=xyz@abc.com,to!=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and does not have a to value of pqr@abc.com.

Globalized

No

Bidi supported

No

Match some search criteria (MatchSomecCtriteria)

If set, this property specifies the search criteria the adapter uses to filter which
events are polled from the designated poll folders on the mail server. Events that
meet the ORed conditions are polled.

Table 104. Match some search criteria details

Required

No

Possible values

You can use any of the following header values when specifying search criteria:
* content=

* subject=

* to=

* cc=

* from=

* sender=

* date=

Default

Default is blank. It means that you have not selected any filtering options.

Property type

String

Usage

Specify OR conditions by separating them with a comma (,). This limits the event search to
mail events in the poll folder that meet the ORed search criteria.

Specify NOT conditions by separating them with an exclamation mark (!). This limits the event
search to only mail events in the poll folder that do not include the search options NOTed.

If both Match all search criteria and Match some criteria properties are set, the adapter uses
the AND operation between the fields. This means that the outputs of the first set of conditions
are subjected to the second set of conditions. For example, if sender=xyz@abc.com,
to=pqr@abc.com is set for Match all search criteria property and subject=test,
from!=Tmn@abc.com is set for Match some search criteria property, the adapter searches for
events with a sender value of xyz@abc.com and a to value of pqr@abc.com that might also
have a subject value of test and which does not have a from value of Imn@abc.com.
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Table 104. Match some search criteria details (continued)

Example sender=xyz@abc.com, to=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and a to value of to=pqr@abc.com.

sender=xyz@abc.com,to!=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and does not have a to value of pqr@abc.com.

Globalized No
Bidi supported No

Maximum connections (MaximumConnections)

This property specifies the maximum number of connections that the adapter can
use for inbound event delivery.

Table 105. Maximum connections details

Required No

Default 1

Property type Integer

Usage Only positive values are valid. The adapter considers any

positive entry less than 1 to be equal to 1. Typing a negative
value for this property may result in run time errors.

Globalized No

Bidi supported No

Minimum connections (MinimumConnections)

This property specifies the minimum number of connections that the adapter can
use for inbound event delivery.

Table 106. Minimum connections details

Required No

Default 1

Property type Integer

Usage Only positive values are valid. Any value less than 1 is treated

as 1 by the adapter. Typing a negative value or 1 for this
property may result in run time errors.

Globalized No
Bidi supported No

Maximum events in polling period (PollQuantity)

This property specifies the number of events that the adapter delivers to the export
during each poll period.

Table 107. Maximum events in polling period details

Required Yes
Default 10
Property type Integer
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Table 107. Maximum events

in polling period details (continued)

Usage

The value must be greater than 0. If this value is increased,
more events are processed per polling period and the adapter
may perform less efficiently. If this value is decreased, fewer
events are processed per polling period and the adapter's
performance might improve slightly.

Globalized

No

Bidi supported

No

Number of times to retry the system connection (RetryLimit)

This property specifies the number of times the adapter tries to reestablish an

inbound connection.

Table 108. Number of times

to retry the system connection details

Required No

Possible values 0 and positive integers

Default 0

Property type Integer

Usage This property controls how many times the adapter retries the
connection if the adapter cannot connect to the mail server to
perform inbound processing. A value of 0 indicates an infinite
number of retries.
To control whether the adapter retries if it cannot connect to
the mail server when it is first started, use the
RetryConnectionOnStartup property.

Globalized No

Bidi supported No

Password (Password)

This property specifies the password for the user name associated with the mail

server.

Table 109. Password details

Required Yes

Default No default value

Property type String

Usage Authenticates the inbound POP3 or IMAP session with the mail server. IBM Business Process
Manager or WebSphere Enterprise Service Bus administrative console does not encrypt the
Password property the first time.

Globalized Yes

Bidi supported Yes

Password used to connect to event data source property

(EP_Password)

This property specifies the password used by the adapter's assured-once delivery

feature.
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Table 110. Password used to connect to event data source details

Required Yes, if the AssuredOnceDelivery property is set to true

Default No default value

Property type String

Usage Specify the password that the adapter uses to connect to the event store. This value is
case-sensitive.

Globalized Yes

Bidi supported Yes

Poll folder (PollFolder)

This property specifies the name of the mail folder or mail folders the adapter
polls for inbound requests (e-mails).

Table 111. Poll folder details

Required No for POP3 protocol
Yes for IMAP protocol

Default For the POP3 protocol, the default is Inbox
For the IMAP protocol, there is no default value.

Property type String

Usage For the POP3 protocol, the adapter cannot poll multiple mail server folders. It automatically
defaults to Inbox because Inbox is the only supported value with POP3.
If the Protocol property is set to POP3, this property defaults to Inbox. No other value for POP3
is supported.
If the Protocol property is set to IMAP, you can define one or more mail folder names. To poll
multiple mail server folders, folder names are delimited with commas.

Globalized Yes

Bidi supported No

Port (Port)

This property specifies the POP3 or IMAP port where the mail server is listening.

Table 112. Port details

Required

No

Default

110 when the protocol is set to POP3
143 when the protocol is set to IMAP

Property type

Integer

Usage If the Secure connection (SSL) property is set to True, this property must be updated.
For the POP3 protocol, it must be set to 995.
For the IMAP protocol, it must be set to 993.

Globalized No

Bidi supported No
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Protocol (Protocol)

The property specifies the protocol used for inbound communication with the mail
server.

Table 113. Protocol details

Required No

Possible values IMAP
POP3

Default POP3

Property type String

Usage If set to IMAP, the adapter uses the IMAP e-mail protocol for inbound communication.
If set to POP3, the adapter uses the POP3 e-mail protocol for inbound communication.

Globalized No

Bidi supported No

Retry EIS connection on startup (RetryConnectionOnStartup)

This property controls whether the adapter attempts to connect again to the mail
server if it cannot connect at startup.

Table 114. Retry EIS connection on startup details

Required No
Possible values True
False
Default False
Property type Boolean
Usage This property indicates whether the adapter should retry the

connection to the mail server if the connection cannot be made
when the adapter is started:

* Set the property to False when you want immediate
feedback about whether the adapter can establish a
connection to the mail server, for example, when you are
building and testing the application that receives events
from the adapter. If the adapter cannot connect, the adapter
writes log and trace information and stops. The
administrative console shows the application status as
Stopped. After you resolve the connection problem, start the
adapter manually.

* Set the property to True if you do not need immediate
feedback about the connection. If the adapter cannot connect
during startup, it writes log and trace information, and then
attempts to reconnect, using the RetryInterval property to
determine how frequently to retry and the value of the
RetryLimit property to retry multiple times until that value
is reached. The administrative console shows the application
status as Started.

Globalized No

Bidi supported No
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Retry interval if connection fails (Retryinterval)

When the adapter encounters an error related to the inbound connection, this
property specifies the length of time the adapter waits before trying to reestablish a
connection.

Table 115. Retry interval details

Required Yes

Default 2000

Unit of measure Milliseconds
Property type Integer

Usage Only positive values are valid. When the adapter encounters
an error related to the inbound connection, this property
specifies the length of time the adapter waits before trying to
establish a new connection.

Globalized No

Bidi supported No

Staging directory (InProgressFolder)

This property specifies the folder on the file system where e-mails polled from the
mail server are first written in file format.

Table 116. Staging directory details

Required

Yes

Default

No default value

Property type

String

Usage

This folder must be created on the same system where the adapter is running before the
adapter is started. Once written to the file system in file format, each file is named based on
the Message-ID of its corresponding e-mail event. These details are retrieved from the e-mail
header value.

You can use a WebSphere Application Server environment variable to represent the In progress
folder. Specify the name of the environment variable in braces, preceded by a $ symbol. For
example: ${ INPROGRESS_FOLDER}. See the topic on creating an environment variable in this
documentation.

Globalized

Yes

Bidi supported

Yes

Stop the adapter when an error is encountered while polling
(StopPollingOnError)

This property specifies whether the adapter will stop polling for events when it
encounters an error during polling.

Table 117. Stop the adapter when an error is encountered while polling details

Required No
Possible values True
False
Default False
Property type Boolean
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Table 117. Stop the adapter when an error is encountered while polling details (continued)

Usage If this property is set to True, the adapter stops polling when
it encounters an error.
If this property is set to False, the adapter logs an exception
when it encounters an error during polling and continues
polling.

Globalized No

Bidi supported No

UseFiveLevelBO

This property specifies whether business graphs and wrappers are generated for
child business objects of the Email parent business object.

Table 118. Use five level business object details

Required No

Default True

Property type Boolean

Usage This property is for compatibility with earlier versions with version 6.0.2 business objects and
does not appear in the external service wizard. In version 6.0.2, the default for this property
was True.

Globalized (Not available)

Bidi supported

No

User name (UserName)

This property specifies the user name for the mail server to be used for the
inbound POP3 or IMAP session.

Table 119. User name details

Required

Yes

Default

No default value

Property type

String

Usage

The mail server must be running on the host noted in the host property.

Globalized

Yes

Bidi supported

Yes

User name used to connect to event data source property
(EP_UserName)

This property specifies the user name used by the adapter's event assured-once
delivery feature.

Table 120. User name used to connect to event data source details

Required

Yes, if you want assured-once delivery

Default

No default value

Property type

String

Usage

Specify the user name that the adapter uses to connect to the event store.
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Table 120. User name used to connect to event data source details (continued)

Globalized

Yes

Bidi supported

Yes

Related concepts

[“Inbound processing” on page 7|

WebSphere Adapter for Email supports inbound processing of e-mail events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new e-mails that are ready for processing. When the adapter detects
an event that is ready to be processed, it converts the event data into a business
object and sends it to the consuming service.

[“WebSphere Application Server environment variables” on page 15|

WebSphere Application Server environment variables can be used in the external
service wizard to specify directory values. You can now change any string property
values in inbound and outbound configuration by only changing the environment
variables.

[‘Required folders for inbound processing” on page 21|
Several folders are required for activities such as archiving and storage before you
run the adapter for inbound processing.

Related tasks

[‘Setting deployment and runtime properties for inbound processing” on page 100
Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

[“Defining WebSphere Application Server environment variables” on page 44|
Use the administrative console of IBM Business Process Manager or WebSphere
Enterprise Service Bus to define WebSphere Application Server environment
variables.

Resource adapter properties

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the administrative console.

The following table lists and describes the resource adapter properties. A more
detailed description of each property is provided in property details tables that
follow the table. For information about how to read the property details tables in
the sections that follow, see [Guide to information about propertied.

Table 121. Resource adapter properties

In the administrative

In the wizard console Description

AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.

Disguise user data as "XXX'| | HideConfidentialTrace Specifies whether to disguise potentially sensitive

in log and trace fileg

information by writing X strings instead of user data in
the log and trace files.

(Not available)

[Enable HA support| Do not change this property.
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Adapter ID (AdapteriD)

This property identifies a specific deployment or instance of the adapter.

Table 122. Adapter ID details

Required

Yes

Default

001

Property type

String

Usage

This property identifies the adapter instance in the log and trace files,
and also helps identify the adapter instance while monitoring adapters.
The adapter ID is used with an adapter-specific identifier, EMARA, to
form the component name used by the Log and Trace Analyzer tool.
For example, if the adapter ID property is set to 001, the component ID
is EMARAQO1.

If you run multiple instances of the same adapter, ensure that the first
eight characters of the adapter ID property are unique for each instance
so that you can correlate the log and trace information to a particular
adapter instance. By making the first seven characters of an adapter ID
property unique, the component ID for multiple instances of that
adapter is also unique, allowing you to correlate the log and trace
information to a particular instance of an adapter.

For example, when you set the adapter ID property of two instances of
WebSphere Adapter for Email to 001 and 002. The component IDs for
those instances, EMARAOOL and EMARAGO2, are short enough to remain
unique, enabling you to distinguish them as separate adapter instances.
However, instances with longer adapter ID properties cannot be
distinguished from each other. If you set the adapter ID properties of
two instances to Instance0l and Instance02, you will not be able to
examine the log and trace information for each adapter instance
because the component ID for both instances is truncated to
EMARAInstanc.

For inbound processing, the value of this property is set at the resource
adapter level. For outbound processing, the value can be set both at the
resource adapter level and the managed connection factory level. After
you use the external service wizard to configure the adapter for
outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM
Integration Designer assembly editor or the administrative console to
reset these properties, ensure that you set them consistently, to prevent
inconsistent marking of the log and trace entries.

Globalized

Yes

Bidi supported

No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 123. Disguise user data as "XXX" in log and trace files details

Required No
Possible values True
False
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Table 123. Disguise user data as "XXX" in log and trace files details (continued)

Default False
Property type Boolean
Usage If you set this property to True, the adapter replaces user data with a

string of X's when writing to log and trace files.

For inbound processing, the value of this property is set at the resource
adapter level. For outbound processing, the value can be set both at the
resource adapter level and the managed connection factory level. After
you use the external service wizard to configure the adapter for
outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM
Integration Designer assembly editor or the administrative console to
reset these properties, ensure that you set them consistently, to prevent
inconsistent marking of the log and trace entries.

Globalized No

Bidi supported No

Enable high availability support (enableHASupport)

Do not change this property. It must be set to true.

Globalization

WebSphere Adapter for Email is a globalized application that can be used in
multiple linguistic and cultural environments. Based on character set support and
the locale of the host server, the adapter delivers message text in the appropriate
language. The adapter supports bidirectional script data transformation between
integration components.

Related tasks

“Setting deployment and runtime properties for simple e-mail data type” on page]
5]

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in the IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

[“Setting deployment and runtime properties for inbound processing” on page 100)
Using the external service wizard in IBM Integration Designer, select whether your
module is to be used for outbound or inbound communication with the mail
server. Then configure connection properties. Connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service using the module.

Globalization and bidirectional data transformation

The adapter is globalized to support single- and multi-byte character sets and
deliver message text in the specified language. The adapter also performs
bidirectional script data transformation, which refers to the task of processing data
that contains both right-to-left (Hebrew or Arabic, for example) and left-to-right (a
URL or file path, for example) semantic content within the same file.

214 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



Globalization

Globalized software applications are designed and developed for use within
multiple linguistic and cultural environments rather than a single environment.
WebSphere Adapters, IBM Integration Designer, IBM Business Process Manager or
WebSphere Enterprise Service Bus, and WebSphere Enterprise Service Bus are
written in Java. The Java runtime environment within the Java virtual machine
(JVM) represents data in the Unicode character code set. Unicode contains
encodings for characters in most known character code sets (both single- and
multi-byte). Therefore, when data is transferred between these integration system
components, there is no need for character conversion.

WebSphere Adapter for Email converts data in mail content and attachments to a
byte stream, which can in turn be converted to a string. During this process, the
encoding is maintained by using Unicode encoding. For example,

* XML documents are used for integration and maintain their encoding within the
document. The XML DataHandler is globalized so the data remains intact.

* The adapter converts a stream of data to bytes, which in turn is converted to a
string. During this process, the encoding is maintained by using UTF-8
encoding.

To log error and informational messages in the appropriate language and for the
appropriate country or region, the adapter uses the locale of the system on which
it is running. The adapter supports all the group 1 languages and Thai.

Bidirectional script data transformation

Languages such as Arabic and Hebrew are written from right to left, yet they
contain embedded segments of text that are written left to right, resulting in
bidirectional script. When software applications handle bidirectional script data,
standards are used to display and process it. Bidirectional script data
transformation applies only to string type data. IBM Business Process Manager or
WebSphere Enterprise Service Bus and WebSphere Enterprise Service Bus use the
Windows standard format, but applications or file systems that exchange data with
the server might use a different format. The adapter transforms bidirectional script
data passed between the two systems so that it is accurately processed and
displayed on both sides of a transaction. It transforms the script data by using a
set of properties that defines the format of script data, as well as properties that
identify content or metadata to which transformation applies.

Note: Popular wrapper business object header values such as from, to, Cc, Bcc,
reply-to, subject, and date are bidi-enabled. The name portions of e-mail addresses
are also bidi-enabled.

Bidirectional script data formats

IBM Business Process Manager or WebSphere Enterprise Service Bus and
WebSphere Enterprise Service Bus use the bidirectional format of ILYNN (implicit,
left-to-right, on, off, nominal). These five attributes comprise the format used by
Windows. If an application or file system that sends or receives data from the
server uses a different format, the adapter converts the format before introducing
the data to the server. For the conversion to occur, you use the external service
wizard to set attribute values that represent the bidirectional format used by the
sending application or file system. This configuration setting is done when you
deploy the module for the first time.
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The bidirectional format consists of five attributes. When you set bidirectional
properties, you assign values for each of these attributes. The attributes and
settings are listed in the following table.

Table 124. Bidirectional format attributes

Letter
position Purpose Values |Description Default setting

1 Order schema Implicit (Logical) I

Visual
Left-to-Right L
Right-to-Left

Contextual Left-to-Right

2 Direction

Contextual Right-to-Left

3 Symmetric
Swapping

Symmetric swapping is on Y

Symmetric swapping is off

Text is shaped N

4 Text Shaping

zlv|zl<xlog|lo|l=|o|<|~

Text is not shaped
(Nominal)

Initial shaping
Middle shaping

Final shaping

Isolated shaping
National (Hindi) N

5 Numeric Shaping

Contextual shaping

zlolz|=|[=|=z]|~

Numbers are not shaped
(Nominal)

Bidirectional properties that identify data for transformation

To identify business data that is subject to transformation, set the bidi format string
property. Do this configuration by specifying values for each of the five
bidirectional format attributes (listed in the preceding table) for the property.

To identify event persistence data subject to transformation, set the BiDiFormatEP
property. Do this configuration by specifying values for each of the five
bidirectional format attributes listed in the preceding table) for the property. The
BiDiFormatEP property can be set for the activation specification.

To identify application-specific data for transformation, annotate the BiDiContext
property within a business object. Do this configuration by using the business
object editor within IBM Integration Designer to add the properties as
application-specific elements of the business object.

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



Related reference

[“Activation specification properties” on page 196|
Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

[“Managed connection factory properties” on page 175|
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.

[“Properties enabled for bidirectional data transformation” on page 218
Bidirectional (bidi) data transformation properties control the format of
bidirectional script data exchanged between an application or file system and
integration tools and runtime environments. After these properties are set,

bidirectional script data is correctly processed and displayed in IBM Integration

Designer and IBM Business Process Manager or WebSphere Enterprise Service Bus.

Bidirectional transformation in business objects
For outbound processing, you can modify the business objects to enable the

bidirectional transformation of the headers in the WebSphere Adapter for Email

business object and the data in content-specific business objects.

You must add an annotation to the complex type of the business object to specify

the bidirectional formatting attributes in the following files:
* For the generic business object, change the Email.xsd file.

* For the user-defined business object, change the custom wrapper (for example,

the CustomWrapper.xsd file).

* For the SimpleAlertEmail business object, change the SimpleAlertEmail.xsd file.

* For all the custom data type business objects such as the WbiAddress.xsd file,

use WbiPhone.xsd.
The following sections include annotations that can serve as examples.

Bidirectional formatting attributes of the business object

The following annotation, which contains the bidirectional context information,

applies to all the headers in the Email business objects. The
EmailWrapperDataBinding uses the bidirectional information in the element
BiDiContext to transform the header values.

<complexType name="Email">
<annotation>
<appinfo
source="http://www.ibm.com/xmlns/prod/websphere/j2ca/
datatransformation/databindingmapping">
<dtm:DataBindingMapping
xsi:type="dtm:DataBindingMapping"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:dtm="http://www.ibm.com/xmIns/prod/websphere/j2ca/
datatransformation/databindingmapping">
<BiDiContext>
<orientation>rtl</orientation>
<textShape>nominal</textShape>
<orderingScheme>visual</orderingScheme>
<symmetricSwapping>true</symmetricSwapping>
<numeralShapes>nominal</numeralShapes>
</BiDiContext>
</dtm:DataBindingMapping>
</appinfo>
</annotation>
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Bidirectional formatting attributes of the wrapper

You can add an annotation to the wrapper business object that is the user-defined
type. The annotation in the wrapper business objects such as the generic (Email)
and the user-defined type (CustomerWrapper) is used to do bidirectional
transformation of wrapper attributes (header values). The content-specific business
objects that are used inside the wrapper business objects are not transformed using
annotation in the wrapper business objects. To transform content-specific business
objects, you must edit the respective business object definition to add the
annotation shown in the previous example for bidirectional formatting attributes of
the business object.

The following annotation is an example for the wrapper:

<complexType name="Customer">
<annotation>
<appinfo
source="http://www.ibm.com/xmins/prod/websphere/j2ca/
datatransformation/databindingmapping">
<dtm:DataBindingMapping
xsi:type="dtm:DataBindingMapping"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:dtm="http://www.ibm.com/xmIns/prod/websphere/j2ca/
datatransformation/databindingmapping">
<BiDiContext>
<orientation>rti</orientation>
<textShape>nominal</textShape>
<orderingScheme>visual</orderingScheme>
<symmetricSwapping>true</symmetricSwapping>
<numeralShapes>nominal</numeralShapes>
</BiDiContext>
</dtm:DataBindingMapping>
</appinfo>
</annotation>

Properties enabled for bidirectional data transformation
Bidirectional (bidi) data transformation properties control the format of
bidirectional script data exchanged between an application or file system and
integration tools and runtime environments. After these properties are set,
bidirectional script data is correctly processed and displayed in IBM Integration
Designer and IBM Business Process Manager or WebSphere Enterprise Service Bus.

At design time all properties enabled for bidirectional transformation can be
configured using the external service wizard and all business object bidi properties
can be configured using the Business Object Editor tool in the IBM Integration
Designer. At deployment time, all managed connection factory and activation
specification bidi properties can be configured using the IBM Business Process
Manager or WebSphere Enterprise Service Bus administrative console.

Bidirectional properties are divided into three types:

¢ EIS bidirectional format - Specifies the bidirectional format for string type
business data exchanged between the mail server and the adapter.

* Metadata bidirectional format - Specifies the bidirectional format for metadata
and configuration data of string type used by the adapter to establish and
maintain communication with the mail server. This format includes both
configuration properties such as User name and application-specific information
stored in business object definitions (XSD files) and business object attributes.

* Event persistence bidirectional format - Specifies the bidirectional format for
event persistence properties.
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The following table shows property types characterized by bidi format.

Table 125. Bidi formats

Level of property

Bidirectional enabled

Property name as it

Property name as it
appears in the

definition property name appears in the wizard administrative console
Managed connection MCF-related properties BiDi format string BiDiContextEIS

factory (MCF) properties

Activation specification AS-related properties EIS BiDi Format BiDiContextEIS

(AS) properties

Activation specification All event persistence Event Persistence BiDi BiDiFormatEP
properties properties Format

Business object (BO) BO-related properties EIS BiDi Format BiDiContextEIS
Business object BO-related properties Metadata BiDi Format BiDiContextMetadata

All the bidi supported configuration properties for both inbound and outbound
communication are shown in the following tables.

Note: Only properties of string type are enabled for bidirectional transformation.
Integer properties, such as port and host, the host name property, and Boolean
type properties cannot be enabled for bidirectional transformation.

Managed connection factory properties

The following managed connection properties control the bidirectional
transformation during outbound communications.

User name

Password

Note: The Protocol managed connection factory property is not enabled for
bidirectional transformation because it maintains a constant value for the SMTP
protocol.

Activation specification properties

The following activation specification properties control the bidirectional
transformation during inbound communications.

Archive file naming pattern

Archive folder
Database

Database schema name

User name used to connect to event data source

Event recovery data source (JNDI) name

Event recovery table name

Failed events folder
Password

Poll folder

Staging directory
User name
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Note: Substring searches for globalized characters are not supported by the Java
Mail API, so MatchAllCriteria and MatchSomeCriteria properties are not enabled
for bidirectional transformation.

Related concepts

|”Globalization and bidirectional data transformation” on page 214]

The adapter is globalized to support single- and multi-byte character sets and
deliver message text in the specified language. The adapter also performs
bidirectional script data transformation, which refers to the task of processing data
that contains both right-to-left (Hebrew or Arabic, for example) and left-to-right (a
URL or file path, for example) semantic content within the same file.

Adapter messages

View the messages issued by WebSphere Adapter for Email at the following
location.

Link to messages: |http:/ /bidoc.torolab.ibm.com:750 /help / topic/|
fcom.ibm.wbpm.ref.doc/topics/welc_ref msg wbpm.htm]|

The displayed Web page shows a list of message prefixes. Click a message prefix to
see all the messages with that prefix:

* Messages with the prefix CWYEM are issued by WebSphere Adapter for Email

* Messages with the prefix CWYBS are issued by the adapter foundation classes,
which are used by all the adapters

Related information

The following information centers, IBM Redbooks, and web pages contain related
information for WebSphere Adapter for Email.

Information resources

* The WebSphere Business Process Management information resources web page
includes links to articles, Redbooks, documentation, and educational offerings to
help you learn about WebSphere Adapters: [http:/ /www14.software.ibm.com /|
webapp /wsbroker / redirect?version=pix&product=wps-dist|
&topic=bpmroadmaps|

* The WebSphere Adapters library page includes links to all versions of the
documentation: [http: / /www.ibm.com /software /integration /wbiadapters /|
[library /infocenter /

Information about related products

* IBM Business Process Manager, version 7.5, information center, which includes
IBM Business Process Manager, IBM WebSphere Enterprise Service Bus, and IBM
Integration Designer information: [http:/ /bidoc.torolab.ibm.com:7500/help /|

* IBM Business Process Manager, version 7.0, information center, which includes
IBM Business Process Manager, IBM WebSphere Enterprise Service Bus, and IBM
Integration Designer information: http:/ /publib.boulder.ibm.com/infocenter /|
[dmndhelp /v7rOmx /index.jsp|

* WebSphere Adapters, version 6.2.x, information center: |l_1ttp:/ / |
[publib.boulder.ibm.com /infocenter/dmndhelp /v6r2mx/index.jsp]|

* IBM WebSphere Adapters, version 7.5 installation on WebSphere Application
Server, version 8.0 information: |http://www-01.ibm.com/support/
[docview.wss?rs=695&uid=swg27011040)
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developerWorks® resources
* |WebSphere Adapter Toolkit]
* |WebSphere business integration zone

Email 221


http://www.ibm.com/developerworks/websphere/downloads/wat/
http://www.ibm.com/developerworks/websphere/zones/businessintegration/
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department 2Z4A/SOM1
294 Route 100

Somers, NY 10589-0100
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: (c) (your company name) (year). Portions of
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this code are derived from IBM Corp. Sample Programs. (c) Copyright IBM Corp.
_enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program's tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning:

Do not use this diagnosis, modification, and tuning information as a programming
interface because it is subject to change.

Trademarks and service marks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. These and other IBM trademarked terms are marked on their first
occurrence in this information with the appropriate symbol (° or ™), indicating US
registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law
trademarks in other countries. A complete and current list of IBM trademarks is
available on the Web at http://www.ibm.com/legal/copytrade.shtml

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Java and all Java based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.

This product includes software developed by the Eclipse Project
(http:/ / www.eclipse.org).
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